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About This Book

This chapter describes who should read this book, why you should read this book,
and how this book is organized.

Purpose

Read this book to find out how to use the IBM MERVA Message Processing Client.
You learn how to start and work with the message-processing functions, such as
creating, displaying, editing, retyping, authorizing, and printing messages.

Audience

This book is written for users of the MERVA Message Processing Client. It is
intended for message-processing personnel who works with messages.

It is assumed that you are familiar with SW.LET. messages and S.W.LET.
terminology as defined in the S.W.LET. User Handbook, published by the Society for
Worldwide Interbank Financial Telecommunication s.c., (5.W.LET.), La Hulpe,
Belgium. And it is assumed that you are familiar with telex terminology as defined
in the documentation provided by your local telecommunications authority.

How This Book Is Organized

The first part of this book provides general information on the MERVA Message
Processing Client by giving an overview of the product and by describing what to
do when you use it for the first time. The second part describes the
message-processing functions in detail. The third part contains appendixes that
describe installation and configuration, and diagnosing problems.

This book also contains a glossary, a bibliography, and an index.

Note that this book describes all available functions of the MERVA Message
Processing Client. Unless otherwise indicated, the functions apply to the following
MERVA features:

e MERVA USE & Branch for Windows NT

e MERVA USE & Branch for Windows NT with SWIFT Link

e MERVA ESA

You might, however, not be allowed to access all these functions. The functions
you are allowed to carry out are determined by the authorization for your user ID.

They are also determined by the customization of the MERVA server system that
establishes the message flow.

Possible settings for your user ID on the server are:

* Functions and commands you are allowed to use

* Types of messages you are allowed to process

 External networks you are allowed to exchange messages with

The illustrated examples and reference material in this book describe the system as
supplied to you. The system, however, can be customized in many ways to suit

© Copyright IBM Corp. 1997, 1999 vii



your working methods. Therefore, it is possible that the windows that are shown
in this book are different from the windows that are displayed to you on your
screen as you work.

Conventions and Terminology Used in This Book

In this book, the following naming conventions apply:

* MERVA Workstation is used when the description applies to MERVA USE &
Branch for Windows NT and MERVA USE & Branch for Windows NT with
SWIFT Link.

* MERVA ESA is used when the description applies only to MERVA ESA.
* MERVA is used when the description applies to all MERVA features.
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Part 1. General Introduction to the MERVA Message
Processing Client

This part of the book gives you an overview of the components and functions of
the MERVA Message Processing Client. It also tells you how to start the MERVA
Message Processing Client and shows you an example of how to handle a
message.

© Copyright IBM Corp. 1997, 1999
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Chapter 1. Introducing the MERVA Message Processing Client

The MERVA Message Processing Client is part of the MERVA family of products
for financial institutions. You can use these products for message handling on
various platforms.

The MERVA Message Processing Client has a common graphic user interface for
message-processing functions for all MERVA server systems. The modern graphic
interface displays messages in a user-friendly way. When you use this interface,
you can carry out different tasks for different kinds of messages.

The MERVA Message Processing Client provides the same level of security as the
message-processing functions on the server systems.

A state-of-the-art graphical user interface makes it easy for you to handle the
messages that you work with. For example, you can use clipboard functions, or
you can view different messages at the same time.

Overview

Message-processing is performed in several steps. With the MERVA Message
Processing Client you can carry out the following message-processing tasks:

* Create messages

Create all messages that are defined in your system. You can create, for example,
a SW.LET. message of any message type belonging to message categories 1 to 9
as defined in the S.W.LET. User Handbook.

You can also use previously defined templates as outlines for the creation of
recurring messages.

* Verify messages

Verify messages by retyping specific data to match the data that is originally
entered.

* Authorize messages

Authorize messages in one or more authorization steps before they are sent to
the SW.LET. or telex network.

* Edit messages

Change an incomplete message, or a previously created message that failed
verification, authorization, or that is rejected by the respective network.

* Display, print, and delete messages
Retrieve one or more messages to display, print, or delete them.
* Search for messages
Retrieve one or more messages that are based on specific search values.
* Create and maintain templates
Save messages as templates for later retrieval, update, or processing.
* Send message as telex
Send a message in the form of a telex.

© Copyright IBM Corp. 1997, 1999 3



Concept of Messages

To handle different message types, the MERVA Message Processing Client has a
concept of messages that divides messages into different groups that are
hierarchically ordered:

* Message applications
* Message categories
* Message types

Messages also have different message parts. The message groups and message
parts are described in the following sections.

General
(Free Format, Telex)

S.W.L.LF.T. System Messages

FIN System Messages | GPA System Messages

S.W.L.E.T. Financial Messages

Category 1 Category 2 Category 9

Customer Payments Cash Management

& Cheques & Customer Status

100 Customer 900 Confirmation
Transfer of Debit

101 Request for 910 Confirmation
Transfer of Credit

102 Mass 920 Request
Payments Message

104 Customer 935 Rate Change
Direct Debit Advice

Figure 1. The Concept of Messages

Message Groups

Message Applications
Message applications specify an application area to which the message categories
and messages belong.

MERVA uses the following applications:
* SW.LET. Financial Messages
* SW.IET. System Messages

¢ General, such as free format or telex

An application contains one or more message categories.

Message Categories
Message categories contain a group of messages that are logically related within an
application, for example:

* The application SSW.LET. Financial Messages consists of nine categories, from
category 1, Customer Payments & Cheques, to category 9, Cash Management &
Customer Status.
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¢ SW.LET. System Messages contain the categories FIN System Messages and
GPA System Messages.

When you create messages, your rights to message categories depend on settings
in your user profile.

Message Types

Each category consists of different message types, for example, S.W.LET. Financial
Messages category 1 consists of Customer Transfer (type 100), Request for Transfer
(type 101), Mass Payments (type 102), Customer Direct Debit (type 104), and
others.

Which message types you can create depends on the settings in your user profile.

Message Parts
A message consists of the following parts:
* Message body
* MERVA-related data
* Message envelopes

Non-MERVA

Applications
MERVA System 4<
Non-MERVA

Networks

Telex | | MERVA Link
MERVA-Related Message
Data Body
- for example, comment - - Message Text -
Envelope | | Envelope

Figure 2. The Different Message Parts

Message Body

The message body contains the message text. This text contains the data that is
sent to other MERVA systems, non-MERVA applications, and networks.

The following formats of the message body are valid:
* SWIET.

The SW.IET. message is formatted according to the SW.LET. rules as defined in
the S.W.LET. User Handbook.

* Telex
The data in the telex message is limited to telex definitions.
¢ Free format message
MERVA-Related Data
MERVA-related data represents data that MERVA uses while processing the

message, such as comments. This data is not included in the message body and is
only used by MERVA.

Chapter 1. Introducing the MERVA Message Processing Client 5



The MERVA-Related Data window shows you detailed information on this data.
The information that is shown depends on the operating system of your MERVA
server. You can start the MERVA-Related Data window from any
message-processing window that shows the message body.

Message Envelope
The following message envelopes are valid:

* Telex message envelope
This message envelope is used to send messages via the telex network.

* MERVA Link envelope
This message envelope is only valid for messages that are received or are sent
via MERVA Link. The data is read-only data.

You can display message envelopes by selecting Show message envelopes from
the View menu of any message-processing window that shows the message body.
You then see the Message Envelopes window with detailed information on this
data.

Connection to Networks and Other Systems

To send and receive messages, the MERVA system can be connected to the
following links:

S.W.LET. Link
Establishes a link between the MERVA system and the S.W.LET. system to
control the transmission of messages between both systems.

Telex Network
To send messages to the telex network, the MERVA server API of MERVA
Workstation establishes a link to a telex program from a vendor of your
choice.

MERVA Link
Allows the exchange of messages with other MERVA systems that have
MERVA Link installed.

S.W.LE.T. Link Telex Network
MERVA System
MERVA Link
Other MERVA
Systems

Figure 3. The MERVA System and lIts Connection to Networks and Other Systems

For detailed information refer to MERVA ESA V4 Concepts and Components.
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Chapter 2. Getting Started

This chapter tells you how to start the MERVA Message Processing Client. It also
describes some features of the MERVA Message Processing Client with which you
should be familiar before you start using the client.

Starting the MERVA Message Processing Client

Before you start the MERVA Message Processing Client, check with your system
administrator that you have a valid user ID and password for your MERVA
system.

You can start the MERVA Message Processing Client in one of the following ways:
* As a remote client to a MERVA Server system

* As message processing integrated in MERVA Workstation located on the same
workstation

Starting As a Remote Client

To start the MERVA Message Processing Client as a remote client, select Programs
from the Windows NT Start menu, then select MERVA Message Processing
Client. You can also double-click on the MERVA Message Processing icon, or select
it and press Enter.

To access Messages and Codes, double-click on the Messages and Codes icon, or
select it and press Enter.

To uninstall the MERVA Message Processing Client, double-click on the Uninstall
icon, or select it and press Enter.

&5 C:\WINNT 40\Profiles\All_ [I[=] E3

J Datei Bearbeiten  Ansicht

MERYA Message Messages & Codes
Froceszing

%

|2 Objekel v

Figure 4. The MERVA Client Icon

You then get the Signon window as shown in the following figure:
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MERYA Client

MERYA

User ID IUSER
Password I""“"' o
server 1D [EEXIINGNGN |

Signon I Change password... | Cancel | Helpl

Figure 5. The MERVA Client Signon Window

To sign on to the MERVA Message Processing Client:
1. Enter your user ID and password.
2. Enter a server ID in the Server ID field or select a name from the list.

In the list, you see entries that are customized for your system, such as SA1 or
Remote. By default, you see the last used server.

3. Select Signon.

According to the customization of your system, you get entry fields in which you
enter the conversation security user ID and password.

Select Cancel to close the MERVA Client Signon window without signing on.

Select Help to get overview information for the current window.

When the signon procedure is successful, you get the Function List window. For a
detailed description of the Function List window refer to ‘C hapter4 The Function

List Window” on page 21.
Starting On the Same Workstation

To start the MERVA Message Processing Client on the same workstation, select
Messages from the MERVA Workstation menu, then select Message Processing.

You are then directly connected to MERVA Workstation. The rights that are defined
for your MERVA Workstation user ID are valid. You do not get the Signon
window.

When the signon procedure is successful, you get the Function List window. For a
detailed description of the Function List window refer to !Chapter 4 The Function

Startup Options

The MERVA Message Processing Client offers you the following startup options
that affect message processing:

/TRACE=
Defines the traces that are to be written to the trace file. Use /TRACE=ALL
except where stated otherwise.

8 MERVA Message Processing Client User’s Guide



Note: Activate the traces only at the direction of your IBM representative.

/TRACEFILE=
Defines the file to which the traces are written. This parameter must
contain the full file specification. It must also contain the directory and
name of a disk with write access.

Note: Activate the traces only at the direction of your IBM representative.

Changing Your Password

To change your password:
1. Select Change password in the MERVA Client Signon window.

The following window is shown:

Change Paszword |

Mew password

Yerify password

Accept Cancel | Helpl

Figure 6. The Change Password Window

2. Enter a new password in the New password and Verify password fields.
3. Select Accept.

Select Cancel to close the Change Password window without changing the
password.

Select Help to get overview information for the current window.

Your system administrator can also specify that your password expires after a
certain period of time. After this period of time elapses, you are asked to change
your password to complete the signon process in the Signon window.

Synchronizing Your Password

The following rule does not apply to MERVA ESA. If your system administrator
makes changes to the MERVA system, it might happen that your password stored
in the security system, for example in the User Manager of Windows NT, is
different from the password stored in MERVA Workstation.

In this case, the Synchronize Passwords window is displayed. It looks like the
following:

Chapter 2. Getting Started 9



MERYA Password |m
Security System Password |m

Accept Cancel | HE||]|

Figure 7. The Synchronize Passwords Window

To synchronize your password:

1. Enter your MERVA password in the MERVA password field.

2. Enter your security system password in the Security system password field.
3. Select Accept.

Both passwords are then synchronized within the databases. You then use the
security system password as the actual MERVA password.

Select Cancel to close the Synchronize Passwords window without changing the
password.

Select Help to get overview information for the current window.

Changing Settings

Select Settings from the User menu of the Function List window to change settings
for the window or information that is contained in the window. You then get the
MERVA Client Settings window where you can choose the following options:

* View
To specify the display of information according to your needs.

— In the Title components field, you can specify that the MERVA Server ID and
user ID are displayed in the window title.

— In the Toolbar field, you can specify whether the toolbar of the
message-processing windows contains text or graphics.

* Print options
To print to a file or to select a printer and its properties.

— When you select File, the output of local message printing is not sent to a
printer but stored in a file. Each time you print a message, a dialog asks you
to specify the file name and the directory to which the output is to be sent.

— When you select Printer, the output of local message printing is sent to a
specified printer. To select a printer from the Printers folder, select Select
printer. The selected printer is then displayed in the field to the right of the
Select printer push button.

Note that this option is only available if the Printers folder contains a printer
object.
To specify printer properties, such as the number of lines per page, select
Properties. To specify the printer font, select Font.

* Fonts
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To set the fonts for information displayed to you.

— Select Font for function and message list to define the font for the contents
of function and message lists.

— Select Font for message type and template list to define the font for the
contents of message type and template lists.

— Select Font for message-processing windows to define the font for the
message-processing windows.

— Select Font for status line to define the font for the status line that explains
the state of an object or process.

Colors

To set the foreground and background colors of the prompt and mandatory
fields in the message-processing windows.

To change the foreground color of a field:

1. Select the field type from the Field type list.

2. Select Foreground.

3. Select Color or RGB to define the color specification mode.

4. According to your color specification mode, select a color from the Color list,
or from the RGB values field.

To change the background color of a field:

1. Select the field type from the Field type list.

2. Select Background.

3. Select Color or RGB to define the color specification mode.

4. According to your color specification mode, select a color from the Color list,
or from the RGB values field.

To reset all color settings to the default setting, select Defaults.

The field MERVA at the bottom of the Color selection field is a test field. It
gives you a preview of the selected field type in the message-processing
windows.

Trace
To set the trace options and the trace file.

Note that you should change these options only at the direction of your IBM
representative.

You can select the following types of trace information in the Trace options field:

— Select Client EUI trace to trace basic operations that refer to the general
windows of the MERVA Client.

— Select MP EUI trace to trace basic operations that refer to the
message-processing windows of the MERVA Client.

— Select API trace to trace basic operations that refer to the MERVA
Client/Server communication on application layer.

— Select Data stream trace to trace basic operations that refer to the MERVA
Client/Server communication on transport layer.

— Select Server trace to trace basic operations that refer to the MERVA Server
request execution on application layer. In case of a remote MERVA Client, this
data is written to the trace file of the MERVA Server.

The settings in the Trace options field are not saved permanently after you sign
off, regardless of whether you select Save settings or not.
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In the Trace file field, you can specify the full path of the trace file. You should
store this file on your local workstation. Entries in the Trace file field are saved
permanently.

With Trace options you cannot trace the MERVA Client during the time between
start and selection of the MERVA Client settings. Therefore, you can also specify
the trace options with the runtime parameters /trace=all and
/tracefile=<trace_file_path>, where trace_file_path represents your real trace file
path. To specify these parameters, change the properties of the MERVA Client
object in the MERVA Client folder or the message-processing object in the
corresponding MERVA folder. For details refer to L ions”

* Style
To specify the behavior of the MERVA Client according to your needs.

— Select one of the following options from Confirmations for message
processing:
- Select Confirm successfully completed action to display a confirmation
message for an action that completes the processing of a message
successfully, such as Accept.

- Select Confirm successful intermediate action to display a confirmation
message for an action that does not complete the processing of a message
but ends successfully, such as Save as template.

— Select one of the following options from Checking errors dialog for message
processing:

- Select Show Checking Errors window for Accept to display the Checking
Errors window after you select Accept if the processing of a message is
completed with errors. If you deselect this option, you do not get the
Checking Errors window but information that errors were found.

- Select Show Checking Errors window for Route to telex to display the
Checking Errors window if the processing of a message is completed with
errors. If you deselect this option, you do not get the Checking Errors
window but information that errors were found.

— Select one of the following options from the Options fields on page 2 of the
Customize your individual styles function:
- Fill fields with single option to specify that an option in a message is
automatically added or deleted if the field has only one option. This option
is selected by default.

- Fill fields with several options to specify that an option in a message is
automatically added or deleted if the field has at least one option.

- Do not fill option fields to specify that an option in a message is never
changed automatically.

— Select one of the following options from the Repeatable sequences fields on
page 2 of the Customize your individual styles function:

- Display occurrences stacked to specify that only a single occurrence of a
repeatable sequence is displayed. This option is selected by default.

- Display occurrences sequentially to specify that all occurrences of a
repeatable sequence are arranged sequentially.

— Select one of the following options from the Field tabbing field on page 2 of
the Customize your individual styles function:

- Manual tabbing with TAB key to specify that a tab forward is only done if
the Tab key is pressed. This option is selected by default.
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- Automatic tabbing after field is filled to specify that a tab forward is done
after the last character of a field is filled, or if the Tab key is pressed.

— Select one of the following options from the Field checking field on page 2 of
the Customize your individual styles function:

- Always when a field is left to specify that the contents of a field are
permanently checked. This option is selected by default.

- When a filled field is left to specify that a field is only checked if it
contains data.

- No field checking to specify that a field is not checked permanently. This
setting does not affect the checking of the complete message.

- In the Message field display field on page 3 of the Customize your
individual styles function, you can specify the initial display of a message
depending on the different message-processing functions. Select one of the
following options:

- Display only fields with data to display only fields that contain data. If
you do not select this option, all message fields are shown regardless of
whether they contain data.

- Display sequences collapsed to specify that the lower-level data of a
message is not shown at the same time.

* Keys
In the field Key assignments for message-processing actions, you can specify
your own shortcuts for specific actions of message handling.
To specify a shortcut of this kind:
1. Select a message-processing action from the Action list box.
2. Select an alphabetic key from the Assigned key combination list box.
3. Select one or more of the check boxes Shift, Ctrl, and Alt.

To reset the key assignment to the default values, select Defaults.

In the field Key assignments for message-processing strings, you can specify
your own shortcuts for predefined text. With these shortcuts, you can insert text
in message fields while you process a message.

To specify a shortcut of this kind:

1. Specify the key assignment for the string in the entry field of the Description
list box to identify it.

Select an alphabetic key from the Assigned key combination list box.
Select one or more of the check boxes Shift, Ctrl, and Alt.
In the field String that is inserted, enter the text that belongs to the shortcut.

S A

Select Add to add the defined string key assignment to your individual
assignments.

If the defined string key assignment is already used, the Add and Change
buttons are not active.

6. To delete a defined string key assignment, select it. Then select Remove.
7. To change a defined string key assignment, select it and change the
definition. Then select Change.

To save the settings permanently, select Save settings permanently. If you then
select OK, the changes are saved in the profile and reused when you work again
with the MERVA Message Processing Client.
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Changing Colors

Except for the background color of specific message-processing fields, the colors
used are system colors. You can change these background colors in the MERVA
Client Settings window. You can change the system colors by using different
schemes or by customizing own schemes.

The following system colors are used:
* Window text for input text
* Static text for titles and literals

* Dialog background for the background of read-only fields

How to Get Help

Several types of help are available:

* Press F1 (Help) to get information about the selected item, including the item’s
purpose and ways to interact with the item.

* Select Help from the menu bar of each window to get Help menu choices for
the active program, such as an index of help topics, general information about
the active window, general information about the help facility, a list and
description of the keys you can use, and product information.

* The information area displays a brief explanation or description of the state of
an object or a process.

* Hover help provides you with brief, descriptive information about the user
interface elements, such as toolbar items.

Using Accelerator Keys

The following accelerator keys are defined for the message-processing windows:

F2 Save

F3 Close

F4 Reject

F7 Route to telex queue

F8 Accept

The following accelerator key is defined for the function list view and the message
list view:

F5 Refresh

To activate the push buttons, enter:

Alt + “char’
‘char’ is the underlined character of the push button text, for example, A
stands for the Accept push button.

By default, the following accelerator key is defined for prompting:

Ctrl + P
To prompt for codewords, currencies, or correspondent information

You can also double-click on the subfield that is enabled for prompting to
get the corresponding prompt window.
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For information on how to change this key, refer to page 13

The following accelerator keys are defined for switching between notebook pages
in the envelope view of a message:

Alt + P
Previous notebook page

Alt + N
Next notebook page

Stopping the MERVA Message Processing Client

From the Function List window select Close to sign off from the MERVA Message
Processing Client. You get a message to confirm the signoff.

Chapter 2. Getting Started 15
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Chapter 3. Example of Message Handling and Routing

This chapter describes how to prepare a specific message to send it via the
S.W.LET. network.

A Graphic View of Message Processing

A message must pass different processing steps and a series of queues before it can
be sent to the network. The sequence in which these steps are completed depends
on the customization of your system.

The following graphic shows you an example of the necessary processing steps for
a message handling money transfer. Your institution can change the processing

steps.

Create a
Message

l

Funds
or Securities
Transfer

Retype Yes

Verification

v

No

N
Edit °

v

Yes Visual
Verification

»
»

v

First
Authorization

l

Value Exceeds
100007

Second
Authorization

Ready for

SW.LET.

Send
Queue

For the financial institution that is used as an example in this chapter, the
customization specification is as follows:

Figure 8. An Example of Message Handling and Routing

* Verify
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— Verify by retyping — Each message that transfers funds or securities must be
verified by retyping. This means you must retype specific fields and the
MERVA Message Processing Client checks the retyped version against the
original version. This eliminates the possibility of a typing error.

— Verify visually — All other messages must be verified visually. This means that
you must read through the message to check it for correctness.

* Authorization one — Each message must be authorized or approved for sending.

* Authorization two — Each message that transfers funds or securities with a
value higher than 10000 must be authorized twice.

For security reasons, the financial institution that is used as an example has the

following additional rules:

* You cannot verify a message that you create. A different user must do this.

* If two authorization steps are required, different users must perform these steps.

* Only supervisors and people in higher positions are allowed to authorize a
message.

* Only the department manager is allowed to authorize a message that transfers
funds or securities that exceeds 10000.

A Step-By-Step Description of Message Processing

The message that is shown in the example is handled and routed as follows:

1. A colleague creates a message that transfers funds of 15000. After the message
is checked for formal errors, it is routed to the queue of the next
message-processing function. The next step is to retype the message to verify it.

2. You are responsible for verifying the message. You select the Retype function to
retype all fields that are marked for retyping. You also check the contents by
reading through the message.

* If you do not find any errors, you accept the message. The message is then
routed to the queue of the next message-processing function. The next step is
to authorize the message.

 If you find any errors, you reject the message and route it to the next
message-processing function. The next step is then to edit the message and
route it to the authorization queue.

3. The supervisor must authorize it. After the supervisor checks and accepts the
message, it is routed to the next message-processing function. The next step is
to authorize the message a second time because the amount exceeds 10000.

4. Because the message transfers funds or securities with an amount that exceeds
10000, the department manager must perform the second authorization. After
the department manager checks and accepts the message, it is routed to the
S.W.LET. ready-to-send queue.
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Part 2. Using the Message-Processing Functions

This part of the book explains in detail how you can use the message-processing
functions of the MERVA Message Processing Client.

© Copyright IBM Corp. 1997, 1999
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Chapter 4. The Function List Window

The Function List window shows you the functions that contain message lists that
are stored in different queues. You can be authorized to use some or all of the
functions that are provided by the MERVA Message Processing Client. Your
financial institution determines names and usage of the functions.

Understanding the Function List Window Layout

After you sign on to the MERVA Message Processing Client, the Function List
window is the first window with which you can work. It looks like the following;:

1
2 — Uszer Selected Wiew ‘window Help
3 — Display only I(AII) j =g
Function List
Mame Description Count

[0 MBMERROR | Corrupt Messages 0 |
4— [0 MBRERROR | Corrupt Messages 0 m

[0 MLAKWAIT Message Ack Wait 0

1 MLCNTRL Message Control 0

[0 MLMERROR | Corrupt Messages 0

] MLSND2 Message Ready To Send 0

[0 MLSNDESA Message Ready To Send 0

[0 PRINTACK Print Messages 0

[0  PRINTTLX Print Messages 544

[0 SLMANAUT Manual Authentication 0

[J SLPRINT1 Print Messages 0

[ SLPRINT2 Print Messages 0 -|

q »
5—— | EFC14011 Last Refreshed: 15:12:20, Total Functions: 39, Shown: 39
6 —1 Open | Find... |

7— Close | Helpl
8

Figure 9. The Function List Window

The Function List window of the MERVA Message Processing Client is divided
into several parts:

1. Title bar with window title and activity icon

The activity icon shows you a server, an envelope, and a terminal. When you
issue a request, such as opening a function, the objects in the icon move to
indicate that server communication takes place.

2. Menu bar with menu items User, Selected, View, Window, and Help
3. Selection field Display only

4. Function list containing an icon in the form of a folder, name of the function,
description of the function contents, and total number of messages contained in
the function.

Status line
Action buttons to perform actions related to the functions

Window buttons to perform actions related to the active window

© N o o

Information area
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With exception of the title bar, these parts are described in detail in the following
sections.

Working with Menu Iltems

22

User

Each menu item has a pull-down menu with different options:

This menu item offers you the following options:

Signoff
Select Signoff to sign off from the MERVA Message Processing Client. You are
asked to confirm the signoff.

Settings

Select Settings to change settings for the window or information that is contained

in the window. For a detailed description refer to !Changing Settings” on page 1d.

Terminate
Select Terminate to stop the MERVA Message Processing Client abnormally. You
are asked to confirm the termination.

Note: Use this option only if signoff does not work, or if the server returns severe
errors.

Selected

This menu item refers to your selection of functions from the function list. You can
select one of the following options:

Open

To display the contents of the selected message lists.

Find

To locate messages by specifying find parameters.

If you select Find, you get the Specify Find Parameters window. It looks like the
following:
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mi Specily Find Parameters: [0l x]

Key fields: Find value:

1SN < [FTEST??
MRN <= l_
<> Single wildcard: 2
0SN ==
> n " )
3= Multiple wildcard: l*_

Update argument:

Find arguments (logical AND connected):

4l 1 | Addfargument;

MRN = WKSTID*168

Select all arguments

Deselect all arguments

4] 1 ] Remove arguments

Description: [Find 168 TEST

Eind Cancel Help |

Figure 10. The Specify Find Parameters Window

To specify find arguments:

1.

Select a value from the Key fields field.

If the MERVA Message Processing Client is connected to a MERVA Workstation
server, the keys are ISN, MRN, TRN, and OSN as shown in w If the
MERVA Message Processing Client is connected to a MERVA ESA server, up to
two keys that are defined for a function are shown. If more than one function is
selected, you see only those keys that are valid for all selected functions.

Select an operator from the Operators field to relate both values.

Enter a value in the Find value field.

Note that you can add a single wildcard symbol that represents one character,
or a multiple wildcard symbol that represents several characters. You can
define the wildcard symbols in the Single wildcard field and in the Multiple
wildcard field. Wildcard symbols are supported only for the equals operator
=)

Select Add argument to save the definition in the Find arguments field.

You can repeat this process of adding arguments. If you want to remove one or
more saved arguments from the Find arguments list, select one or more items
and then select Remove arguments.

Select Update argument to replace the definition of the selected argument in
the Find arguments field.

Select Select all arguments to select all items in the Find arguments field.
Select Deselect all arguments to deselect all items in the Find arguments field.
To start the search, select Find.

The search arguments are then used to find the messages that match all find
arguments.

Note that the find arguments are logically AND connected. For example, if you
define the arguments ISN>100 and MRN=xyz*, only those messages that
match both arguments are shown.

To close the Specify Find Parameters window without starting the search, select
Cancel.
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The Description field allows you to give a name to the list of messages that are
found. In the Function List window, this name is shown in the Description field.
To display only those message lists that match the find arguments, select All
results from Display only. For a detailed description refer to

7

Minimize

To shrink to an icon one or more open functions that you select. The function is
then still open and available. To display the minimized window in its original size,
point to the icon and double-click mouse button 1, or select Restore from the
Selected menu.

Restore
To display the selected minimized window in its original size. You can also point
to the icon and double-click mouse button 1.

Close
To close the selected functions.
View
This menu item offers you the following options:

Refresh now
To update changed information within the Function List window, such as the
number of messages, to its current status.

Sort order
To sort the functions in ascending or descending alphabetical order.

Window

This menu item offers you the following options:

Minimize all
To shrink to an icon all open functions. The functions are then still open and
available.

Restore all
To display all selected minimized windows in their original size.

Close all
To close all open functions.

Help

This menu item offers you the following options:

Help index
To display an alphabetical list of topics for which help information is provided.

General help
To display overview information about the current window.

Using help

To display information on how to use the help facility.

Keys help

To display key assignments for the current window.
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Product information
To display copyright information about the MERVA Message Processing Client.

Defining the Selection for the Functions

The field Display only allows you to define the selection for the functions that are
to be displayed. You can perform a textual search by entering a specific name, or
you can select one of the following items:

<All> To display all functions that are defined in your user profile. You can only
see functions with which you are allowed to work.

<All active>
To display all functions that are opened from this function list.

<All filled>
To display all functions that contain messages.

<All results>
To display all functions that match the find parameters specified in the
Specify Find Parameters window.

Display
To display all functions that you are allowed to display.

Edit  To display all functions that you are allowed to edit.

Create To display all functions that are not yet completed or to create new
messages.

Authorize
To display all functions that you are allowed to authorize.

Retype
To display all functions that you are allowed to verify.

You can also use wildcard symbols for a textual search:
* Use ? as a single wildcard symbol for a character within the entry field.
* Use * as a multiple wildcard symbol for several characters within the entry field.

The Function List

This is the main area of the Function List window that contains information about
the functions that are shown. You see:

* An icon in the form of a folder that indicates whether the function is open or
closed

* The name of the function
* A description of the function contents
* The total number of messages that are contained in the function

The status line shows you the following information:

* Information message ID to locate the message in Messages and Codes. To access
Messages and Codes double-click on the corresponding icon in the MERVA Client

window. For details refer to ESiaLhn.g_the_M.ERMA_Messa.ge_Emcessm.g_Chenilgd

¢ Time at which the function list is last refreshed

* Total number of functions available to you
¢ Total number of functions that are shown
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Note that you can also display a pop-up menu for the function list area. The
options of the menu items apply to the selected functions. To start the pop-up
menu, place the mouse pointer within the function list area and click mouse-button

2. For a detailed description of the items, refer to 'Working with Menu Items” onl

Working with Action and Window Buttons

The action and window buttons of the Function List window allow you to perform
actions that are related to the functions and to the active window. The following
buttons are provided:

Open To display the contents of the selected function.

Find To locate messages usmg specified find parameters. For a detailed
description refer to L ’

Close To sign off from the MERVA Message Processing Client. You are asked to
confirm the signoff.

Help To display overview information about the current window.
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Chapter 5. The Message List Window

The Message List window shows you the message list that is contained in the
selected function. The message list that is displayed to you contains messages that
are stored in queues. Each function has its own queue, the name of which is
identical to the respective function.

Understanding the Message List Window Layout

After you open a function in the Function List window, the Message List window
is displayed. Note that the window layout and the information that is contained in
the window depend on your MERVA system.

The following figure shows an example of the Message List window of MERVA

Workstation:
1— @ MERVA USER at SA1 / SMVERIFY _ | O]
2 Selected Wiew Window Help
3 — Display only I(AII) j [
Message Yerification
MRN Msg_Type | Sender Receiver Printed
SDFFE3F800000265 | SWIFT199 | IBMMERVAZXXXX | TESTBNKAXXKK | N |
4 — %% SDFFE3FG00000266 | SWIFT100 | IBMMERVAZGCC | TESTBNKBMOM

N
SDFFE3FS800000269 | SWIFT199 | IBMMERVAZXXX | TESTBNKAOOSK | N
SDFFE3F800000270 SWIFT100 IBMMERVA2YCCX TESTBNKBXOOO( N

4

5 EHC15011 Last Refreshed: 12:53:09. Total Hessages: 4. On Client: 4. Shown: 4. Default Action: Retype
6— Dlsplayl Hetype | Delete Copy to print... Move...

7— Close | Help

8 —

Figure 11. The Message List Window

The Message List window of the MERVA Message Processing Client is divided into
different parts:
1. Title bar with window title and activity icon

The activity icon shows you a server, an envelope, and a terminal. When you
issue a request, such as opening a message list, the objects in the icon move to
indicate that server communication takes place.

2. Menu bar with menu items Selected, View, Window, and Help
3. Selection field Display only

4. Message list containing an icon in the form of an envelope, message reference
number (MRN), message type, sender of the message, receiver of the message,
and print flag.

The message list can also contain an icon in the form of an envelope with an
access-denied sign. A MERVA Workstation system can be customized in such a
way that a user who processes a message cannot authorize or retype this
message. In this case, you see an envelope with an access-denied sign. The
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appropriate action buttons and menu items are then not active. For details on
this type of processing a message, refer to the corresponding server
customization documentation.

Status line
Action buttons that depend on user rights and queue settings
Window buttons to perform actions related to the active window

© N o O

Information area

With exception of the title bar, these parts are described in detail in the following
sections.

Working with Menu Iltems

Each menu item has a pull-down menu with different options:

Selected

The contents of this menu item depend on settings for MERVA functions and user
rights. The following list in alphabetical order shows you all options available.
These options apply to a selected message. If the selected message is already
active, the existing message-processing window is shown.

Authenticate
To start reauthentication of the selected message. After reauthentication
completes, the message is routed accordingly. The routing depends on
successful or unsuccessful authentication.

Authorize
To display the Authorize Message window for the selected message.

Close To close the selected message.
Delete To delete a message.

You are asked to confirm the deletion. Only upon confirmation of the
delete request is the message deleted.

Dispatch
To display the Dispatch Message window for the selected message.

Display
To display the Display Message window for the selected message.
Edit  To display the Edit Message window for the selected message.

Mark as failed
To route the selected message as it is routed when reauthentication fails.

Minimize
To shrink to an icon the selected message.

Move To put a selected message into another queue and delete it from the
original one.

Print To print a working copy of the selected message. After printing, the Print
flag of the message is set to Y.

Restore
To display the minimized window of the selected message in its original
size.

Retype
To display the Retype Message window for the selected message.
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View

This menu item offers you the following options:

Refresh now

To update changed information within the Message List window, such as the print
status of a message, to its current status. This option is only available if there are
no active messages.

Sort order
To sort the messages in ascending or descending order. Each column is changed
accordingly.

Window
This menu item offers you the following options:

Minimize all
To shrink to an icon all open messages. The messages are then still open and
available.

Restore all
To display all selected minimized windows in their original size.

Close all
To close all open messages.

Help

This menu item offers you the following options:

Help index
To display an alphabetical list of topics for which help information is provided.

General help
To display overview information about the current window.

Using help

To display information on how to use the help facility.

Keys help

To display key assignments for the current window.

Product information
To display copyright information about the MERVA Message Processing Client.

Defining the Selection for the Message List

The field Display only allows you to define the selection for the messages that are
to be displayed. You can perform a textual search by entering a specific name, or
you can select one of the following items:

<All> Displays all messages according to the settings in your user profile. You
can only see messages with which you are allowed to work.

<All active>
Displays all messages that are opened for message processing.

You can also use wildcard symbols for a textual search:

* Use ? as a single wildcard symbol for a character within the entry field.
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* Use * as a multiple wildcard symbol for several characters within the entry field.

The Message List

This is the main part of the Message List window. Its contents depend on your
MERVA system. For MERVA Workstation, for example, it contains an icon in the
form of an envelope indicating whether the message is open, closed, or denied for
access, the message reference number (MRN), message type, sender of the
message, receiver of the message, and print flag. The status line shows you
information, such as:

* Information message ID to locate the message in Messages and Codes. To access
Messages and Codes double-click on the corresponding icon in the MERVA Client

window. For details refer to LSiaJ:hn.g_tbe_M.ERMA_Messa.ge_Emces&n.g_Chenilad

* Time at which the message list is last refreshed

 Total number of messages available for this function
* Number of messages on the client
* Number of messages that are shown
This number depends on the setting in the Display only field.
* Action to be performed by default when you double-click on the message

If you select more than one message, only Delete, Move, Copy to Print, and Print
are available.

Note that you can also start a pop-up menu for the message list area. The pop-up
menu contains options that are currently applicable. These options are identical
with the options of the Selected menu and apply to a selected message. If the
selected message is already active, the existing message-processing window is
shown. To start the pop-up menu, point to a specific message and chck
mouse-button 2. For a detailed description of the options refer to I!Actions foi
Message Pracessing” on page 48. If you point to an arbitrary point w1th1n the
message list area and click mouse button 2, you can select or deselect all messages
that are shown.

Working with Action and Window Buttons

The action and window buttons of the Message List window allow you to perform
actions that are related to the message list and to the active window.

The action buttons that are shown depend on the settings for MERVA functions
and user rights. The following list in alphabetical order shows you all options
available:

Authenticate
To start reauthentication of the selected message. After reauthentication
completes, the message is routed accordingly. The routing depends on
successful or unsuccessful authentication.

Authorize
To display the Authorize Message window for the selected message.

Copy to Print
To copy a message to a print queue.

Create To display the Select Message Type window.

Delete To delete a message.
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You are asked to confirm the deletion. Only upon confirmation of the
delete request is the message deleted.

Dispatch
To display the Dispatch Message window for the selected message.

Display
To display the Display Message window for the selected message.

Edit  To display the Edit Message window for the selected message.

Mark as failed
To route the selected message as it is routed when reauthentication fails.

Move To put a selected message into another queue and delete it from the
original one.

Print To print a working copy of the selected message. After printing, the Print
flag in the MERVA-related data of the message is set to Y.

Retype
To display the Retype Message window for the selected message.

Templates
To display the Maintain Templates window to select or specify a template.
The following window buttons are valid:

Close To close the Message List window without performing an action and
return to the Function List window.

Help To display overview information about the current window.
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Chapter 6. Working with Message-Processing Windows

The message-processing windows display the contents of a message. The message
consists of fields, subfields, sequences, repeatable sequences, and other parts. It is
formatted to help you enter data efficiently in these message parts. The
message-processing windows also provide functions to vary the amount of data
that is shown and to check the message for correctness. This chapter shows you
how to work with these functions.

General Description

The following sections give you an overview of the functions available to you.

Understanding the Structure of a Message Part

Several types of fields are available.

* Mandatory fields and subfields
Fields that are preceded by an asterisk (*). For example, fields that contain at
least one mandatory subfield, are mandatory. You must fill them in to complete
the message.

Depending on the contents of the message, additional fields might become
mandatory. These fields are found when you check the message.

* Sequences

Fields can be combined into sequences. Each sequence is contained in an outline
box and has a push button to expand or collapse it.

An expanded sequence that is indicated by a minus sign (-) shows you either a
header line and all fields, or a header line and only those fields that contain
data.

A collapsed sequence that is indicated by a plus sign (+) shows you only the
header line.

* Repeatable Sequences

A repeatable sequence is a field or group of fields that can be successively
entered in a message more than once. Each repetition of a repeatable sequence is
called an occurrence.

Repeatable sequences are displayed in a similar way as notebooks in which each
occurrence occupies a notebook page. You can expand or collapse repeatable
sequences in the same way as sequences. You can also browse through the
occurrences by selecting an occurrence with the spin button.

If you are in the edit mode and enter data in the last empty page, at the end of
this page another empty page is automatically created.

Navigation Elements

In a message with fields that you can edit, the cursor is automatically located in
the first field in which you can enter data. To move the cursor to the next field in
which you can enter data, press the Tab key or use the mouse.

For mandatory fields that are empty or for fields that contain incorrect data, you
get a warning message:

* When you select OK, the cursor is located in the previous field. You can then
correct the data.
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* When you select Cancel, the cursor remains where it was. The warning message
is ignored.

To scroll through the message, use the Page Up and Page Down keys.

Entering Data in S.W.L.LF.T. Messages

The MERVA Message Processing Client lets you enter, display, check, and handle
message data in different ways. You can, for example:

* Fill option fields automatically.

* Select different display modes for repeatable sequences.
* Move from field to field automatically.

* Switch off intermediate field checking.

For a detailed description on how to customize these options, refer to m

B&tﬁn.gs_ﬂn_page_ld' ” .

You must enter data in the message fields in the format specified in the S.W.L.ET.
User Handbook with the following exceptions for option fields, Bank Identifier Code
(BIC) fields and amount fields:

* Option fields

Some fields contain options as first subfields. These options define the layout of
the remaining field that can vary for different options. You must enter the option
before you can enter other data. The layout of the field might then change.

e BIC fields
In these fields, you can:
— Enter a nickname for a financial institution.

When you then press Tab, the nickname is replaced with the BIC code. At the
same time, the address information that is found in the correspondents
database is expanded.

— Enter a BIC of a financial institution.

When you then press Tab, the address information that is found in the
correspondents database is expanded.

— Double-click or press Ctrl + P to prompt for possible BIC information.
You then get the Prompt window. For a detailed description of this window

refer to [Waorking with the Prompt Codewords Window” on page 3.

During a session, the data that is retrieved from the server is stored in a cache.
For example, if currency data is changed on the server, you must sign off from
the client and sign on again to see the data changed.

* Amount fields
You can use abbreviations to specify amounts in the amount field, such as:
— T for thousand
For example, instead of 10000, you can type 10T.
— M for million
For example, instead of 20000000, you can type 20M.

— You can enter the amount with or without delimiters, for example, 1523,50 is
equivalent to 1.523,50. Both entries are shown as 1.523,50.
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Authentication Checking

When you enter the BIC code of the receiver’s LT in the SSW.ILET. application
header of a message, the MERVA server checks whether an authentication check
for the sender’s and receiver’s LTs is to be performed. If authentication keys are
not available, you get a warning.

During a session, the data that is retrieved from the server is stored in a cache. For
example, if currency data is changed on the server, you must sign off from the
client and sign on again to see the data changed.

If authentication checking is not active on the MERVA server, the check is not
performed.

Working with the Prompt Codewords Window
Some fields allow you to enter only defined values, such as:
e Currency code
* Codeword

Subfields that allow you to prompt for the possible values are indicated by color
according to the user settings.

To get the prompt window with a list of values that you can select, double-click on
a subfield that is enabled for prompting or enter Ctrl + P. Note that for codewords
the list of values might also depend on the message type.

The following figure shows you an example of a Prompt Codewords window:

= MERVA uszer at SA1 / SMINCMPT - Prompt Codewords  [H[=] [E3

Select codevord:

Code YWord

IACCH il
/BENDMLY/

JCHEQUE!
JCORPTRAD/
FHOLDS

AME,

N
ANTRACOM/
/PHOMN/

/PHONBEM/

FRHOMIBKS =
o »
oK I Cancel | Help |

Figure 12. Example of a Prompt Codewords Window

You can select OK to enter the selected value in the field that is enabled for
prompting. You can also select Cancel to close the Prompt Codewords window
without selecting a value.
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Working with the Prompt Correspondent Window

In some fields you must enter correspondent information. These fields allow you
to prompt for the information by showing you the Prompt Correspondent window.
In this window you can search for a correspondent in the correspondents database
of the server.

The following figure shows you an example of a Prompt Correspondent window:

i= MERVA - Prompt Correzpondent M=l E

Correspondent [minimum 4 characters):
|tt:st

Correspondent list:

~Correspondent details:
Name: Bank Testbank A =
[ -]
Branch: Branch 01 =]
|-
City: [City A
Search | Accept Cancel

Figure 13. Example of a Prompt Correspondent Window

To start the search:

1. In the Correspondent field, specify the value for which you want to search in
the correspondents database.

Note: You must enter at least four characters.
2. Select Search to start the search in the correspondents database.

After the search is completed successfully, you see the search results in the
Correspondent list list box. You can scroll through the list to select a
correspondent.

In the Correspondent details field, you can see details of the selected
correspondent.

3. Select Accept to use the selected correspondent for further processing within
message processing.

Working with the Clipboard

The Edit toolbar contains the toolbar buttons Cut, Copy, and Paste.

These buttons and the corresponding menu items of the Edit menu are
dynamically enabled:
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¢ Cut is enabled if you are in the edit mode and if text is selected.
* Copy is enabled if text is selected.

* Paste is enabled if the clipboard contains text.

Displaying only Fields with Data
You can change the amount of information that is displayed to you by:
* Expanding or collapsing message parts
* Displaying only fields that contain data

For details on how to expand or collapse sequences and repeatable sequences, refer
tO ’ : 77

You can also expand or collapse all sequences or repeatable sequences of the
complete message part by using the toolbar buttons or the corresponding menu
items of the View menu.

By selecting or deselecting Display only fields with data you can define to display
only fields with data or to display the complete message.

Checking Errors

Whenever you move to a new field by pressing Tab or by positioning the cursor,
MERVA checks that the data entered in the previous field is correct. If an error
occurs, an action message is shown.

Some fields depend on entries that are made in other fields. This cross-field
checking for errors is done when you select Accept, Accept with parameters,
Check, or Route to telex from the Message menu or from the action buttons.
When an error is found, you get the Checking Errors window. It shows you a list
of all errors that are found. The window looks like the following;:

i MERVA USER at SA1 / SMINCMPT - Checking Errors =] &=

Field name Error message

EMC2166]1 Must be 1 to 16 SWIFT characters.

SW32 ENC21771 Must be YYMMDD.

SWh0 EMC21661 Must be 1 to 35 SWIFT characters.

SWhI ENC21661 Must be 1 to 35 SWIFT characters. =
K| _>l_I

Cancel | Helpl

Figure 14. An Example of the Checking Errors Window

The Field name field shows you the identification of the field where the error
occurs.

The Error message field shows you error message ID and error reason.
When you double-click on the error message that is shown, the cursor is

positioned to the part of the message that causes the error. You can correct the
error, and accept or check the message. You can also correct the error later.
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Understanding the Text View of a Message Body

The message body is usually displayed in a formatted way according to the
message type that it represents. This allows you to enter data without knowing the
network structure of the message. If a message cannot be formatted correctly,
however, it is necessary to display the network structure of the message.

If the message cannot be formatted, the message body is automatically displayed
in network format, also called text view. You then get an error message that
indicates the formatting error. By default, the cursor is positioned at the place
where the error occurs. The following figure shows you an example of a text view
of a message that cannot be formatted correctly.

= MERVA USER at 5A1 / SMEDIT - Edit Message (Text View) =]
Edit Wiew Envelopes Help
A i Q
Cut Copy Find
~Error g
ENC2141E Mapping fails at position 56, expected literal -}. =
[
M ge text
{1:F01IBMADEFDAXCCK0 31501 6093H2:11 99IBMADE FOXCOONLH4: =l
:20TRN
(7912345
-}{5:{MAC:B6EER 7FH{CHK:3B7DBCFESCEOHTNG:}}
Kl ;I_I

Line 3 Character 89 of 118

| Switchto!ormaﬂedviewl Close | Helpl

Figure 15. An Example of the Text View Window

Working with the text view of a message allows you to correct the message and to
retry formatting. Note that you cannot change the message type and for SW.LET.
messages the LT addresses when you work in the text view mode.

The display of the text view of a message is only done automatically if a message
cannot be formatted correctly. You can, however, for any message except for the

Retype Message function, select Switch to text view from the View menu.

The following figure shows you the standard Text View window.
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= MERYA USER at SA1 / SMEDIT - Edit Message (T ext Yiew) =1 E3
Edit Wiew Envelopes Help

& & & Q
Cut Copy tate Find
M ge text
{1:FOTIBMADEF0A>2{<0315016093}H{2:1199IBMADEF03CO04N} A: =l

:20:TRAN
:79:12345
3{5:{MAC:B63995 7 [FTLREEIDIC 7ESCEOHTNG:}}

Line 3 Character 104 of 119

| Switchto!ormaﬂedviewl Close | Helpl

Figure 16. Standard Text View Window
The Text View window consists of several parts:

Menu Bar
The menu bar of the Text View window contains the following options:

+ Edit

* View

* Envelopes
* Help

When you create or edit a message, you can select the following options from the
Edit menu. When you do not create or edit a message, only Copy is available.

Cut  To move marked data to the clipboard.

Copy To copy marked data to the clipboard.

Paste To place data that you have cut or copied.

Find To open the Find window. For a detailed description refer to W
You can select the following options from the View menu:

Show MERVA-related data
To display the MERVA-Related Data window with information that is
assigned to the message by MERVA.

Switch to formatted view
To redisplay the message body in formatted view if the message can be
formatted correctly.

You can select the following option from the Envelopes menu:

Telex To send a message as a telex.

When you select this option, MERVA assigns a telex envelope to the
message. You can only select this option if your user profile has the
authorization to create a telex. You can only deselect this option if your
user profile has the authorization to remove a telex envelope. When you
deselect this option, the telex envelope is removed from the message.

You can select the following options from the Help menu:
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Help index
To display an alphabetical list of topics for which help information is
provided.

General help
To display overview information about the current window.

Using help
To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.

Message Text
The message text contains the message body in network format. For the functions

Create Message, Edit Message, or Edit Template, the text can be changed. For all
other functions, except for Retype Message, the text can be viewed.

At the bottom of the message text area, you see information according to the
current cursor position. The shown line and character numbers indicate the
number of lines and characters between the beginning of the displayed message
body and the cursor.

Action and Window Buttons
The following action and window buttons are valid:

Switch to formatted view
To redisplay the message body in formatted view if the message can be
formatted correctly.

Reject To mark a message as rejected during a verification step or an
authorization step and route it to further message-processing functions,
such as edit.

When you select Reject, you automatically get a comment field as part of
the MERVA-related data. In this field, you can enter a reason why you
reject the message or leave the comment field unchanged.

Close To close the Text View window without performing an action.

Help To display overview information about the current window.

Information Area
The information area shows information about the selected item or about the
choice on which the cursor is .

Finding Text in the Text View

In complex messages, it is difficult to find specific data in the text view. To help
you find specific text, MERVA offers you the Find Text window that allows you to
search for text parts, such as phrases, words, or word fragments. The search
process is similar to that of a text editor.

You can search in ascending or descending order. You can start the search from the

current cursor position, from the top of the message, or from the bottom of the
message.
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If you start searching in ascending order from the top of the message, the cursor is
positioned at the corresponding hit after each search for the string. This procedure
is repeated until the last hit is found. The same applies if you start searching in
descending order, or from the current cursor position.

The following figure shows you the Find Text window with an example.

= MERYA USER at SA1 f SMEDIT - Find Text M= E
Find: ICustumt:r

-Options

[ Ignore case Start at
{s

[~ Bewverse search Cursor
[ Iup
¢ Bottom

Eind | Close | Help |

Figure 17. Find Text Window

The Find Text window consists of several parts:
Find In this field you type the text you want to locate.

Options
Select Ignore case to locate text in uppercase and lowercase letters, no
matter how you have typed it. For example, “Bank”, “bank”, and “BANK”
is treated the same. This item is selected by default.

Select Reverse search to search from the position that is defined in the
Start at field to the beginning of the text.

Start at
To specify the start position of the search.
The following action and window buttons are valid:

Find To start the search for the string specified in the Find field. If no other
piece of data with the same information is found, this is indicated in the
information area.

Close To close the Find Text window without performing an action.

Help To display overview information about the current window.

Message Parts

A message consists of the message body, MERVA-related data, and optionally of
telex envelope and MERVA Link envelope. The following sections describe the
MERVA-related data and the MERVA Link envelope. For details on the telex

envelog)e refer to 'Chapter 13_Processing Telex and Free Eormat Messages” odl
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MERVA-Related Data

MERVA-related data contains data that MERVA assigns to a message to control and
monitor the message flow. This data is not sent via a network. The data depends
on the operating system that is used by the attached MERVA server. For details
refer to the corresponding User’s Guides of the MERVA servers.

The following list shows you all MERVA-related data available:

Message reference
A number that is assigned by MERVA to identify the message. For MERVA
Workstation, the number is called Message Reference Number (MRN). The
MRN is 16 characters long. For MERVA ESA, this number is the Unique
Message Reference (UMR). The UMR is 22 characters long.

Message entry date
This field is only valid for MERVA Workstation. It shows the date on
which the message is created, copied, or received in the form of
YYYY-MM-DD.

Message entry time
This field is only valid for MERVA Workstation. It shows the time on
which the message is created, copied, or received in the form of
HH:MM.SSSSSS.

Print flag
This field is only valid for MERVA Workstation. Y indicates that the
message was printed. N indicates that the message was not printed.

Last user
This field is only valid for MERVA Workstation. It shows the user ID of the
last user who changed the message.

Date last modified
This field is only valid for MERVA Workstation. It shows when the
message was last changed in the form of YYYY-MM-DD.

Sequences S.W.LET. information
The following fields are only available for SSW.IET. messages:

Message acknowledgment
This field contains the acknowledgment information ACK or NAK.

For detailed information about the NAK codes refer to the Online
Help of the MERVA Message Processing Client.

Authentication (MAC)
This field contains the message authentication code (MAC)
information.

Proprietary authentication (PAC)
This field contains the proprietary authentication code (PAC)
information.

Comment
In this field you can attach a comment, for example, the reasons for
rejecting a message during verification or authorization. This field is the
only MERVA-related data field that you can edit.

Reconciliation key
This field is only available for MERVA ESA. For details refer to MERVA
Traffic Reconciliation.
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Sequence trace entry
This field contains an entry with trace information. For MERVA
Workstation, only the latest trace entry is available. For MERVA ESA, a list
of trace entries is shown as a notebook.

The trace entry consists of:

User This field shows the user ID of the last user who worked with the
message, for example, the last user authorizing the message.

Function
This field shows the MERVA function that is active when the trace
entry is written.

Error This field shows the error code. If no error code exists, this field is
empty.

Date This field shows the date on which the trace entry is written in the
form of YYYY-MM-DD.

Time This field shows the time at which the trace entry is written in the
form of HH:MM.

Sequence Message Acknowledgment Explanation
If the field Message acknowledgment contains a S.W.LET.
acknowledgment message, the sequence explains the delivered
acknowledgment code in textual form.

The message acknowledgment explanation consists of:

Status This field shows you whether the SW.IET.
acknowledgment is positive or negative. If the
acknowledgment is negative, the status message contains
the returned SW.LET. NAK code and the number of the
incorrect message net format line.

Explanation  This field explains the returned S.W.LET. NAK code in
textual form.

The following figure shows you an example of a MERVA-Related Data window:
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= MERVA USER at BONA_S5A1 / SMYERIFY - Retype Message [MERVA-Related Data)

Figure 18. MERVA-Related Data Window
The MERVA-Related Data window consists of several parts:

Menu Bar
The menu bar of the MERVA-Related Data window contains the following options:

* Data
» Edit

* View
* Help

When you can edit fields, you can select the following options from the Data
menu. When you cannot edit fields, only Close is available.

Save To save the MERVA-related data.

Close To close the MERVA-Related Data window without saving any changes.
When you can edit fields, you can select the following options from the Edit menu.
When you cannot edit fields, only Copy is available.

Cut  To move marked data to the clipboard.

Copy To copy marked data to the clipboard.

Paste To place data that you have cut or copied.

44  MERVA Message Processing Client User’s Guide



You can select the following options from the View menu:

Display only fields with data
To display only fields that contain data. Empty fields are hidden.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.
You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help
To display overview information about the current window.

Using help
To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.

Action and Window Buttons
The following action and window buttons are valid:

Save To save the MERVA-related data. This action button is only available if you
can edit fields.

Close To close the MERVA-Related Data window without saving any changes.

Help To display overview information about the current window.

Telex Envelope
For details on the telex envelope refer to LC hapter 13 Processing Telex and Fred

Eormat Messages” on page 8.

MERVA Link Envelope

The MERVA Link envelope contains data that MERVA assigns to a message when
the message is sent via the MERVA Link feature. You cannot change this data.

The following list shows you all data available:

IAM identifier
This field shows the IAM message identifier. This identifier is identical for
all messages that are transferred via MERVA Link.

Originating node name
This field shows the MERVA Link node name.

Originating application name
This field shows the Application Support Program (ASP) name.
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The following figure shows you an example of MERVA Link data:

= USER at SA1 - Edit Message ([Envelopes]

_tooept | _Close | _Help |

Figure 19. MERVA Link Data

Envelopes View

The envelopes view contains the optional envelopes for telex and MERVA Link.

The following figure shows you an example of a telex envelope:
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= MERVA USER at SA1 / SMEDIT - Edit Message [Envelopes]

Lcoia |coms

ADDEESS OF SENDER'S BANK

13971006

TESTENKBXXEX

STREET1

{1 sl sl s L L et et et et el sl d sl sl s { {3 L et

_fooept | _Close | _telp |

Figure 20. An Example of a Telex Envelope
An envelope consists of several parts:

Menu Bar
The menu bar of the Envelopes View window contains the following options:

* Envelopes
* Edit

* View

* Help

When you are in an edit mode, you can select the following options from the
Envelopes menu. When you are not in an edit mode, only Check and Close is
available.

Accept
To check and save the envelopes data.

Check To check the envelopes data.

Save To save the envelopes data.

Close To close the current window without saving any changes.

When you are in an edit mode, you can select the following options from the Edit
menu. When you are not in an edit mode, only Copy is available.

Cut  To move marked data to the clipboard.
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Copy To copy marked data to the clipboard.

Paste To place data that you have cut or copied.

You can select the following options from the View menu:

Display only fields with data
To display only fields that contain data. Empty fields are hidden.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.
You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help

To display overview information about the current window.
Using help

To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.

Action and Window Buttons
The following action and window buttons are valid:

Accept
To check and save the envelopes data. This action button is only valid if
you can edit fields.

Save To save the envelopes data. This action button is only available if you can
edit fields.

Close To close the current window without saving any changes.

Help To display overview information about the current window.

Actions for Message Processing

48

The options that you see in the Message menus of the message-processing
windows depend on the settings for:

¢ MERVA functions
* User rights

The following list shows you all options available for message processing.

Accept
To complete a message after you enter your data and route it to the next
message-processing function.

When you select Accept:
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¢ The message is checked for errors.

If an error is found, you get the Checking Errors window. You can
correct the error, and accept or check the message. You can also correct
the error later.

If no error is found, the message is routed to the queue of the next
message-processing function.

¢ If the message contains envelopes, the envelopes are also checked.
Accept with parameters

To complete a message including parameters and route it to the next

message-processing function.

When you select Accept with parameters:

* The message is checked for errors.

If an error is found, you get the Checking Errors window. You can
correct the error, and accept or check the message. You can also correct
the error later.

If no error is found, you are asked to enter the parameters. If you select
OK after you enter the parameters, the message is routed to the queue
of the next message-processing function. If you select Cancel, no action
is performed, and the message window remains open.

* If the message contains envelopes, the envelopes are also checked.
Authenticate
To start reauthentication of the selected message. After reauthentication

completes, the message is routed accordingly. The routing depends on
successful or unsuccessful authentication.

Check To check a message.

When you select Check:
* The message is checked for errors.

If an error is found, you get the Checking Errors window. You can
correct the error, and accept or check the message. You can also correct
the error later.

* If the message contains envelopes, the envelopes are also checked.

Close To close the current window.

* When you select Close while creating a message, the creation process
ends. New messages are deleted and existing messages remain
unchanged.

* When you select Close while editing, authorizing, or retyping a
message, the respective process ends. The message remains where it was
without a change.

If the contents of the message is changed, you are asked to confirm closing
of the current window.

Copy to print
To copy a message to a print queue.

If more than one print queue exists, you get a list of all defined print
queues from which you can select a queue.

For details refer to t‘Chapter 12 Printing Messages” on page 83.

Delete To delete a message.
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You are asked to confirm the deletion. Only upon confirmation of the
delete request is the message deleted.

Delete by routing
To delete a message by routing it to a queue.

The message is marked as deleted and routed according to your routing
conditions.

Mark as failed
To route the selected message as it is routed when reauthentication fails.

Move To put a message into another queue and delete it from the original one.

Print To print a working copy of the message. After printing, the Print flag of
the message is set to Y.

For details refer to Chapter 12 Printing Messages” on page 83.

Reject To mark a message as rejected during a verification step or an
authorization step and route it to further message-processing functions,
such as edit.

When you select Reject, you automatically get a comment field as part of
the MERVA-related data. In this field, you can enter a reason why you
reject the message or leave the comment field unchanged.

Replace
To return a message with all changes to the queue without checking for
errors.

Requeue
To place a message at the end of the queue without checking for errors.

Route to edit
To route a message to the edit queue.

Route to telex
To route a message to the telex queue.

If more than one telex queue exists, you get a list of all telex queues from
which you can select a queue.

Save To save an incomplete message.
The message is saved and stays in the create queue.

Save as template
To save the currently displayed message as a template to reuse its data.

For MERVA Workstation, a secondary window, Specify Template Name
and Description, is displayed. The window looks like the following:
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Specify Template Hame and Description

5100
MT 100 Template

_Save | _Cancet | Help |

Figure 21. The Specify Template Name and Description Window

For MERVA ESA, this window is not displayed. Template name and description
are created by the server system according to its definitions.
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Chapter 7. Creating Messages

You use the create function to:

Create S.W.LLE.T. messages in categories 1 to 9, as defined in the S.W.LLET. User
Handbook.

Create S.W.LET. system messages in the categories GPA System Messages and
FIN System Messages, as defined in the S.W.L.E.T. User Handbook.

The creation of new messages is described in 'Working with the Create Messagd
hc 3 I 7 55

Create a S.W.LET. message to send as a telex.

The creation of SSW.LE.T. messages for telex transmission is described in

4 : ”

Complete unfinished messages.

How to complete unfinished messages is described in t!Chapter 10_Editing
Create and use template messages.
The creation and use of template messages are described in [/Creating a Messagd

Create telex messages and free format messages.

The creation and use of telex messages and free format messages are described
: i’ : 7
in

Creating a New Message

The MERVA Message Processing Client allows you to create different kinds of
messages, such as S.W.LET. Financial Messages and S.W.LET. System Messages.

When you select Create in the Message List window, the Select Message Type
window is the first window that is displayed to you. It shows you all message
types that you are allowed to create in hierarchical order. It also shows you all
template types that you are allowed to use. This window looks like the following:
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= MERYA USER at BOMA_S5A1 / SMINCMPT - Select Meszage Type M= E3

Start from:

& Message type

 Template

Application IS.W.I.F.T. Financial Messages j
Category I(AII categories> j

100 Customsr Transfer ﬂ
101 Request For Transfer
102 Ma== Payments
103 Single Customer Credit Transfer
104 Customer Direct Debit
108 EDIFACT Envelope
106 EDIFACT Envelope
0 Advice of Chegue
111 Request for Stop Pavment of a Chegue
112 Status of a Regquest for Stop Payment of a Cheque
190 Advice of Charges, Interest and other Adjustments
191 Request for Payment of Charges., Interest and other Expenses
192 Request for Cancellation
195 Queries
196 Answers =l
Create | Close | Hefresh | Help |

Figure 22. The Select Message Type Window

The Select Message Type window of the MERVA Message Processing Client is
divided into several parts:

The Start from field, where you choose to:
* Create new messages by selecting a message type.
* Create a new message by selecting a predefined template.

For a detailed description refer to I‘Creating a Message by Using a Template” onl

The Application list denotes the message applications available to you. You can
choose:

* SW.LET. Financial Messages in categories 1 to 9, as defined in the S.W.LET. User
Handbook

* SW.LET. System Messages in the categories GPA System Messages and FIN
System Messages, as defined in the S.W.L.F.T. User Handbook

* General messages, such as free format message or telex message

The Category list shows you the name and description of the message categories
that are contained in the selected application. Each category contains different
message types, for example, SW.LET. category 1 contains the message types 100 to
199. The default setting <All categories> allows you to enter a message type in the
entry field of the type list that can belong to any category of the selected
application.

The Type list shows you the key that identifies the message. The Description list
shows you the description of the messages that are assigned to the selected

category type.

Note that the contents of these fields depend on the rights that are assigned to
you. The examples that are shown describe all messages available.

The following action and window buttons are available:
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Create To create a new message and display the Create Message window.
Close To close the Select Message Type window without creating a message.

Refresh
To refresh the list of templates. This button is only active when you work
with templates.

Help To display overview information for the current window.

To create a new message:
* Select Message type in the field Start from. This is the default selection.
* Select an application from the Application field.
* Select a category from the Category field.
* Specify a message type in one of the following ways:
— Enter the message type.

For example, enter 100 to create a customer transfer that belongs to the
S.W.ILET. category 1, Customer Payments & Cheques.

— Select a message type from the Type list box.

* Select Create to get the Create Message window where you can enter the
message text.

Working with the Create Message Window

Depending on your selection in the Start from field, this window shows an empty
message body or the message body of the selected template.

The following figure shows you an example of a message with an empty message
body.
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= MERVA USER at SA1 / SMINCHMPT - Create Message

TESTENKBEXEX

971006 DEM 1.000.

.
_scept | _clse | |

Figure 23. The Create Message Window

The message consists of these parts:
. Messa:g:e body with message fields containing the message text as shown in

* MERVA-related data containing data that MERVA uses while processing the
message

You can see this data when you select Show MERVA-related data from the
View menu.

* Message envelopes assigned to the message body to send messages via telex
network or MERVA Link

If available, you can see the envelopes when you select Show message
envelopes from the View menu.

The information area shows you the following:

* Comment
If no comment is available, you see the text Comment: <No data available.>.
If a comment is available, you see the first part of the comment.

¢ Acknowledgment information

If this information is available, you see the first part of the message
acknowledgment field for SW.ILET. messages.

¢ General information

Shows you information about the selected menu item or the choice on which the
cursor is.
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You can see the complete information in the MERVA-Related Data window. For

details refer to 'MERVA-Related Data” on page 42.
How you enter data in the message fields is described in I!Chapter 6. Working with
Wi B e Wind ze]

12

Working with Menu Iltems
The menu bar of the Create Message window contains the following entries:
* Message
 Edit
* View
* Envelopes
* Help

Message
The options that you can select from the Message menu depend on the settings
for:

* MERVA functions
 User rights

For a detailed description of all options available refer to [/Actions for Messagd

17

Edit

You can select the following options from the Edit menu:
Cut  To move marked data to the clipboard.

Copy To copy marked data to the clipboard.

Paste To place data that you have cut or copied.

Delete data from message
To delete a specific subfield or a complete segment of data.

A secondary window shows you the choice for deletion that depends on
the position of the cursor. For example, if the cursor is positioned in a
subfield of an occurrence of a repeatable sequence, you can delete the
following data:

* Current subfield

* Field

e Data area

* QOccurrence

* Complete repeatable sequence

Insert an occurrence
To insert one occurrence of a repeatable sequence.

A secondary window shows you occurrences of repeatable sequences that
you can insert as an empty occurrence.

View

You can select the following options from the View menu:

Show MERVA-related data
To display the MERVA-Related Data window with information that is
assigned to the message by MERVA.
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Show message envelopes
To display the Message Envelope window that contains message envelopes
assigned to the message body.
The following message envelopes are valid:
* Telex

If the message is to be sent via the telex network or is received with a
telex envelope.
* MERVA Link

Assigned by MERVA if the message is received via MERVA Link.
If no envelope exists, this item is not active.

Display only fields with data
To display only fields that contain data. Empty fields are hidden.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.

Switch to text view
To display the message body in network format.

Envelopes
You can select the following option from the Envelopes menu:

Telex To send a message as a telex.

When you select this option, MERVA assigns a telex envelope to the
message. You can only select this option if your user profile has the
authorization to create a telex. You can only deselect this option if your
user profile has the authorization to remove a telex envelope. When you
deselect this option, the telex envelope is removed from the message.

Help

You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help
To display overview information about the current window.

Using help
To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information for the MERVA Message Processing
Client.

Working with Action and Window Buttons

The action and window buttons of the Create Message window allow you to
perform actions that are related to the message and to the active window.
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The action buttons that are shown depend on the settings for:
¢ MERVA functions
 User rights

For a detailed description of all options available refer to LActions for Messagd

Emcesslnvg—w .

The following window buttons are valid:

Close To close the Create Message window without performing an action and
return to the Message List window.

Help To display overview information for the current window.

Creating a Message by Using a Template

A template usually contains information that is reused on a regular basis. It serves
as an outline that you can use to create a finished message of this type.

When you select Template in the Start from field, the Select Message Type
window looks like the following:

i= MERVA USER at BONA_S5A1 / SMINCHMPT - Select Template

SMW.LF.T. Financial Messages |_
<All categories> |_

100 Te=tl

Figure 24. The Select Message Type Window with Template Selected as Message Type

The Select Template window is divided into different parts:

The Application list shows the message applications available to you. The contents
of this field depend on the existing templates. For example, you might choose:

* SW.LET. Financial Messages in categories 1 to 9, as defined in the S.W.LE.T. User
Handbook

¢ S.W.IET. System Messages in the categories GPA System Messages and FIN
System Messages, as defined in the S.W.LE.T. User Handbook
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The Category list shows you the name and description of the message categories
that are contained in the selected application. Each category contains different
message types, for example, SW.LET. category 1 contains the message types 100 to
199. The default setting <All categories> allows you to enter a template identifier
with a type in the entry field of the type list. The template can belong to any
category of the selected application.

The lists Template, Type, and Description show you the template name, message
type of the template, and template description of the templates that you are
allowed to access.

Note: Entries in the Application list, the Category list, and the Type list might be
marked with the label (?). Entries with this label refer to applications,
categories, or message types that are incorrect according to the current
message-processing rules of the client. A reason can be, for example, that the
templates stored on the MERVA Server refer to message types that do no
longer exist due to the yearly SW.LET. changes.

If you use an incorrect template to create a message, or if you display or
edit an incorrect template, you get message-processing errors. To avoid this,
delete the incorrect templates. For a description of how to do this, refer to

G ”

The following action and window buttons are available:
Create To create a new message.
Close To close the Select Message Type window without creating a message.

Refresh
To refresh the list of templates. This button is only active when you work
with templates.

Help To display overview information for the current window.

To create a message by using a template:

* Select Template in the field Start from.

* Select an application from the Application field.
* Select a category from the Category field.

* Specify a template in one of the following ways:

— Enter the name of the template that you want to use as an outline for the
message.

— Select a template from the Template list box.

* Select Create to get the Create Message window with the message body of the
selected template.

Creating a S.W.L.LF.T. Message for Telex Transmission

To create a SW.LET. message for transmission via the public telex network, select
Telex from the Envelopes menu of the Create Message window. The telex envelope
is then created.

To display the telex envelope, select Show message envelopes from the View
menu of the Create Message window. You then get the envelope view of the
message with the telex envelope. If appropriate, you also get the MERVA Link
envelope.
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The following figure shows you an example of a telex envelope:

= MERVA USER at SA1 / SMEDIT - Edit Message [Envelopes)

o |come
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Figure 25. The Telex Envelope

Fields Filled Automatically

When you first create the telex envelope for a SW.LET. input message, as much
information as possible is taken from the existing message to fill the telex header.

The contents of the LT Address field of the SSW.LE.T. basic header are used for a
search in the correspondents database to fill the From Address field.

The contents of the Receiver LT field of the SSW.LET. message (BIC code) are
copied to the To ID field of the telex header. The correspondents database is then
searched for the correspondent that is specified in the To ID field.

If a record is found in the correspondents database, the following telex header
fields are filled automatically if data is available:

To Address
Telex Line
Telex Number 1
Answerback 1
Telex Number 2
Answerback 2

Other fields that are filled automatically are:
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* Sending Date
This field is filled with the current date.
¢ Telex Reference

This field is filled with the contents of field 20 if field 20 is available in the
S.W.ILET. message body.

* Testkey Calculation Required
By default, this field is filled with Y.

Telex Header Fields

The following list shows you all telex header fields for a S.W.LET. message. For a
more detailed description of telex header fields refer to Vi

From Address

This field contains the sender’s address in up to four lines of 35 characters
each.

Sending Date
This field contains the current date in the form of YYYYMMDD.

To ID This field contains the identifier of the correspondent of up to 11 characters
long.

To Address
This field contains the receiver’s address in up to four lines of 35
characters each.

Telex Line
This field contains the telex line on which the telex message is sent. The
line numbers available depend on your installation.

Telex Reference
This field contains the telex reference identifier of up to 16 characters.

Telex Number 1
This field contains the dial-up number of up to 20 characters long.

Answerback 1
This field contains the expected answerback in up to 20 characters.

For a detailed description of answerback checking refer to the MERVA USE
& Branch for Windows NT Application Programming Guide.

Telex Number 2
This field contains an alternative dial-up number that is used if the
number specified in the Telex Number 1 field cannot be reached. The
format and meaning of Telex Number 2 are identical to those of Telex
Number 1.

Answerback 2
This field contains the expected answerback for the alternative dial-up
number.

Priority
This field indicates the priority of the message. The following priorities are
available:

N Normal priority
8) Urgent priority

T Timed telex that means delayed transmission via telex link.
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If you enter T, you must enter the earliest possible transmission
time in the Time field. Note that you can also specify a date.

Timed Telex Send Time
This field indicates the time for the telex transmission of the timed telex.

You must specify the transmission time in the form of HHMM where HH
stands for hours (00 to 23) and MM stands for minutes (00 to 59).

Timed Telex Send Date
This field indicates the date for the telex transmission of the timed telex.

You must specify the transmission date in the form of YYYYMMDD where
YYYY stands for the year, MM stands for the month (01 to 12), and DD
stands for the day (01 to 31).

Comment
This field contains a comment of up to 64 characters for the attention of
the receiver.

Telex Testkey Fields

Testkey Calculation Required
This field indicates whether a testkey calculation has to be performed for
this message. By default, the field is filled with a value that is specified
with the customization of the MERVA server to which the client is
connected. If the server does not deliver this value, the field is filled with
Y. If you do not want to calculate a testkey, overwrite Y with N.

Testkey Flag
The value for this field is one of the following characters:

N The testkey calculation is not yet performed or failed.

C The testkey is calculated by a testkey processing program.

\" The testkey is verified by a testkey processing program.

G The testkey is verified but the sequence number is out of sequence

and therefore wrong.
M The testkey is manually calculated or verified.

Calculation Comment
In this field you can enter a comment that explains the calculation testkey.

After you complete the telex header, you can select one of the following:

Accept
To check the telex header for completeness.
The following fields must be filled:
* The first line of the From Address field
* The first line of the To Address field
* The Telex Number 1 field
* The Priority field

If the priority of the message is T, the Time Telex Send Time field must
also be filled.

* The Testkey Calculation Required field

Save To save the telex envelope without checking that the mandatory fields are
complete.
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Use this option in case you cannot complete the telex header. The complete
message can then only be saved as incomplete.

Check To check the telex envelope.

Close To close the telex envelope without saving any entries or changes.
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Chapter 8. Retyping Messages

During the verification process, the message is displayed on your screen. You
should then check the contents by reading through the message. Some message
types also contain fields that must be retyped.

This chapter explains how to verify messages by reading through the contents and
retyping fields that are activated for data entry. It also shows you how to verify a
telex message.

Selecting a Message for Verification

You can select the messages that you want to verify in one of the following ways:

¢ In the Function List window specify Retype in the Display only field. This
displays all message lists that you are allowed to verify. Then double-click on
the list or select Open to get the Message List window.

* In the Function List window select Find to get the Specify Find Parameters
dialog where you can specify search parameters.

* Select a verification function from the Function List window. Then double-click
on the function or select Open to get the Message List window.

Verifying a Message
Some message types can be verified by reading through the message. Other
message types contain fields that must be retyped. To verify those messages, you
must retype specific data to match the data originally entered.

After a subfield is retyped correctly, it becomes a read-only field.

The following figure shows you an example of a Retype Message window:
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Figure 26. The Retype Message Window

When you start the Retype Message window, you see only those fields that contain
data or that have to be retyped. If you want to see all fields, select Display only
fields with data from the View menu.

A message is not marked as correct until you retype all fields that are marked for
retype verification. You can make three attempts at retyping the contents of each
field as it was originally entered. After the third unsuccessful attempt, the message
is marked as incorrect and routed according to your routing conditions, usually to
edit.

If the retyped information is correct, accept the message to route it to the next
message-processing function. If you do not have the correct information, reject the
message. It is then routed to the next message-processing function. You can add a
comment in the comment field of the MERVA-related data. You can also leave the
comment field unchanged. The comment field is displayed automatically. The
comment might help the user who subsequently handles the message to correct the
error.

The information area shows you the following:

* Comment
If no comment is available, you see the text Comment: <No data available.>.
If a comment is available, you see the first part of the comment.

* Acknowledgment information

If this information is available, you see the first part of the message
acknowledgment field for S.W.LET. messages.

¢ General information

Shows you information about the selected menu item or the choice that the
cursor is on.
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You can see the complete information in the MERVA-Related Data window. For

details refer to 'MERVA-Related Data” on page 42.

Working with Menu Items
The menu bar of the Retype Message window contains the following entries:

* Message
 Edit
* View
* Envelopes
* Help
Message

The options that you can select from the Message menu depend on the settings
for:

* MERVA functions
* User rights

For a detailed description of all options available refer to ‘Actions for Messagd

17

Edit

You can select the following options from the Edit menu:
Cut  To move marked data to the clipboard.
Copy To copy marked data to the clipboard.

Paste To place data that you have cut or copied.

View
You can select the following options from the View menu:
Show MERVA-related data

To display the MERVA-Related Data window with information that is
assigned to the message by MERVA.

Show message envelopes
To display the Message Envelope window that contains message envelopes
assigned to the message body.
The following message envelopes are valid:
* Telex

If the message is to be sent via the telex network or is received with a
telex envelope.
* MERVA Link

Assigned by MERVA if the message is received via MERVA Link.
Display only fields with data

To display only fields that contain data. Empty fields are hidden. This
option is selected by default.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.
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Envelopes
You cannot select any options from the Envelopes menu.

Help

You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help
To display overview information about the current window.

Using help
To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.

Working with Action and Window Buttons

The action and window buttons of the Retype Message window allow you to
perform actions that are related to the message and to the active window.

The action buttons that are shown depend on the settings for:
* MERVA functions
* User rights

For a detailed description of all options available refer to I‘Actions for Messagd

17

The following window buttons are valid:

Close To close the Retype Message window without performing an action and
return to the Message List window.

Help To display overview information about the current window.

Verifying a Telex Message

68

If the message that you verify is a telex message, select Show message envelopes
from the View menu to see the message envelopes.

To verify the message:
1. Check that the information in the telex header is correct.
2. Select Close to end displaying of the telex envelope.

You can then proceed to verify the message as described in I'Verifying a Message”]
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Chapter 9. Authorizing Messages

A message can be authorized in one or more authorization steps before it can be
sent to the SSW.LET. or telex network. This is done by reading through the message
to check it for errors. If the message is correct, it is sent to the respective network.

This chapter explains how to authorize messages by reading carefully through the
contents. It also shows you how to authorize a telex message.

Selecting a Message for Authorization

You can select the messages that you want to authorize in one of the following

ways:

¢ In the Function List window specify Authorize in the Display only field. This
displays all message lists that you are allowed to authorize. Then double-click
on the list or select Open to get the Message List window.

* In the Function List window select Find to get the Specify Find Parameters
dialog where you can specify search parameters.

e Select an authorization function. Then double-click on the function or select
Open to get the Message List window.

Authorizing a Message

The MERVA system offers two authorization functions, first authorization and
second authorization. If your system is customized to use two authorization
functions and if the message matches the specified criteria, your message must
pass through both before it can be sent.

After the first authorization, messages are usually routed to the second
authorization. If your system is customized in this way, the first and the second
authorization procedures are identical.

Note that the customization of your system might not allow you consecutive
message-processing actions. Therefore, you might not be able to authorize a

message that you previously processed.

The following figure shows you an example of an Authorize Message window for
the first authorization:
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Figure 27. The Authorize Message Window

To authorize a message, read it carefully to check for errors.

If the information is correct, accept the message to route for further processing. The
next processing function can be a second authorization function or a SW.LET. Link
ready-to-send queue. This depends on the routing conditions of your system.

If the message is incorrect, mark it as incorrect by selecting Reject. It is then routed
to the edit function to be corrected. Depending on the routing conditions of your
system, the message might be routed to a function other than edit. You can add a
comment in the comment field of the MERVA-related data. You can also leave the
comment field unchanged. The comment field is displayed automatically. The
comment might help the user who subsequently handles the message to correct the
error.

The information area shows you the following:

* Comment
If no comment is available, you see the text Comment: <No data available.>.
If a comment is available, you see the first part of the comment.

¢ Acknowledgment information

If this information is available, you see the first part of the message
acknowledgment field for SW.LET. messages.

* General information
Shows you information about the selected menu item or the choice on which the
cursor is.

You can see the complete information in the MERVA-Related Data window. For

details refer to EMERVA-Related Data” on page 47.
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Working with Menu Items
The menu bar of the Authorize Message window contains the following entries:
* Message
* Edit
* View
* Envelopes
* Help

Message
The options that you can select from the Message menu depend on the settings

for:
e MERVA functions
* User rights

For a detailed description of all options available refer to I‘/Actions for Messagd

17

Edit

You cannot select any options from the Edit menu.

View
You can select the following options from the View menu:
Display only fields with data

To display only fields that contain data. Empty fields are hidden. This
option is selected by default.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.

Switch to text view
To display the message body in network format.

Envelopes
You cannot select any options from the Envelopes menu.

Help

You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help

To display overview information about the current window.
Using help

To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.
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Working with Action and Window Buttons

The action and window buttons of the Authorize Message window allow you to
perform actions that are related to the message and to the active window.

The action buttons that are shown depend on the settings for:
* MERVA functions
* User rights

For a detailed description of all options available refer to l‘Actions for Messagd

The following window buttons are valid:

Close To close the Authorize Message window without performing an action and
return to the Message List window.

Help To display overview information about the current window.

Authorizing a Telex Message

At any time during the authorization process, you can select Show message
envelopes from the View menu to see the message envelopes.

To authorize the message:
1. Check that the information in the telex header is correct.
2. Select Close to end displaying of the telex envelope.

You can then proceed to authorize the message as described in m

Message” on page 69.
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Chapter 10. Editing Messages

You can edit an incorrect message by checking the comment that is attached to the
message if a comment exists. You then read through the message and correct any
errors. After you correct and check the message, you mark the message as correct
and forward it to the next-message processing function.

This chapter shows you how to complete or modify a previously created message
that is not yet complete, failed verification or authorization, or was rejected by the
network it was sent to, for example, NAK messages from the SSW.LET. network. It
also shows you how to edit a telex message.

Selecting a Message for Editing

You can select the messages that you want to edit in one of the following ways:

¢ In the Function List window specify Edit in the Display only field. This displays
all message lists that you are allowed to edit. Then double-click on the list or
select Open to get the Message List window.

* In the Function List window select Find to get the Specify Find Parameters
dialog where you can specify search parameters.

* Select an edit function. Then double-click on the function or select Open to get
the Message List window.

Editing a Message

In the Edit Message window you can edit a message that:
* Is not yet complete

e Failed verification

* Failed one of the authorization steps

* Is rejected by the respective network

The following figure shows you an example of an Edit Message window:
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Figure 28. The Edit Message Window

To edit a message:
* Read through the message to find possible errors.

* Check the comment that is attached to the message to see possible errors or
reasons for rejection.

* Use the Check function to display all errors. Then, read through the message
and correct any errors that are indicated in the error messages.

* After you enter the data, accept the message by selecting Accept and route it to
further message-processing functions.

Cross-field checking is then carried out. If an error is found, you get the
Checking Errors window.

If you select Close while you edit a message, the editing process ends. The
message is routed back to the edit queue without a change.

The information area shows you the following;:

* Comment
If no comment is available, you see the text Comment: <No data available.>.
If a comment is available, you see the first part of the comment.

* Acknowledgment information

If this information is available, you see the first part of the message
acknowledgment field for SW.LET. messages.

¢ General information

Shows you information about the selected menu item or the choice on which the
cursor is.
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You can see the complete information in the MERVA-Related Data window. For

details refer to 'MERVA-Related Data” on page 42.

Working with Menu Items
The menu bar of the Edit Message window contains the following entries:

* Message
 Edit

* View

* Options
* Help

Message

The options that you can select from the Message menu depend on the settings
for:

¢ MERVA functions

* User rights
For a detailed description of all options available refer to ‘Actions for Messagd

17

Edit

You can select the following options from the Edit menu:
Cut  To move marked data to the clipboard.

Copy To copy marked data to the clipboard.

Paste To place data that you have cut or copied.

Delete data from message
To delete a specific subfield or a complete segment of data.

A secondary window shows you the choice for deletion that depends on
the position of the cursor. For example, if the cursor is positioned in a
subfield of an occurrence of a repeatable sequence, you can delete the
following data:

* Current subfield

* Field

e Data area

* Occurrence

* Complete repeatable sequence

Insert an occurrence
To insert one occurrence of a repeatable sequence.

A secondary window shows you occurrences of repeatable sequences that
you can insert as an empty occurrence.

View
You can select the following options from the View menu:
Show MERVA-related data

To display the MERVA-Related Data window with information that is
assigned to the message by MERVA.

Show message envelopes
To display the Message Envelope window that contains message envelopes
assigned to the message body. The following message envelopes are valid:
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 Telex
If the message is to be sent via the telex network or is received with a
telex envelope.

* MERVA Link
Assigned by MERVA if the message is received via MERVA Link.

Display only fields with data
To display only fields that contain data. Empty fields are hidden. This
option is selected by default.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.

Switch to text view
To display the message body in network format.

Envelopes
You can select the following option from the Envelopes menu:

Telex To send a message as a telex.

When you select this option, MERVA assigns a telex envelope to the
message. You can only select this option if your user profile has the
authorization to create a telex. You can only deselect this option if your
user profile has the authorization to remove a telex envelope. When you
deselect this option, the telex envelope is removed from the message.

Help

You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help

To display overview information about the current window.
Using help

To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.

Working with Action and Window Buttons

The action and window buttons of the Edit Message window allow you to perform
actions that are related to the message and to the active window.

The action buttons that are shown depend on the settings for:
¢ MERVA functions
* User rights

For a detailed description of all options available refer to 'Actions for Messagd
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The following window buttons are valid:

Close To close the Edit Message window without performing an action and
return to the Message List window.

Help To display overview information about the current window.

Editing a Telex Message

At any time during the edit process, you can create a telex envelope or remove an
existing one depending on the settings for MERVA functions and user rights. To
create a telex envelope, select Telex from the Envelopes menu. To remove a telex
envelope, deselect Telex from the Envelopes menu. For a detailed description of

the fields of the telex headers, refer to I‘Creating a SWIET Message for Telex

”

To display the contents of a telex envelope, select Show message envelopes from
the View menu. You then see the message envelopes.

To end processing or displaying of the telex envelope, select one of the following:
* Accept
To check and store the telex envelope.
* Save
To save the telex envelope without checking.
* Check
To check the telex envelope.
* Close

To close the telex envelope without changes.

You can then proceed to edit the message as described in IEditing a Message” orl
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Chapter 11. Displaying Messages

To display messages means to view a message in a read-only mode. You can also
display message envelopes and the data that MERVA assigns to the message.

Selecting a Message for Displaying

You can select the message that you want to display in one of the following ways:

* In the Function List window specify Display in the Display only field. This
shows you all message lists that you are allowed to display. Then double-click
on the list or select Open to get the Message List window.

* In the Function List window select Find to get the Specify Find Parameters
dialog where you can specify search parameters.

* Select a display function. Then double-click on the function or select Open to get
the Message List window.

Displaying a Message

In the Display Message window you can only view a message. You cannot change
the message text or accept the message.

The following figure shows you an example of a Display Message window:
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= MERVA USER at 5A1 / SMEDIT - Display Message

Figure 29. The Display Message Window

The information area shows you the following:

* Comment
If no comment is available, you see the text Comment: <No data available.>.
If a comment is available, you see the first part of the comment.

* Acknowledgment information

If this information is available, you see the first part of the message
acknowledgment field for SW.LET. messages.

* General information
Shows you information about the selected menu item or the choice on which the
cursor is.

You can see the complete information in the MERVA-Related Data window. For

details refer to EMERVA-Related Data” on page 47.
Working with Menu Items

The menu bar of the Display Message window contains the following entries:

* Message
+ Edit

* View

* Envelopes
* Help
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Message
The options that you can select from the Message menu depend on the settings
for:

¢ MERVA functions
* User rights

For a detailed description of all options available refer to l/Actions for Messagd

1

Edit
As the text is read-only data, you cannot select all options from the Edit menu.
The following options are available:

Copy To copy marked data to the clipboard.

View
You can select the following options from the View menu:
Show MERVA-related data

To display the MERVA-Related Data window with information that is
assigned to the message by MERVA.

Show message envelopes
To display the Message Envelope window that contains message envelopes
assigned to the message body. The following message envelopes are valid:

o Telex

If the message is to be sent via the telex network or is received with a
telex envelope.
* MERVA Link

Assigned by MERVA if the message is received via MERVA Link.

Display only fields with data
To display only fields that contain data. Empty fields are hidden. This
option is selected by default.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.

Switch to text view
To display the message body in network format.

Envelopes
You cannot select any options from the Envelopes menu.

Help

You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help
To display overview information about the current window.

Using help
To display information on how to use the help facility.
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Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.

Working with Window Buttons
The window buttons of the Display Message window allow you to perform actions
that are related to the active window. Note that there are no action buttons for this
window.

The following window buttons are valid:

Close To close the Display Message window without performing an action and
return to the Message List window.

Help To display overview information about the current window.
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Chapter 12. Printing Messages

You can print a message in different ways. You can send a copy of the message to
the print queue. The automatic print process of the MERVA Server then prints a
copy of the message. After printing, the print flag that is associated with the copy
of the message by MERVA is changed to Y.

You can also print a working copy of the message. The MERVA Message Processing
Client then changes the print flag of the printed message immediately. This feature
is additional to the printing facilities that are offered by the MERVA servers.

Note that the print flag is available only for MERVA Workstation.

Selecting a Message for Printing

The MERVA Message Processing Client allows you to select the message that you
want to print in one of the following ways:

* In the Message List window select the message that you want to print, then
select Copy to print.
The message is copied to the print queue. The print flag is changed when the
message is printed.

¢ In the Message List window select Copy to print from the Selected menu or
from the pop-up menu.
The message is copied to the print queue. The print flag is changed when the
message is printed.

* From a message-processing window, select Copy to print from the Message
menu.
The message is copied to the print queue. The print flag is changed when the
message is printed.

* Print a working copy from a message window by selecting Print from the
Message menu of a message-processing window.

A working copy of the message is printed. After printing, the print flag is
changed.

Printing a Message by Using Copy to Print

Each of the described methods of selecting a message causes the Select Print
Queue window to be displayed. The window looks like the following:
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i Select Print Target Queue H=] B3

Select target queue from the list:
PRINTACK
SLPRINT1
SLPRINT2
H*TW _FILE
*TW_PRN

KN i

Accept I Cancel | Helpl

Figure 30. The Select Print Queue Window

To print a message or a list of messages:
 Select a print queue from the list.
* Select Accept.

Select Cancel to close the Select Print Queue window without printing the
message.

Select Help to get overview information for the current window.

Printing a Working Copy of a Message

You can also print a working copy of a message by selecting Print from the
Message menu of a message-processing window. Depending on your printer
settings, you can route the working copy directly to a printer or store it in a file.

For information about the print options refer to I‘Changing Settings” on page 10.

The following figure shows you an example of a working copy of a message.

Page 1 of 1

| HERVA Working Copy I
Hessage already printed: Mo

Hsg Reference:  SOFRZHZB70000007, Queue: SMINCPLT, 97-05-07-14.23.55. 000123
Hog Tupe: 100 (Customer Transfer)
Basic Header  Appl Id: F APDU Id: 01 LT fddr:  TBHHERVAXKXK
Session: 0008 Sequence: 000000
fApplication Header  Inpul/Output: I
Receiver LT:  IBHHERVAZKXX

Hsg Type: 168

181
Boeblingen
Priority: N Delivery Hon.: Obsolesc. period:
TRN #20 12348
Value finount %32 M Date 970507 Cade DEM Amount 1686,
Ordering Cust. #50  Mr. Luckywan
Beneficiary 489  /
Hr. Customer
———————————————————————— > End of Heasage  {-----—------------ooooooooooooo

Figure 31. An Example of a Working Copy of a Message
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Chapter 13. Processing Telex and Free Format Messages

The MERVA Message Processing Client allows you to work with telexes and free
format messages in different ways. You can, for example, create telexes or telex
envelopes, use the dispatch function, or display telex information. You can also
create a free format message. Each of these options is described in detail in this
chapter.

Creating Telexes

With the MERVA Message Processing Client, you can create telexes. Telexes belong
to the message application General. For more information on message applications
refer to L -

When you select Create in the Message List window, the Select Message Type
window is the first window that is displayed to you. (For a detailed description on
the Message List window refer to £ i i ”

.) The Select Message Type window shows you in hierarchical order all
message types that you are allowed to create. It also shows you all template types
that you are allowed to use. The following figure shows you what this window
looks like if you want to create a telex:

= MERYA USER at BONA_S5A1 / SMINCMPT - Select Message Type _ O]
Start from:
* Message type
" Template
Application General Messages @
Category IGeneraI Category j
Typ= Description
IFREE Free Format Message

TELEXTSH Telex to Send

Create | Close | Hetresh | Helpl

Create a new mnessage starting from a message type or a template.

Figure 32. The Select Message Type Window for Telex Creation

To create a telex:
* Select Message type in the field Start from. This is the default selection.
* Select General from the Application field.
* Select General from the Category field.
* Specify a message type in one of the following ways:
— Enter TELEXTSN as message type.
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— Select TELEXTSN as message type from the Type list box.

A telex envelope is created by default. You must fill in this envelope before you
can send the telex.

The line length can be up to 69 characters. You must use the telex character set.

Creating a Telex Envelope

To create a telex envelope for transmission of a message via the public telex
network, select Telex from the Envelopes menu of the appropriate
message-processing window. The telex envelope is then created.

To display the telex envelope, select Show message envelopes from the View

menu of the message-processing window. You then get the envelope view of the

message with the telex envelope. If appropriate, you also get the MERVA Link
envelope.

The following figure shows you an example of a telex envelope:

= MERVA USER at 5A1 / SMINCHMPT - Create Message (Envelopes)

SENDER'S ADDRESS

19971006

TESTENKBXXX

STREET

A

=
L — [
REIEIEEIR IR EEE R EEE R E R EEEE R R

_tooept | _Close | _Help |

Figure 33. The Telex Envelope

The telex information that you must enter in a telex envelope consists of several
parts:

e Telex header
* Telex testkey

For general telexes, these parts are described in the following sections. For

S.W.LET. messages, refer to I’Creating a SWIFET. Message for Telex Transmission’]
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Creating the Telex Header

Depending on your message type and the contents of the correspondents database
for SW.ILET. messages, some of the telex header fields are filled automatically. For

a detailed description of all telex header fields refer to Bhe.mm.glelex.l:leadeﬂ

”

After you complete the telex header, you can select one of the following options.
Note that these options are available from the Message menu. Some of the options
are also available from the push buttons.

Accept

To check the telex header for completeness and save it.

The following fields must be filled:

* The first line of the From Address field

* The first line of the To Address field

* The Telex Number 1 field

* The Priority field
If the priority of the message is T, the Timed Telex Send Time field
must also be filled.

Save To save the telex envelope without checking that the mandatory fields are
complete.

Use this option if you cannot complete the telex header. The message is
then saved as incomplete.

Check To check the telex envelope.

Close To close the telex envelope without saving any entries or changes.

Creating the Testkey Fields

The telex testkey information can be used for testkey checking between
correspondents. The following telex testkeys are available:

* Testkey Calculation Required
* Testkey Flag
e Testkey

¢ Calculation Comment

Note: The field Testkey Calculation Required must be filled.

For a detailed description of all testkey fields, refer to EViewing Telex Testkey

: ”

Working with the Dispatch Function

The MERVA Message Processing Client offers you a dispatch function that helps
you work with telex messages.

Depending on the rights that are assigned to the queue on which you currently
work, the following options are available:

Calculate Testkey
To enter a testkey for an outgoing telex message.
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Route NAKed Telexes
To correct the telex address information of a negatively acknowledged telex
message (NAKed telex message) that must be retransmitted.

Route to Telex
To send messages to the public telex network that are in a ready-to-send
queue for the SSW.LET. network.

Verify Testkey
To verify a testkey that is attached to an incoming telex message and to
append the result to the message. The message is then routed accordingly.

These functions can be selected from the appropriate message-processing window
menus. The functions are described in detail in the following sections.

Calculating Testkeys

Use calculating testkeys to insert a testkey with a short comment into a message.

In the supplied standard routing, verified and authorized telex messages that
contain the value Y in the Testkey Calculation Required field of the telex header
are routed to a testkey calculation queue. The telex messages are then processed by
this function.

After you select a message, the message body of the selected message is shown in
dispatch mode. The following figure shows you an example of a message in
dispatch mode:

= MERVA USER at 5A1 / TMKEYCAL - Dispatch Message

Figure 34. Example of a Message Body in Dispatch Mode for the Calculate Testkey Function

To display the contents of the telex envelope, select Show message envelopes from
the View menu. You then see the message envelopes.
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You can select, deselect, and change the following telex testkey fields:

Testkey
To enter a testkey of up to 16 characters.

Testkey Flag
The value for this field is one of the following characters:

N The testkey calculation is not yet performed or failed.

C The testkey is calculated by a testkey processing program.

A% The testkey is verified by a testkey processing program.

G The testkey is verified but the sequence number is out of sequence

and therefore wrong.
M The testkey is manually calculated or verified.

Calculation Comment
To enter a comment of up to two lines of 35 characters each.

To end processing or displaying of the telex envelope, select one of the following
options. Note that these options are available from the Envelopes menu. Some of
the options are also available from the push buttons.

* Accept
To check and store the telex envelope.
¢ Check
To check the telex envelope.
* Save
To save the telex envelope without checking.
* Close
To close the telex envelope without changes.
To end processing or displaying of the message, select one of the following

options. Note that these options are available from the Message menu. Some of the
options are also available from the push buttons.

* Accept

To check, store, and route the message according to your routing conditions.
* Route to edit

To route the message to the edit queue.
* Close

To close the message without changes.

Routing Negatively Acknowledged Telex Messages

For different reasons, it might not be possible to send a message via the telex
network. Those messages are called negatively acknowledged (NAKed). They are
routed to an appropriate message queue.

In this queue, you can proceed with the message as follows:
¢ Check

* Delete

* Route to a queue for retransmission

* Route to a queue for correction and retransmission

Chapter 13. Processing Telex and Free Format Messages 89



The telex information that is contained in a NAKed telex is the same as for a
transmitted telex. For a detailed description of the telex information parts, refer to

the corresponding section in ['Viewing Telex Information in Telex Envelopes” onl

Use the route NAK telexes function to process NAKed messages. With the Route
NAKed telexes function, you can analyze why a message was not sent. You can
also correct possible errors that are found in the telex header. The message is then
routed to a telex queue from which it is later sent to the telex network.

You can determine the reason for the negative acknowledgment from one of the
following:

* Box Termination Code

* Expected Answerback

* Reason Code

After you select a message, the message body of the selected message is shown in

dispatch mode. The following figure shows you an example of a message in
dispatch mode:

= MERVA USER at 5A1 / TMNAKS - Dispatch Message

Figure 35. Example of a Message in Dispatch Mode for the Route NAKed Telex Messages
Function

To display the contents of the telex envelope, select Show message envelopes from
the View menu. You then see the message envelopes.

You can select, deselect, and change the telex header fields. You can also check the
telex header fields by selecting Check from the Envelopes menu.
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To end processing or displaying of the telex envelope, select one of the following
options. Note that these options are available from the Envelopes menu. Some of
the options are also available from the push buttons.

* Accept
To check and store the telex envelope.
¢ Check
To check the telex envelope.
* Close
To close the telex envelope without changes.
To end processing or displaying of the message, select one of the following

options. Note that these options are available from the Message menu. Some of the
options are also available from the push buttons.

* Reject
To mark the message as rejected and route it to further message-processing
functions.

* Route to telex

To route the message to a telex queue from which it is later sent to the telex
network.

* Delete by routing

To delete the message by routing it to a delete queue.
* Close

To close the message without changes.

Verifying Testkeys
With this function you can verify a testkey that is attached to an incoming telex
message.

After you select a message, the message body of the selected message is shown in
dispatch mode.

To display the contents of the telex envelope, select Show message envelopes from
the View menu. You then see the message envelopes.

You can then compare the testkey that is found in the message to your separately
calculated testkey.

To end processing or displaying of the telex envelope, select one of the following
options. Note that these options are available from the Envelopes menu. Some of
the options are also available from the push buttons.

¢ Check
To check the telex envelope.
* Close
To close the telex envelope without changes.
To end processing or displaying of the message, select one of the following

options. Note that these options are available from the Message menu. Some of the
options are also available from the push buttons.

e Accept
To check and store the message according to your routing conditions.
* Reject
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To mark the message as rejected and route it to further message-processing
functions.

¢ Close

To close the message without changes.

Routing Messages to the Telex Network

With this function you can send messages that are in a ready-to-send queue to the
S.W.IET. network to the public telex network.

After you select a message, the message body of the selected message is shown in
dispatch mode.

You can handle the message in one of the following ways:

* Select Route to telex to route the message to a telex queue from which it is later
sent to the telex network.

The telex header fields of the message are filled with values from the
correspondents database.

For security reasons, you cannot change the contents of the message and the
telex header. The telex header is checked for completeness, and the following
fields must be filled:

— The first line of the From Address field

— The first line of the To Address field

— The Telex Number 1 field

— If the priority of the message is T, the Timed Telex Send Time field and the
Timed Telex Send Date field must also be filled.

If one of these fields is empty, the message cannot be routed to a telex queue.

You must then select Route to edit to route the message to an edit queue.

* Select Route to edit to route the message to an edit queue for correcting the
message.

You can then correct the message with the Edit Message function before you
send it to another network. The message must then follow the usual
message-processing steps, for example, verification and authorization, before it
can be resent.

To end processing or displaying of the telex envelope, select one of the following
options. Note that these options are available from the Envelopes menu. Some of
the options are also available from the push buttons.

* Check
To check the telex envelope.
* Close
To close the telex envelope without changes.
To end processing or displaying of the message, select one of the following

options. Note that these options are available from the Message menu. Some of the
options are also available from the push buttons.

* Route to edit

To save the message as incomplete. This item is only enabled if a telex envelope
exists.

* Route to telex
To check, store, and route the message according to your routing conditions.
e Close
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To close the message without changes.

Viewing Telex Information in Telex Envelopes

A telex envelope that is displayed to you contains telex information that consists
of:

* Telex header
* Telex testkey information

¢ Telex information

These parts are described in detail in the following sections.

Viewing Telex Header Information

The following information about telex header fields is displayed:

From Address
This field contains the sender’s address in up to four lines of 35 characters
each.

To ID This field contains the identifier of the correspondent of up to 11 characters
long.

To Address
This field contains the receiver’s address in up to four lines of 35
characters each.

Telex Line
This field contains the telex line on which the telex message is sent. The
line numbers available depend on your installation.

Telex Number 1
This field contains the dial-up number.

Enter the telex dial-up number of the subscriber you want to call. Include
the country code if required.

The dial-up number can be up to 20 characters long. It can include a digit,
a slash, or a hyphen (-) to stipulate a break in dialing so that multistage
dialing can be done. This is, for example, necessary in the U.S. and France
where two-stage dialing is valid.

Example:
100-XXXXXXXXX

The TelexBox waits for a response after dialing 100 before proceeding with
the rest of the dialing.

Answerback 1
This field contains the expected answerback in up to 20 characters.
Use one of the following methods for answerback checking:
* Leave the field blank to specify no answerback checking.

* Enter an asterisk to specify a check of the dial-up digits against the
numeric part of the received answerback.

* Enter specific characters and digits. The default answerback checking
method is used.

Telex Number 2
This field contains an alternative dial-up number that is used if the
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number that is specified in the Telex Number 1 field cannot be reached.
The format and meaning of Telex Number 2 are identical to those of Telex
Number 1.

Answerback 2
This field contains the expected answerback for the alternative dial-up
number.

Priority
This field indicates the priority of the message. The following priorities are
available:

N Normal priority
8) Urgent priority
T Timed telex that means delayed transmission via telex link.

If you enter T, you must enter the earliest possible transmission
time in the Time field. Note that you can also specify a date.

Timed Telex Send Time
This field indicates the time for the telex transmission of the timed telex.

You must specify the transmission time in the form of HHMM where HH
stands for hours (00 to 23) and MM stands for minutes (00 to 59).

Timed Telex Send Date
This field indicates the date for the telex transmission of the timed telex.

You must specify the transmission date in the form of YYYYMMDD where
YYYY stands for the year, MM stands for the month (01 to 12), and DD
stands for the day (01 to 31).

Telex Reference
This field contains the telex reference identifier of up to 16 characters. If
the message is a SW.LET. message and contains a transaction reference
number, the information is copied into this field.

Comment
This field contains a comment of up to 64 characters for the attention of
the receiver.

Viewing Telex Testkey Information

The following information about telex testkeys is displayed:

Testkey Calculation Required
In this field you specify whether testkey calculation is required for this
message. The value for this field is one of the following characters:

Y Route to testkey calculation.
This requires correct routing to be set up.
N Do not route to testkey calculation.

Testkey Flag
The value for this field is one of the following characters:

N The testkey calculation is not yet performed or failed.
C The testkey is calculated by a testkey processing program.
A% The testkey is verified by a testkey processing program.
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G The testkey is verified but the sequence number is out of sequence
and therefore wrong.

M The testkey is manually calculated or verified.

Testkey
In this field you specify the testkey in up to 16 characters.

Calculation Comment
In this field you can enter a comment that explains the calculation testkey.

Viewing General Telex Information

For MERVA Workstation, the telex information is written only by the telex
provider. Therefore, the following description of the general telex information
might differ from the information that is displayed to you.

Note that general telex information is displayed only for transmitted telexes. When
you display the telex envelope, only fields that contain data are shown. If you edit
the telex envelope, all fields are shown. The following list shows you all fields
available:

Type of Acknowledgment
The acknowledgment type, such as positive acknowledgment or negative
acknowledgment.

The data that is shown depends on your telex system. For further details
refer to the corresponding documentation of your telex provider.

Type The telex message type.

The data that is shown depends on your telex system. For further details
refer to the corresponding documentation of your telex provider.

Report Sequence Number
The transmission acknowledgment is the last in a series of reports for each
transmitted telex. The TelexBox generates reports for every action that is
associated with the telex, for example, a dial-up attempt. This sequential
number indicates the number of reports that are sent for this telex
message.

Dial-up Number
The telex number of the telex correspondent.

Expected Answerback
The response from the telex network.

Transmission Start Time
The date and time when the transmission was started.

Transmission Duration
The amount of time, in the form of HHMMSS, that is required for the
transmission of the telex.

Reason Code
The error message code. For details on the error code refer to the
corresponding documentation.

Note: This is not the telex transmission reason code.

Box Used
The number of the TelexBox that is used for transmission.
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Line Used
The number of the telex line that is used for transmission.

Box Termination Code
In case of a transmission problem, this code provides a detailed
explanation.

The data that is shown depends on your telex system. For further details
refer to the corresponding documentation of your telex provider.

Exceptions
Indicates whether an error was found in the telex. For a transmitted telex,
this is always zero.

Possible Duplication
A code that indicates that the telex was possibly sent more than once.

The data that is shown depends on your telex system. For further details
refer to the corresponding documentation of your telex provider.

Application Document Number
The unique message identifier of the telex.

Creating a Free Format Message

You can create a free format message that you do not use in the SW.LET. or telex
networks.

When you select Create in the Message List window, the Select Message Type
window is the first window that is displayed to you. (For a detailed description on
the Message List window refer to P‘Fhapfpr 5 The Message Tist Window” onl

page21)

To create a free format message:
* Select Message type in the field Start from. This is the default selection.
* Select General from the Application field.
¢ Select General from the Category field.
* Specify a message type in one of the following ways:
— Enter FREE as message type.
— Select FREE as message type from the Type list box.
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Chapter 14. Maintaining Templates

A template usually contains information that is reused on a regular basis. You use
the maintain templates function to display, edit, or delete an existing template.
Note that you can only use this function if the right to maintain templates is

specified in your user profile.

This chapter shows you how to select, display, edit, and delete templates.

Selecting a Template

If you have the right to maintain templates, the Message List window of a function
for which you are allowed to create messages, shows you the action button
Templates. Note that you see only templates that you are allowed to access. Select
Templates to display the Maintain Templates window. The window looks like the

following:

& MERVA user at 5A1 / SMINCMFPT / Maintain Templates =13
Selected Option:  Help
Application IS.W.I.F.T. Financial Messages j
Category |4 Collections & Cash Letters j
Tenplate Type Description
5412 412 HT 412 Template]
S400 400 MT 400 Template
5412 412 Tenplate
5499 499 MT 499 Temnplate

ENC1601I Last Refreshed:

Display | Edit | Deletc ..

15:02:49, Templates:

Refresh

532

Close | Helpl

Figure 36. The Maintain Templates Window

Use the Maintain Templates window to select or specify the template you want.

The Maintain Templates window is divided into several parts:

© © N O~

© Copyright IBM Corp. 1997, 1999

Title bar with window title

Application list

Category list

Template, Type, and Description lists
Status line

Information area

Menu bar with menu items Selected, Options, and Help

Action buttons to perform actions related to the selected templates

Window buttons to perform actions related to the active window
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With exception of the title bar, these parts are described in detail in the following
sections.

The menu bar offers you menu items with pull-down menus that contain different
options. Note that the options for Selected are identical to the action buttons
Display, Edit, and Delete. The menu items are:

Selected
To display, edit, or delete the selected template.

Options
To update changed information within the Maintain Templates window,
such as the number of templates, to its current status.

To open the Delete Templates window in which you can delete one or
more templates.

Help To display different options for help.

The Application list shows the message applications available to you. You can
choose between:

* S.W.LET. Financial Messages in categories 1 to 9, as defined in the S.W.LET. User
Handbook

* SW.LET. System Messages in the categories GPA System Messages and FIN
System Messages, as defined in the S.W.LET. User Handbook

* General messages, such as free format message or telex message

The Category list shows you the name and description of the message categories
that are contained in the selected application. Each category contains different
message types, for example, SW.LET. category 1 contains the message types 100 to
199. The default setting <All categories> allows you to enter a template identifier
with a type in the entry field of the type list. The template can belong to any
category of the selected application.

The lists Template, Type, and Description show you the template name, message
type of the template, and template description.

Note: Entries in the Application list, the Category list, and the Type list might be
marked with the label (?). Entries with this label refer to applications,
categories, or message types that are incorrect according to the current
message-processing rules of the client. A reason can be, for example, that the
templates stored on the MERVA Server refer to message types that do no
longer exist due to the yearly SW.LET. changes.

If you use an incorrect template to create a message, or if you display or
edit an incorrect template, you get message-processing errors. To avoid this,
delete the incorrect templates. For a description of how to do this, refer to

7 ”

The status line shows you information, such as:

* Information message ID to locate the message in Messages and Codes. To access
Messages and Codes, double-click the Messages and Codes icon in the MERVA
Client folder, or select it and press Enter.

e Time at which the template list is last refreshed

* Total number of templates available

The following action and window buttons are available:
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Display
To display the selected template.

Edit  To edit the selected template.

Delete ...
To open the Delete Templates window.

Refresh
To update the list of templates to its current status.

Close To close the Maintain Templates window.

Help To display overview information about the current window.

Displaying a Template
Displaying a template means to view the template in a read-only mode.
To display a template, select Display from the Selected menu or the action buttons

in the Maintain Templates window. You then get the Display Template window
that shows you the selected template. The window looks like the following:

= MERYA USER at 5A1 7/ SMINCMPT / Maintain Templates - Display Message

Figure 37. The Display Template Window

The information area shows you the following:
* Template

You see the text Template succeeded by the template name and description.
* General information
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Shows you information about the selected menu item or the choice on which the
cursor is.

Working with Menu ltems

The menu bar of the Display Template window contains the following entries:
e Template

* Edit

* View

* Envelopes

* Help

Template
You can select the following options from the Template menu:

¢ Check

When you select Check, the template body is searched for errors in the
individual fields and in the related fields. If an error is found, you get the
Checking Errors window.

* Close
To close the Display Template window.
Edit
As the text is read-only data, you cannot select all options from the Edit menu.
The following options are available:

Copy To copy marked data to the clipboard.

View
You can select the following options from the View menu:

Show message envelopes
To display the Telex Envelope window if a telex envelope exists.

Display only fields with data
To display only fields that contain data. Empty fields are hidden. This
option is selected by default.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.

Switch to text view
To display the template body in network format.

Envelopes
You cannot select any options from the Envelopes menu.

Help

You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help
To display overview information about the current window.
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Using help
To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information about the MERVA Message Processing
Client.

Working with Window Buttons
The window buttons of the Display Template window allow you to perform
actions that are related to the active window. Note that there are no action buttons
for this window.

The following window buttons are valid:

Close To close the Display Template window without performing an action and
return to the Maintain Templates window.

Help To display overview information about the current window.

Editing a Template

Use this function to complete or change a template that is not yet complete.
To edit a template, select Edit from the Selected menu or the action buttons in the

Maintain Template window. You then get the Edit Template window that shows
you the selected template. The window looks like the following:
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= MERVA USER at 5A1 / SMINCMPT / Maintain Templates - Edit Template
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Figure 38. The Edit Template Window

The information area shows you the following:
* Template

You see the text Template succeeded by the template name and description.
* General information

Shows you information about the selected menu item or the choice on which the
cursor is.

Working with Menu Items
The menu bar of the Edit Template window contains the following entries:
* Template
+ Edit
* View
¢ Envelopes
* Help
Template
You can select the following options from the Template menu:
* Save

When you select Save, the template is saved.
¢ Check
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When you select Check, the template body is searched for errors in the
individual fields and in the related fields. If an error is found, you get the
Checking Errors window.

* Delete
To delete the selected template.
e Print
To print the selected template.
* Close
To close the Display Template window.
Edit

You can select the following options from the Edit menu:
Cut  To move marked data to the clipboard.

Copy To copy marked data to the clipboard.

Paste To place data that you have cut or copied.

Delete data from message
To delete a specific subfield or a complete segment of data.

A secondary window shows you the choice for deletion that depends on
the position of the cursor. For example, if the cursor is positioned in a
subfield of an occurrence of a repeatable sequence, you can delete the
following data:

* Current subfield

* Field

* Data area

* Occurrence

* Complete repeatable sequence

Insert an occurrence
To insert one occurrence of a repeatable sequence.

A secondary window shows you occurrences of repeatable sequences that
you can insert as an empty occurrence.

View
You can select the following options from the View menu:

Show message envelopes
To display the Telex Envelope window if a telex envelope exists.

Display only fields with data
To display only fields that contain data. Empty fields are hidden.

Expand all sequences
To display all lower-level data for every sequence that can be expanded at
one time.

Collapse all sequences
To hide all lower-level data for every sequence that is expanded.

Switch to text view
To display the template body in network format.

Envelopes
You cannot select any options from the Envelopes menu.
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Help

You can select the following options from the Help menu:

Help index
To display an alphabetical list of topics for which help information is
provided.

General help
To display overview information about the current window.

Using help
To display information on how to use the help facility.

Keys help
To display key assignments.

Product information
To display copyright information and version number for the MERVA
Message Processing Client.

Working with Window Buttons

The window buttons of the Edit Template window allow you to perform actions
that are related to the active window. Note that there are no action buttons for this
window.

The following window buttons are valid:

Save To save the template.

Close To close the Edit Template window without performing an action and
return to the Maintain Templates window.

Help To display overview information about the current window.

Deleting Templates

Use this function to delete one or more templates.

To delete one or more templates, select Delete ... from the Options menu or from
the action buttons in the Maintain Templates window. You then get the Delete
Templates window that shows you the contents of the current template, type, and
description. The window looks like the following:

1 MERVA user at SA1 / SMINCMPT / Delete Templates =] 3

~Select t to be deleted:

p

Select all | Deselect all |

Delete | Cancel I Helpl

Delete all selected templates

Figure 39. The Delete Templates Window

To delete a template:
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1. Select the template that you want to delete.

Note: A template that was selected in the Maintain Templates window is
selected by default in the Delete Templates window.

2. Select Delete.

You are requested to confirm the deletion. Only upon confirmation of the delete
request is the template deleted.

To delete more than one template at the same time:
1. Select the templates that you want to delete.
2. Select Delete.

You are requested to confirm the deletion. Only upon confirmation of the delete
request are the templates deleted.

Select Select all to select all templates.
Select Deselect all to deselect all selected templates.
Select Cancel to close the Delete Templates window without deleting templates.

Select Help to get overview information for the current window.
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Appendix A. Installation and Customization

This chapter describes how to install and customize the MERVA Message
Processing Client.

Installing the MERVA Message Processing Client

The following sections describe how to install the MERVA Message Processing
Client.

Note: In this chapter the following naming conventions apply:

¢ The name MERVA Family Client is used when the product applies to
several platforms.

* MFCL Client stands for the MERVA Family Client on the client side.
¢ MFCL Server stands for the MERVA Family Client on the server side.

System Requirements

The following table lists the machine requirements needed to install the MERVA
Message Processing Client.

Table 1. Machine Requirements for the MERVA Message Processing Client

Processor Any workstation that runs under Windows/NT Version 4.0 or
a subsequent release. A Pentium with 133MHz or an
equivalent processor is recommended.

RAM 32MB or more.

Disk space The program files require approximately 30MB of disk space.

Printer (optional) Any printer supported by Windows NT.

Communication Any interface device supported by the used communication

equipment (for remote software (for example, Token Ring Card or SDLC Adapter).

connections)

The following table lists the program requirements needed to install the MERVA
Message Processing Client.

Table 2. Program Requirements for the MERVA Message Processing Client

Operating system Microsoft Windows NT Version 4.0 with Service Pack 4, or a
subsequent release.
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Table 2. Program Requirements for the MERVA Message Processing Client (continued)

Communication software | For remote connections, the following alternatives are possible:

For SNA APPC:

« IBM eNetwork " Personal Communication Version 4.2,
Program Number 5639-B94, or a subsequent release.

e IBM eNetwork Communications Server for Windows NT
Version 6.0, Program Number 5639-F25, or a subsequent
release.

For TCP/IP
¢ The TCP/IP support is incorporated in the Windows NT 4.0
operating system.

Note: The communication software might have additional
program requirements depending on the interface device used.

General Description

During the installation procedure, the files that are necessary to work with the
MERVA Message Processing Client are transferred to your workstation. At the
same time, all environment changes are written to the Windows NT registry.

By default, the target destination is C:\MERVA\Message_Processing\. You can,
however, change this destination.

In the target installation directory, the following substructure is allocated:
* TARGET\

* TARGET\BIN

* TARGET\SAMPLES

* TARGET\TABLES

* TARGET\TRACE

Note: TARGET is the final target installation directory.

The following list shows you the corresponding directories and their contents:

TARGET
Contains the MERVA Message Processing Client customization profile
ENCTDTS.PRF and several files that you need for corrective service and
deinstallation. After installation, the environment variable ENC_DIR points
to this directory.

TARGET\BIN
Contains the MERVA Message Processing Client application files.

TARGET\SAMPLES
Contains the sample profiles. For a description of these profiles refer to
I’C11anmi7ing the Data Transfer Service (DTS) of the MERVA Mpqcagd

I ! 3 ( I I 77 ] ] EI'
TARGET\TABLES
Contains the MERVA message-processing tables.

TARGET\TRACE
By default, this directory is empty. It can be used as target directory for
trace files of the MERVA Message Processing Client.
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Installation Steps

For the installation use the setup program from diskette 1 of the MERVA Message
Processing Client.

To install the MERVA Message Processing Client:
1. Insert the MERVA ESA Components V4 CD-ROM in the CD-ROM drive.

2. Start the setup program. To do this, open the Windows NT Explorer and
double-click on the SETUP.EXE in the
MERVA_Features\Message_Processing_Client directory on the CD-ROM.

3. Read the displayed information carefully.
4. Follow the instructions displayed to you.

5. Select the destination location. By default, the MERVA Message Processing
Client is installed in C:\MERVA\Message_Processing\. To change the
destination location, select Browse, then select a new target directory.

6. After completion, restart your system if you are advised to do so.

Installation Verification
To ensure that the MERVA Message Processing Client is installed correctly:
1. Open the MERVA Message Processing Client folder.
2. Check whether the following program objects are shown:
a. MERVA Message Processing Client
b. Messages and Codes

3. Double-click on the MERVA Message Processing Client program object to
display the MERVA Client Signon window.

When you invoke the client program for the first time, you are asked to enter
the directory path where the profile of the client is to be stored. Enter an
existing directory and select Accept.

4. Select Help to display the Help window.
5. In the Help window select the Esc key.
6. Select Cancel.

If you do not get an error message, the MERVA Message Processing Client is
installed successfully.

Corrective Service
To apply corrective service:
1. Insert the first CSD diskette in the diskette drive.

2. Start the setup program. To do this, double-click on the appropriate object in
the Windows NT Explorer or enter A:\SETUP in the command line of an
MS-DOS window.

3. Follow the instructions of the setup program to install the corrective service.

4. To generate the installation and configuration report, run the enccfg.exe. It is
contained in the installation directory of the MERVA Client. By default, the
output is sent to the screen. To sent the output to a file, use the redirect
operator >.

Appendix A. Installation and Customization ~ 111



Customizing Message Processing for the MFCL Client
In addition to the customization described in !Changing Settings” on page 10, you

can customize parts of the message processing via environment variables.

The following environment variables are valid:

ENC_AMOUNT_FORMAT = US

Controls the format of the amount. By default, European format, for example
1.000,00, is used. If you want to use the US format, for example 1,000.00, set the
variable value to US.

ENC_AUTOFILL_SWIFT BIC = YES

Controls the expansion of standard BIC codes. By default, a BIC code is
expanded to 8 characters that do not include the branch code. If you want to
expand the BIC code to 11 characters that include the branch code, set the
variable value to YES.

ENC_AUTOFILL_SWIFT FIELD22 = YES

Fills the SW.LET. fields 22 and 22C automatically with the short SW.LET. BIC
code. The short code does not include the country code. By default, you must
enter the data manually. If you want the fields to be filled automatically, set the
variable value to YES.

ENC_CHECK_SW62 = NO

Controls the checking of the amount fields 60, 61, and 62. By default, it is
checked whether the amount in field 62 is equal to the amount in field 60 plus
the sum of the amounts in each field 61 of the repeatable sequence. If you want
to inactivate this checking, set the variable value to NO.

Customizing Communication Systems for the MERVA Message
Processing Client

The communication services of the MERVA Message Processing Client use the
services of data communication subsystems (DC subsystems) to provide the
partner system connectivity. You must customize these subsystems before the
MERVA Message Processing Client can use them.

The customization of the DC subsystem depends on the operating system and the
selected transfer protocol. Specific parameters of the DC subsystem must

correspond to parameters of the DTS customization of the MERVA Message
Processing Client. For detailed information refer to [ izi

- . The
operating systems for the MFCL Servers are Windows NT and ESA.

The communication of the MERVA Message Processing Client supports the
following types of DC protocols:

* SNA APPC
s TCP/IP
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For communication between an MFCL Client instance and an MFCL Server
instance, the types of the DC protocol must be identical. The operating system of
both instances can be different.

The following sections describe how to customize different DC subsystems for

MECL Client and MFCL Server instances on different operating systems. This

description covers the DC subsystem resources that:

* Contain parameter values specifically required by MFCL Server instances.

* Are related to the DTS customization parameters of the MERVA Message
Processing Client.

For more details refer to Customizing the Data Transfer Service (DTS) of thd

. . 77

General intercommunication resources are not considered.

The following table gives you an overview of the related sections in this document:

Table 3. DC Subsystem Configurations of the MERVA Message Processing Client

DC Subsystem MERVA Client MERVA Server
NT ESA Windows NT
SNA Refer to Refer to Refer to

E Zation f 1 Zation f 1 |IE Zation £ |
MECT Client od MECT Server od MECL Server od
bage11d.
TCP/IP Refer to m Refer to m Refer to m

E Zafionf 1E Aot 1 |E afion f |
MECT Client or IMECT Server od MECT Server od
ind T od ESA” d ind NT od
[ é - M.

The following sections give you an overview of the steps that are necessary to
customize TCP/IP and SNA APPC. For more details refer to MERVA Workstation
Based Functions and MERVA Connection/NT.

SNA Customization for an MFCL Client on Windows NT

You can connect an MFCL Client instance in the Windows NT environment to an

MEFCL Server in the SNA environment of any supported operating system. To do

this:

* You must define the compatible resources in the SNA subsystems.

* An SNA connection network must be operational to bind APPC sessions so that
the server instances of the MERVA Message Processing Client can use them.

In the MFCL Client environment, customize the following basic SNA resources to

establish an APPC connection to the partner system:

e LU 6.2 local LU

* LU 6.2 partner LU

e LU 6.2 mode

e SNA connection

¢ CPI communications side information

Appendix A. Installation and Customization 113



With respect to the MFCL Client instance, the specification of the CPI
communications side information is important. It specifies the resources that are
used at the server side to connect to the MFCL Server transaction program (TP):

* The symbolic destination name is used to refer to this set of CPI
communications side information. This parameter corresponds to the
symb_destination parameter of the enctdts.prf DTS profile of the MERVA
Message Processing Client. For details refer to “MECL Server Node ( SNQDH

”

* The partner LU alias or the fully qualified partner LU name identifies the APPC
LU that contains the server TP.

* The partner TP name identifies the MFCL Server TP definition in the partner

system. On the server side, you must specify the allocation of the real partner

TP full path to the partner TP name. For details refer to 'SNA Customization foy
lan MECL Server on ESA” on page 114[ and toI: SNA Customization for an ME( ||

Berver on Windows NT

¢ The mode name parameter identifies the LU 6.2 mode profile that is used for
APPC sessions between the cooperating LUs.

* The security type defines the conversation security type that is used with this
transaction program. The recommended security type is Program.

TCP/IP Customization for an MFCL Client on Windows NT

You do not have to customize the TCP/IP subsystem so that an MFCL Client
instance can use it. You can, however, define the short name of a partner host
where the MFCL Server is located in the file %ETC%\HOSTS. This parameter
corresponds to the partner_host parameter of the enctdts.prf profile of the MERVA
Message Processing Client. For details refer to MECI. Server Nade (SNODH

The parameter value of the partner host name can be one of the following:

* A short host name that is translated to the corresponding IP address by a
TCP/IP name server or by information in the file /%etc%/hosts

* The official partner host name that includes the TCP/IP domain identifiers
¢ The IP address of the partner host in dotted-decimal representation

SNA Customization for an MFCL Server on Windows NT

You can connect an MFCL Server instance in the Windows NT environment to an

MECL Client in the SNA environment of any supported operating system. To do

this:

* You must define the compatible resources in the SNA subsystems.

* An SNA connection network must be operational to bind APPC sessions so that
the MFCL Server instances can use them.

In the MFCL Server environment, customize the following basic SNA resources to

establish an APPC connection to the partner system:

* LU 6.2 local LU

* LU 6.2 partner LU

e LU 6.2 mode

* LU 6.2 conversation security

* Transaction program definition
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Regarding the MFCL Server instance, the specification of the transaction program
definition is important. It defines the resources that are used to refer to the right
MECL Server transaction program TP. This program handles each request of the
MECL Client.

The path and file name of the Windows NT program must specify the Windows
NT path of the receiving program enctpi.exe of the MFCL Server, for example:

Complete path name <mervabin>\enctpi
Program parameters [<instance> [<tracedir>[\<tracelevel>]]]
where:

* <mervabin> is the bin directory of the MERVA installation. Note that this is not
the MERVA Family Client installation.

* <instance> is the name of the MERVA instance.

* <tracedir> is the trace directory of the MFCL DTS trace. You can use any
parameter.

 <tracelevel> indicates the level of tracing.

TCP/IP Customization for an MFCL Server on Windows NT

On Windows NT, you must use the MERVA inetd service for the MERVA Family
Client. For information on how to install the inetd service, refer to the MERVA USE
& Branch for Windows NT Installation and Customization Guide.

To use the MERVA inetd service daemon:

1. Add the MFCL service to the file services. This file is installed automatically by
Windows NT. It is located in the path %SystemRoot% \system32\drivers\etc\.
The path %SystemRoot% is provided by the environment variable
SystemRoot.

To add the MFCL service, add the following line to the file services:
MFCL 7117/tcp # MERVA Client DTS Server

Note: Do not add this line as the last line otherwise, the Win32 API call that
searches the file cannot find it.

This defines the service MFCL for port number 7117 using TCP as protocol. You

can specify the name of the service and the port number as you like. The port

number, however, should be greater than 2134 because the range of the

well-known ports for TCP/IP is 1 to 2134.

2. Copy the sample file enminetd.cfg from the samples directory of MERVA to
%SystemRoot% \system32\drivers\etc\.

3. Add the following line to the file enminetd.cfg:

MFCL stream tcp nowait root <mervabin>\enctci<instance> [<tracedir>[\<tracelevel>]]

where:

* <mervabin> is the bin directory of the MERVA installation. Note that this is
not the MERVA Family Client installation.

* <instance> is the name of the MERVA instance.

* <tracedir> is the trace directory of the MFCL DTS trace. You can use any
parameter.

* <tracelevel> indicates the level of tracing.

This defines that the transaction program <mervabin>\enctci starts on request
of the service MFCL.

The following example shows you a definition for MERVA installed on drive D:
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MFCL stream tcp nowait root d:\MERVA\USE Branch\bin\enctci merval d:\merva\trace\3

4. Start the MERVA inetd service as described in the MERVA USE & Branch for
Windows NT Installation and Customization Guide.

SNA Customization for an MFCL Server on ESA

You can connect an MFCL Server instance in the ESA SNA environment to an

MECL Client in the SNA environment of any supported operating system. To do

this:

* You must define the compatible resources in the SNA subsystems.

* An SNA connection network must be operational to bind APPC sessions so that
the MFCL Server instances can use them.

For detailed information and configuration examples, refer to MERVA Workstation
Based Functions.

TCP/IP Customization for an MFCL Server on ESA

You can connect an MFCL Server instance in the ESA TCP/IP environment to an
MECL Client in the TCP/IP environment of any supported operating system. To
do this, you must define the compatible resources in the TCP/IP subsystems.

For details on the customization of the MERVA ESA TCP/IP services, refer to
MERVA Workstation Based Functions.

Customizing the Data Transfer Service (DTS) of the MERVA Message
Processing Client

By using the DTS of the MERVA Message Processing Client, an MFCL Client and
an MFCL Server can communicate. If the MFCL Client and the MFCL Server are
located on the same workstation, local communication is used. For remote
connections between the MFCL Client and the MFCL Server, SNA APPC or
TCP/IP can be used.

The DTS of the MERVA Message Processing Client transfers each data between
clients and servers as determined by the contents of its Data Transfer Service
profile, abbreviated to DTS profile. The information on how to interconnect partner
systems (intersystem connection parameters) is the most important information.
The DTS profile is a flat file. The name of the file is enctdts.prf.

The DTS profile is available only for the Windows NT platform. The DTS of the
MERVA ESA server has fixed DTS parameters. These parameters are also used for
the MERVA ESA client.

Each MERVA Message Processing Client workstation uses one DTS profile. If a
local MFCL Client is installed on an MFCL Server, the MFCL Client and the MFCL
Server use the same DTS profile. The parameters in a DTS profile can be valid only
for an MFCL Client environment or only for an MFCL Server environment
(Windows NT). You can define parameter sets for several MFCL Client or MFCL
Server nodes in one profile.

Introduction to Node Resource Groups

The information in the MERVA Family Client DTS profile consists of a set of typed
node resource groups. The following node resource groups are defined:
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LNODE
Contains information about a local MFCL Client or MFCL Server node.

SNODE
Contains information about a remote MFCL Server node.

CNODE
Contains information about a remote MFCL Client node.

A DTS profile contains any number of any node resource group in any sequence.

An LNODE group contains information about local node and either one or more
local MFCL Clients or MERVA applications. The local node can be an MFCL Client
or an MFCL Server node, or both.

An SNODE group contains information about an MFCL Server node and one or
more MERVA server applications. This resource group is only applicable in an
MECL Client environment.

A CNODE group contains information about an MFCL Client node and one or
more client applications. This resource group is only applicable in an MFCL Server
environment.

The following list shows you the complete structure of the DTS profile:
LNODE:

( Tocal node parameters ... )
APPL:
( Tocal application 1 parameters ... )
APPL:
( Tocal application 2 parameters ... )
SNODE :
( server node 1 parameters ... )
APPL:
( server 1 application 1 parameters ...)
APPL:
( server 1 application 2 parameters ...)
SNODE :
( server node 2 parameters ... )
APPL:
( server 2 application 1 parameters ...)
APPL:
( server 2 application 2 parameters ...)
CNODE:
( client node 1 parameters )
APPL:
( client 1 application 1 parameters ...)
APPL:
( client 1 application 2 parameters ...)
CNODE:
( client node 2 parameters )
APPL:
( client 2 application 1 parameters ...)
APPL:

( client 2 application 2 parameters ...)
The following sections show you basic examples with only mandatory parameters

for DTS profiles. At the end of each section, you find a brief description of the
mandatory parameters and possible additional parameters. For a summary of all

Appendix A. Installation and Customization 117



parameters that you can use in the enctdts.prf, refer to ‘DTS Profile Contents
[MECI. Client)” on page 131l and ‘DTS Profile Contents (MECI, Server)” on

page 131.

Example A — Message Processing

The following figure shows you an MFCL Server that is used for local message
processing. You can install this profile on a MERVA Workstation server.

APPL
CA1

(MCSERVER)
MERVA Server

APPL SA1

Local

Figure 40. Message Processing with an MFCL Server

The following section shows you an example of an enctdts.prf profile for MERVA
Workstation message processing with an integrated MERVA Client.

# MERVA Message Processing Client (MFCL) DTS Profile
# Example for an MFCL Server with a local MFCL Client

#==============================================s==s=s=s=s=s=s==================

e e

# Local Node Definitions

B e

LNODE: Local MFCL node
local_node _name = MCSERVER Local MFCL node name

APPL: Local client application
application_name = CAl (MFCL Server is both, client and server)

APPL: Local server application
application_name = SAl

e e

# Server Node Definitions

B e

SNODE: MFCL Server node (here: Tocal server)
server_node name = MCSERVER MFCL Server node name

APPL: Remote server application (here: Tocal)
application_name = SAl Server application formal name
connection_type = LOCAL Connect locally to server

#============================================================================

# MERVA Message Processing Client (MFCL) DTS Profile End

#============================================================================

Parameters Used in This Example
In the LNODE group:

local_node_name
Specifies the name of the local node. You can specify the name as you like.
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application_name
Specifies the name of the application. In the example, a client and a server
application are defined on the local node. You can specify the application
names as you like, but they must be unique. You can have more than two
applications with different settings on a server.

In the SNODE group:

server_node_name
Specifies the name of the local MFCL Server. The name must match the
name of the MFCL Server defined in the LNODE resource group.

application_name
Specifies the name of the server application. The name must match the
name of the server application defined in the LNODE resource group.

Additional Parameters
Additionally, you can set the following parameters:

e To activate trace files, set dts_trace_dir or dts_trace_file on the MFCL Client
side.
* To specify the trace level, set dts_trace_level.

¢ To change the MERVA message-processing table, set msg_proc_table. The
default table is MERVASON.MRT.

Example B — MFCL Server with a Local and a Remote Client

The following figure shows you the contents of L —

ing” but with a remote MFCL Client (Windows NT) added. An
MECL Client called CLIENT_A is connected to the MFCL Server through TCP/IP.
Note that the local MFCL Client on the server workstation still exists.

APPL
CA1

(MCSERVER)
MERVA Server

APPL SA1

TCP/IP Local

APPL
CA1

(CLIENT_A)
MERVA Client

Figure 41. Message Processing with an MFCL Client MFCL Server

MFCL Server DTS Profile

The following example shows you an MFCL Server DTS profile. You can use the
DTS profile that is described in [Example A — Message Processing” on page 118
However, in this example, a CNODE resource group with the ca_match parameter
is added. This ensures that only MFCL Clients that are indicated in the CNODE
resource group can connect to this server node.

# MERVA Message Processing Client (MFCL) DTS Profile
# Example for an MFCL Server with a local and a remote client
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e e e
LNODE: Local MFCL node
Tocal_node_name = MCSERVER Local MFCL node name
ca_match = yes Check all client addresses
APPL: Local client application
application_name = CAl (MFCL Server is both, client and server)
APPL: Local server application
application_name = SAl
B o o o e
# Server Node Definitions
e e
SNODE : MFCL Server node (local server)
server_node_name = MCSERVER MFCL Server node name
APPL: Server application
application_name = SAl Server application formal name
connection_type = LOCAL Connect locally to server
B o o o el
# Client Node Definitions
el
CNODE
client_node_name = MCSERVER MFCL Client node (here: local client)
APPL: Client application
application_name = CAl Client application name
CNODE
client_node_name = CLIENT_A MFCL Client node
APPL: Client application
application_name = CAl Client application name
#============================================================================
# MERVA Message Processing Client DTS Profile End
#============================================================================

Parameters Used in This Example:

In the LNODE group:

local_node_name
Specifies the name of the MFCL node. You can specify the name as you
like, but it must be unique for all interconnected MERVA Family Client
nodes.

ca_match
If this parameter is set to Yes, all MFCL Clients that try to connect to the
MECL Server are checked. If an MFCL Client is not defined in the CNODE
resource group of the DTS profile, the connection attempt is rejected. By
default, this parameter is set to No.
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application_name
Specifies the name of the application. In the example, a client and a server
application are defined on the local node. You can specify the application
names as you like, but they must be unique. You can have more than two
applications with different settings on an MFCL Server.

In the SNODE group:

server_node_name
Specifies the name of the local MFCL Server node. The name must match
the name of the MFCL Server node defined in the LNODE resource group
on the MFCL Server.

application_name
Specifies the name of the server application. This name must be unique
within the SNODE group.

In the CNODE group:

client_node_name
Each MFCL Client has a unique local node name. You can specify all
MEFCL Clients that are allowed to connect to the MFCL Server in the
CNODE resource group. If the parameter ca_match is set to Yes, the server
then rejects connection attempts of MFCL Clients that are not contained in
the CNODE resource group.

application_name
For each MFCL Client node in the CNODE resource group, one or more
applications are defined. Only applications with this parameter can connect
to the MFCL Server. If CNODE resource groups are not defined, and if the

parameter ca_match is set to No, any client application can connect to the
MECL Server.

Additional Parameters:

Additionally, you can set the following parameters:

* To specify encryption methods, set encryption.

* To specify a security key modifier, set sec_key_modifier.

* To specify a timeout value for the MFCL Client, set sp_timeout.

* You can specify whether the name of the server application that is received from
the MFCL Client in the connect request must be verified. To do this, set
sa_match.

MFCL Client DTS Profile

The following example shows you the corresponding MFCL Client (Windows NT)
DTS profile. The MFCL Client is called CLIENT_A. This corresponds to the
standard profile that is provided by the installation of the MERVA Message
Processing Client.

# MERVA Message Processing Client (MFCL) DTS Profile
# Example for an MFCL Client

#============================================================================
e
# Local Node Definitions

B e
LNODE : Local node is an MFCL Client node

local_node_name = CLIENT_A Local MFCL Client node name
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APPL: Local client application

application_name = CAl
B o o o o e
# Server Node Definitions
B o o o o e
SNODE : Remote MFCL Server node
server_node_name = MCSERVER MFCL Server node name
partner_host = hostname TCP/IP hostname of MFCL Server
port_number = 7117 Port number of the MFCL service
APPL: Server application
application_name = SAl Server application formal name
connection_type = TCP/IP Connection type is TCP/IP
#============================================================================
# MERVA Message Processing Client DTS Profile End
f#===============================================S=============================

Parameters Used in This Example:

In the LNODE group:

local node name
Specifies the name of the local MFCL Client. You can specify the name as
you like, but it must be unique for all interconnected MERVA Message
Processing Client nodes.

application_name
Specifies the name of the application. The local node in the example has
one application defined. You can specify the application name as you like,
but it must be unique. You can have more than one application with
different settings on an MFCL Client. Because the example describes a DTS
profile for an MFCL Client, a server application is not defined.

In the SNODE group:

server_node_name
Specifies the name of the remote MFCL Server. The name must match the
name of the MFCL Server defined in the LNODE resource group on the
MECL Server.

partner_host
Specifies the TCP/IP host name of the MFCL Server node. It can also
specify the TCP/IP address in dotted-decimal form. You must set this
parameter, if TCP/IP is used.

port_number
Specifies the port number of the inetd service (enctci.exe). The port
number must match the port number that is specified in the
%ETC%\SERVICES file on the MFCL Server. You must set this parameter,
if TCP/IP is used.

application_name
Specifies the name of the remote server application. If the ca_match
parameter is set to Yes, the MFCL Server checks the MFCL Clients for the
correct name of the server application. Connection attempts with incorrect
names are rejected.
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connection_type

Specifies how the connection is established through a keyword. Valid
keywords are TCP/IP for a TCP/IP connection, SNA for an APPC
connection, and LOCAL for local message processing through the local
MFCL Server.

Additional Parameters:

Additionally, you can set the following parameters:

To activate trace files, set dts_trace_dir or dts_trace_file on the MFCL Client
side.

To specify the trace level, set dts_trace_level. You can set the trace level
separately for each MFCL Server node.

To activate the TCP_NODELAY flag, set tcp_nodelay. You can set this parameter
for each MFCL Server node.

To provide information for the logon panel of each server application, set
informal_name for the name of the server application. You can then see the
server name in the pull-down menu of the MERVA Message Processing Client
logon panel. You can also set free_form_name for other additional information.

To change the MERVA message-processing table, set msg_proc_table. The
default table is MERVASON.MRT.

To specify encryption methods, set encryption. You can set this parameter
separately for each MFCL Client.

To specify a security key modifier, set sec_key_modifier.
To specify a timeout value for the MFCL Server, set cp_timeout.

To get a prompt window for the conversation security user ID and password of
a TCP/IP connection, set cvsec_prompt.

Example C — MFCL Server with a Local and Two Remote

Clients

The following figure shows you the contents of

but with a second MFCL Client added.

An MFCL Client called CLIENT_B is connected to the MFCL Server through SNA
APPC.

APPL
CA1

(MCSERVER)
MERVA Server

APPL SA1

A A

Local

APPL APPL
CA1 CA1

«—
(CLIENT_A) (CLIENT_B)
MERVA Client || TCP/IP SNA MERVA Client

Figure 42. MFCL Client/MFCL Server
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MFCL Server DTS Profile

To add a new MFCL Client, an additional entry in the CNODE resource group on
the MFCL Server side is necessary. If you do not use the CNODE resource group,
and if you set the parameter ca_match to No, you do not have to change the
entries.

The following example shows you the additional entry. You can also compare this

example to £ — z
m to see the changes.

# MERVA Message Processing Client (MFCL) DTS Profile
# Example for an MFCL Server and three MFCL Clients

#============================================================================
e e
# Local Node Definitions for an MFCL Server and Client
B e
LNODE: Local node is an MFCL Server node
local_node name = MCSERVER Local MFCL node name
ca_match = yes Check all client addresses
APPL: Local client application
application_name = CAl (MFCL Server is both, client and server)
APPL: Local server application
application_name = SAl
B o o o o e
# Server Node Definitions
B o o o el
SNODE: MFCL Server node (for local client)
server_node_name = MCSERVER MFCL Server node name
APPL: Server application
application_name = SAl Server application formal name
connection_type = LOCAL Connect locally to server
B o e o e
# Client Node Definitions
B o o o o e
CNODE
client_node name = MCSERVER MFCL Client node (here: local client)
APPL: Client application
application_name = CAl Client application name
CNODE :
client_node name = CLIENT_A MFCL Client node
APPL: Client application
application_name = CAl Client application name
CNODE:
client_node_name = CLIENT_B MFCL Client node
APPL: Client application
application_name = CAl Client application name
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Parameters Used in This Example:

In the LNODE group:

local_node_name
Specifies the name of the local node. You can specify the name as you like,
but it must be unique for all interconnected MFCL nodes.

ca_match
If this parameter is set, all MFCL Clients that try to connect to the MFCL
Server are checked. If an MFCL Client is not defined in the CNODE
resource group of the DTS profile, the connection attempt is rejected. By
default, this parameter is set to No.

application_name
Specifies the name of the application. The local node in the example has
two applications defined. You can specify the application names as you
like, but they must be unique. You can have more than two applications
with different settings on an MFCL Server. In the example, a client and a
server application are defined on the local node.

In the SNODE group:

server_node_name
Specifies the name of the local MFCL Server. The name must match the
name of the MFCL Server defined in the LNODE resource group.

application_name
Specifies the name of the server application. The name must be unique
within the SNODE group.

In the CNODE group:

client_node_name
Each MFCL Client has a unique local node name. You can specify all
MFCL Clients that are allowed to connect to the MFCL Server in the
CNODE resource group. If the parameter ca_matchis set to Yes, the server
then rejects connection attempts of MFCL Clients that are not contained in
the CNODE resource group.

application_name
For each MFCL Client node in the CNODE resource group, one or more
applications are defined. Only applications with this parameter can connect
to the MFCL Server. If no CNODE resource groups are defined and the
parameter ca_match is set to No, any client application can connect to the
MEFCL Server.

Additional Parameters:

Additionally, you can set the following parameters:

* To specify encryption methods, set encryption. You can set this parameter
separately for each MFCL Client.

* To specify a security key modifier, set sec_key_modifier.
* To specify a timeout value for the MFCL Client, set sp_timeout.
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* You can specify whether the name of the server application that is received from
the MFCL Client in the connect request must be verified. To do this, set
sa_match.

MFCL Client DTS Profile
The following example shows you an enctdts.prf profile of an MFCL Client. In the

example, the MFCL Client has the local node name Client_B.

# MERVA Message Processing Client (MFCL) DTS Profile
# Example for an MFCL Server and three MFCL Clients

#============================================================================
e e e e
# Local Node Definitions
B o o e o e
LNODE: Local node is an MFCL Client node
Tocal_node_name = CLIENT_B Local MFCL Client node name
APPL: Local client application
application_name = CAl
B o o o o e
# Remote Server Node Definitions
B o o o el
SNODE : Remote MFCL Server node
server_node_name = MCSERVER MFCL Server node name
symb_destination = MCSERV
APPL: Server application
application_name = SAl Server application formal name
connection_type = SNA Connection type is TCP/IP
#========================================s=s=sssssssssssssss=s=s=ss=ssss=======
# MERVA Message Processing Client DTS Profile End
#============================================================================

Parameters Used in This Example:

In the LNODE group:

local_node_name
Specifies the name of the local MFCL Client. You can specify the name as
you like, but it must be unique for all interconnected MERVA Family
Client nodes.

application_name
Specifies the name of the application. The local node in the example has
one application defined. You can specify the application name as you like,
but it must be unique. You can have more than one application with
different settings on an MFCL Client. Because the example describes a DTS
profile for an MFCL Client, a server application is not defined.

In the SNODE group:

server_node_name
Specifies the name of the remote MFCL Server. The name must match the
name of the MFCL Server defined in the LNODE resource group on the
MEFCL Server.
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symb_destination
Specifies the symbolic destination name that is used in the CPI-C side
information of SNA. You must set this parameter, if SNA APPC is used.

application_name
Specifies the name of the remote server application. If the ca_match
parameter is set to Yes, the MFCL Server checks the MFCL Clients for the
correct name of the server application. Connection attempts with incorrect
names are rejected.

connection_type
Specifies how the connection is established through a keyword. Valid
keywords are TCP/IP for a TCP/IP connection, SNA for an APPC
connection, and LOCAL for local message processing through the local
MEFCL Server.

Additional Parameters:

Additionally, you can set the following parameters:

* To activate trace files, set dts_trace_dir or dts_trace_file on the MFCL Client
side.

* To specify the trace level, set dts_trace_level. You can set the trace level
separately for each MFCL Server node.

* To activate the TCP_NODELAY flag, set tcp_nodelay. You can set this parameter
for each MFCL Server node.

* To provide additional information in the logon panel of each server application,
set informal_name for the name of the server application. You can then see the
server name in the pull-down menu of the MERVA Message Processing Client
logon panel. You can also set free_form_name for other additional information.

* To change the MERVA message-processing table, set msg_proc_table. The
default table is MERVASON.MRT.

* To specify encryption methods, set encryption. You can set this parameter
separately for each MFCL Client.

* To specify a security key modifier, set sec_key_modifier.
* To specify a timeout value for the MFCL Server, set cp_timeout.

* To get a prompt window for the conversation security user ID and password of
a TCP/IP connection, set cvsec_prompt.

General DTS Profile Structure of an MFCL Client
The DTS profile consists of node resource groups (LNODE, SNODE, and CNODE)

that can have one or more application resource groups (APPL).

The following parameter groups are valid:

LNODE
Contains the node parameters of the local MFCL Client or MFCL Server.

SNODE
Contains the server node parameters of an MFCL Client.

CNODE
Contains the client node parameters of an MFCL Server.

APPL Contains application parameters of an MFCL Client or an MFCL Server.
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A NODE parameter group contains the name and other parameters of the MFCL
Client or MFCL Server node. An APPL parameter group contains the name and
other parameters of a client or server application within this node.

The following section shows you a skeleton of a DTS profile in the MFCL Client
environment (Windows NT):

#======================================================================
#
# MFCL Client DTS Profile (Example)
#
B o o o el
LNODE: Local MFCL Client Node
Tocal_node_name = CN MFCL Client Node Name
APPL: Local Client Application
application_name = CAl Client Application Name
APPL: Local Server Application
application_name = CA2 Client Application Name
SNODE: Remote MFCL Server Node
server_node_name = SN1 MFCL Server Node Name
APPL: Remote Server Application
application_name = SIA1  Server Application Name
APPL: Remote Server Application
application_name = S1A2  Server Application Name
SNODE: Remote Server Node
server_node _name = SN2 MFCL Server Node Name
APPL: Remote Server Application
application_name = S2A1  Server Application Name
APPL: Remote Server Application
application_name = S2A2  Server Application Name
#======================================================================

This profile contains the following node resource groups:
* LNODE (local node parameters)

* SNODE (server node parameters for server 1)

* SNODE (server node parameters for server 2)

Local Node Resource Group (LNODE)
The first node resource group contains information about the local MFCL
Client node. In this example, the local MFCL Client node is a server node
at the same time. It begins with the node resource group identifier
LNODE. The node parameter group of this node resource group follows
the node resource group identifier. A DTS profile can contain only one
local node resource group.

The node parameter group is followed by two application parameter
groups, each beginning with the application parameter group identifier
APPL.

The local node resource group end is indicated by the beginning of the
second node resource group.

Local Node Parameter Group
This group begins with the mandatory local node name parameter
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statement. The local node parameter group ends with the
beginning of the first application parameter group.

Local Application Parameter Groups
These groups begin with the application parameter group identifier
APPL. Local application parameter statements follow.

In this example, the first local application parameter group ends
with the beginning of the second application parameter group. The
second local application parameter group ends with the next server
node resource group.

Server Node Resource Groups (SNODE)
The second and the third node resource groups contain information about
remote MFCL Server nodes. MFCL Server node resource groups begin with
the node resource group identifier SNODE. The internal structure of an
MFCL Server node resource group is identical to the internal structure of a
local node resource group.

The end of the DTS profile defines the end of the last application
parameter group and the end of the last node resource group.

General DTS Profile Structure of an MFCL Server

The following section shows you a skeleton of a DTS profile in the MFCL Server
environment (Windows NT):

$======================================================================
#
# MFCL Server DTS Profile (Example)
#
e e
LNODE: Local MFCL Server Node
local_node _name = SN MFCL Server Node Name
APPL: Local Server Application
application_name = SAl Server Application Name
CNODE: Remote MFCL Client Node
client_node_name = CN1 MFCL Client Node Name
APPL: Remote Client Application
application_name = C1A1  Client Application Name
APPL: Remote Client Application
application_name = Cl1A2 Client Application Name
CNODE: Remote Client Node
client_node_name = CN2 MFCL Client Node Name
APPL: Remote Client Application
application_name = C2A1  Client Application Name
#======================================================================

This profile contains the following resource groups:
* LNODE (local node parameters)

* CNODE (client node parameters for client 1)

* CNODE (client node parameters for client 2)

Local Node Resource Group
The first node resource group contains information about the local MFCL
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Server node. It begins with the node resource group identifier LNODE.
The unique node parameter group of this node resource group follows the
node resource group identifier.

The node parameter group is followed by one application parameter group
that begins with the application parameter group identifier APPL.

The local node resource group end is indicated by the beginning of the
second node resource group.

Local Node Parameter Group
This group begins with the mandatory local node name parameter
statement. Parameters of the succeeding application parameter
groups cannot be referred to if a local node name is not specified.

The local node parameter group ends with the beginning of the
tirst application parameter group.

Local Application Parameter Groups
These groups begin with the application parameter group identifier
APPL. Local application parameter statements follow.

The first local application parameter group ends with the
beginning of the second application parameter group. The second
application parameter group ends with the beginning of the first
MECL Client node resource group.

Client Node Resource Groups
The second and the third node resource groups contain information about
remote MFCL Client nodes. MFCL Client node resource groups begin with
the node resource group identifier CNODE. The internal structure of an
MEFCL Client node resource group is identical to the internal structure of a
local node resource group.

The end of the DTS profile defines the end of the last application
parameter group and the end of the last node resource group.

General DTS Profile Structure of MFCL Client/MFCL Server

The following section shows you a skeleton of a DTS profile of a node that has an
MEFCL Client and an MFCL Server environment (Windows NT):

#:=====================================================================
#
# MFCL Client/Server DTS Profile (Example)
#
B o o o e
LNODE: Local MERVA Server Node
Tocal_node_name = SN MERVA Server Node Name
APPL: Local Client Application
application_name = CAl Client Application Name
APPL: Local Server Application
application_name = SAl Server Application Name
CNODE: Remote MFCL Client Node

client_node_name = CN1 MFCL Client Node Name

APPL: Remote Client Application
application_name = C1A1 Client Application Name

APPL: Remote Client Application
application_name = C1A2 Client Application Name
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SNODE: Remote MFCL Server Node
server_node_name = SN1 MFCL Server Node Name

APPL: Remote Server Application
application_name = SIA1  Server Application Name

APPL: Remote Server Application
= S1A2  Server Application Name

application_name

For a description of the parameters refer to “General DTS Profile Structure of anl
MECL Client” on page 127 and !General DTS Profile Structure of an MECI Server’]

bnpage12d.
DTS Profile Contents (MFCL Client)

This section describes the information that can be contained in a parameter group
of an MFCL Client DTS profile.

Local Node (LNODE Parameter Group)

A local node parameter group in the MFCL Client environment contains local
MECL Client node parameters. The local node parameters are:

local_node_name
Specifies the name of the local node.

The local node names must be unique for all interconnected MERVA Client
systems. You can specify other local node names as you like. A local node
name consists of up to eight alphanumeric characters beginning with an
alphabetic character. Upper- and lowercase letters have the same meaning.
For example, NODE1 and nodel identify the same node.

dts_trace_dir
Specifies the name of the MFCL Client DTS Diagnosis Trace Directory.

Processing trace files created by the MFCL Client DTS programs are
written to this directory. The name of the created trace files begins with the
application name. The extension of the file name is a number between 000
and 999. For example, the name of the third trace file of the application
SA1is SA.002.

You must specify the name of the diagnosis trace directory as an absolute
path name, a relative path name, or a network path name. According to
the rules of your operating system, each path name ends with a forward
slash or a backslash. Otherwise, an error occurs.

dts_trace_file
Specifies the name of the MFCL Client DTS processing trace file.

A DTS process writes its diagnosis trace into this file. If the file does not
exist, it is created. If the file exists, it is cleared at the beginning of a DTS
process.

You must specify the name of the diagnosis trace file as a full path name, a
relative path name, or a network path name. If parameter data ends with a
forward slash or a backslash, an error occurs.

You can define the name of the trace files by using dts_trace_dir or by
using dts_trace_file. If both parameters are specified, the last one in the
DTS profile is valid.
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dts_trace_level
Specifies whether an MFCL Client DTS processing trace is requested.
Specifies also the trace details.

The trace level specified in this parameter is the default trace level for all
MECL Client DTS processes. You can overwrite the default trace level for a
specific MFCL Client DTS process by setting the dts_trace_level parameter
of a parameter group of a MERVA Server application.

Valid parameter values are:

0 No trace is created. This is the default value.

1 A trace that contains information about process activities of the
MEFCL Client is created. The trace does not show transfer data
elements.

2 A trace that contains each data of a level-1 trace and transfer data

envelopes (outbound and inbound control data) is created.

3 A trace that contains each data of a level-2 trace and up to 1024
bytes of the transfer data (outbound and inbound data) is created.
This trace shows also information related to data communication
service calls.

The trace is written to the file that is specified by the dts_trace_file
parameter or to a file in the trace directory that is specified by the
dts_trace_dir parameter.

Local Application (APPL Parameter Group)

A local application parameter group in the MFCL Client environment contains
information that depends on the local client application. The client application
parameters are:

application_name
Specifies the name of a local client application.

The attributes of a client application name are identical to the attributes of
a local node name.

MFCL Server Node (SNODE Parameter Group)
An MFCL Server node parameter group in the MFCL Client environment contains
remote MFCL Server node parameters. The MFCL Server node parameters are:

server_node_name
Specifies the name of an MFCL Server node.

The attributes of an MFCL Server node name are identical to the attributes
of a local node name.

symb_destination
Specifies the name of an SNA APPC side information profile that contains
SNA APPC related control information about the MFCL Server process.

partner_host
Specifies the name or the IP address of the TCP/IP host to which the
MFCL Server belongs.

You must specify the IP address in dotted-decimal representation. The
maximum length of the partner host information is 16 characters.
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port_number
Specifies the TCP/IP port number for the Internet subserver that represents
the MFCL Server in the MFCL Server system.

The sample and default port number for the MFCL Server in the TCP/IP
environment is 7117. The maximum value of a TCP/IP port number is
65.535.

tcp_nodelay
Specifies whether the tcp_nodelay parameter must be set for the outbound
socket.

The outbound socket is used for communication with the MFCL Server
process. This parameter can affect the performance of the data
communication. Valid parameter values are off, on, 0, and 1. The default
parameter value is 1.

Server Application (APPL Parameter Group)

A server application parameter group in the MFCL Client environment contains
information that defines the characteristics of a specific MERVA server application.
The information applies to the MFCL Client part, to the MFCL Server part, or to
both parts of the application.

The server application parameters are:

application_name
Specifies the formal name of a remote MERVA server application.

Formal names of a server application must be unique within an MFCL
Server node resource group. The attributes of a formal name of a server
application are identical to the attributes of a local node name.

cvsec_prompt
Specifies whether the MERVA Client Logon window contains an additional
user ID and password prompt for a TCP/IP connection.

The additional password is used for the conversation security check. This
check is performed while the connection on the MFCL Server side takes
place. By default, the cvsec_prompt parameter is set to No. In this case,
your MERVA user ID and password are used for the conversation security
check. The conversation security user ID and password must match the
appropriate system user ID and password on the target MERVA server to
get a TCP/IP connection.

informal name
Specifies the informal name of a remote MERVA server application.

Informal names of a server application must be unique within the MFCL
Client system. You can use an informal name of a server application as a
nickname to identify a server application in MFCL Client user terms. An
informal name of a server application consists of a maximum of eight
non-white printable characters. Upper- and lowercase characters have
different meanings.

free_form_name
Specifies the free-form name of a remote server application.

You can use a free-form name of a server application to explain the
purpose of a server application in MFCL Client user terms. A free-form
name of a server application consists of a maximum of 64 printable
characters, including blanks. You must specify all free-form name
characters in the same line as the parameter keyword.
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msg_proc_table
Specifies the name of the message-processing table that the MFCL Client
message-processing entity must use when it communicates with this
MERVA server application.

If this parameter is not specified, the default name of the
message-processing table is MERVASON.MRT.

connection_type
Specifies the type of connection to the partner system.

You must define the connection type of each application explicitly. If the
connection type is not set, or if the parameters of the selected connection
type are not sufficient, an error is reported. The connection type value is
one of the following;:

LOCAL
The connection type is the connection to the local MFCL Server.

SNA  The connection type is SNA APPC (remote MFCL Server).

TCP/IP
The connection type is TCP/IP (remote MFCL Server).

encryption
Specifies the method that must be used for encryption of MERVA
application data that the MFCL Client sends to the MFCL Server.

The encryption parameter value is one of the following:

NONE
MERVA application data is not encrypted.

This is the default.

MFC The MFCL Client proprietary method is used for encryption of
MERVA application data.

sec_key_modifier
Specifies the security key modifier of the MERVA application data that
must be used for encryption of MERVA application data.

The parameter value of the security key modifier can be a string of one
character, up to eight numeric characters. You must specify the same
parameter value in the applicable client APPL parameter group in the
MFCL Server system. If the MFCL Client and the MFCL Server system use
the same character encoding (ASCII or EBCDIC), you can use any
character, up to eight characters, as security key modifier. If this parameter
is not specified or if it is specified as zero (any number of zero characters),
security key modification of application data is not applicable.

cp_timeout
Specifies the timeout value for an MFCL Client process that communicates
with the MFCL Server application.

After the MFCL Client sends data to the MFCL Server, it expects a
response within a specific period of time. If the MFCL Server does not
respond within this period of time, the MFCL Client DTS interrupts the
communication and informs the MFCL Client application about the
timeout, that is, the MFCL Server did not respond in time.

The timeout value specifies the number of seconds that the DTS waits for a
response from the MFCL Server. A timeout value of zero means that the
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communication is not interrupted if the server does not respond in time.
The default timeout value is 60 seconds.

dts_trace_level
Specifies whether an MFCL Client DTS processing trace is requested.
Specifies also trace details.

The trace level specified in this parameter overwrites the trace level
specified in the local node parameter group for an MFCL Client DTS
process that is connected to the MFCL Server application. It also overwrites
an explicitly specified trace level.

The valid parameter values are identical to the dts_trace_level parameter
values that can be specified in a local node parameter group.

DTS Profile Contents (MFCL Server)

The information that can be contained in a parameter group of an MFCL Server
DTS profile is described in the following sections.

Local Node (LNODE Parameter Group)

A local node parameter group in the MFCL Server environment contains local
MECL Server node parameters. The local node parameters are:

local node name
Specifies the name of the local node.

The local node names must be unique for all interconnected MERVA Client
systems. You can specify other local node names as you like. A local node
name consists of up to eight alphanumeric characters beginning with an
alphabetic character. Upper- and lowercase letters have the same meaning.
For example, NODE1 and nodel identify the same node.

sa_match
Specifies whether the MERVA server application name received from the
MEFCL Client in the connect request must be verified.

The parameter value is one of the following:

Yes The MERVA server application name must be verified. The name
of the MERVA server application received from the MFCL Client
must match the name of a local MERVA server application defined
in the local MFCL Server resource group. If the name of the
MERVA server application cannot be verified, the connect request
is rejected.

No This is the default value. The name of the MERVA server
application received from the MFCL Client does not have to match
the name of a local MERVA server application defined in the local
MECL Server resource group. The local MERVA server application
parameters of an explicitly identified MERVA server application
apply. Otherwise, default parameters of the MERVA server
application apply.

ca_match
Specifies whether the address information about the MFCL Client received
from the MFCL Client in the connect request must be verified.

The parameter value is one of the following:

Yes The MFCL Client address information is verified and must match
definitions in the DTS profile. The MFCL Client node name
received from the MFCL Client must match the name of an MFCL
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Client node defined in this DTS profile. The client application
name received from the MFCL Client must match the name of a
client application defined in a client application parameter group
within the scope of the applicable client node resource group. If
one of the two client resources is not defined in the DTS profile, a
connect request is rejected.

No The client address information does not have to match definitions
in the DTS profile. The MFCL Client node name received from the
MEFCL Client does not have to match the name of an MFCL Client
node defined in an MFCL Client node parameter group. The MFCL
Client node parameters of an explicitly identified MFCL Client
node apply. Otherwise, default MFCL Client node parameters
apply.

The client application name received from the MFCL Client does
not have to match the name of a client application defined in a
client application parameter group. The client application
parameters of an explicitly identified client application parameter
group within the scope of the applicable MFCL Client node
resource group apply. Otherwise, default client application
parameters apply.

Local Application (APPL Parameter Group)

A local application parameter group in the MFCL Server environment contains
information that depends on local MERVA server application. The MERVA server
application parameters are:

application_name
Specifies the name of a local MERVA server application. The attributes of a
MERVA server application name are identical to the attributes of a local
node name.

MFCL Client Node (CNODE Parameter Group)
An MFCL Client node parameter group in the MFCL Server environment contains
remote MFCL Client node parameters. The MFCL Client node parameters are:

client_node_name
Specifies the name of an MFCL Client node.

The attributes of an MFCL Client node name are identical to the attributes
of a local node name.

Client Application (APPL Parameter Group)

A client application parameter group in the MFCL Server environment contains
remote client application dependent information. The client application parameters
are:

application_name
Specifies the name of a remote client application.

The attributes of a client application name are identical to the attributes of
a local node name.

encryption
Specifies the method that must be used for encryption of MERVA
application data that the MFCL Server sends to the MFCL Client.

The encryption parameter value is one of the following:

NONE
MERVA application data is not encrypted. This is the default value.
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MFC The MFCL Client proprietary method is used for encryption of
MERVA application data.

sec_key_modifier
Specifies the security key modifier of the MERVA application data that
must be used for encryption of MERVA application data.

The parameter value of the security key modifier can be a string of one
character, up to eight numeric characters. You must specify the same
parameter value in the applicable server APPL parameter group in the
MEFCL Client system. If the MFCL Client and the MFCL Server system use
the same character encoding (ASCII or EBCDIC), you can use any
character, up to eight characters, as security key modifier. If this parameter
is not specified or if it is specified as zero (any number of zero characters),
security key modification of application data is not applicable.

sp_timeout
Specifies the timeout value for an MFCL Server process when it
communicates with the MFCL Client application.

After the MFCL Server sends response data to the MFCL Client, it expects
another request within a specific period of time. If the client does not send
another request within this period of time, the MERVA server application is
stopped. An active client automatically creates a blank message within this
time period even if the client and the server do not communicate with
each other.

The timeout value specifies the number of seconds that the DTS waits for
another request from the MFCL Client. A timeout value of zero means that
the MERVA server application is not stopped because the client does not
send another request in time. The default timeout value is 10 minutes.

DTS Profile Implementation

The implementation of the MERVA Family Client DTS profile depends on the
operating system environment.

DTS Profile Implementation in MVS and VSE
The MFCL Server DTS profile is implemented in the MVS (TM) and VSE
environments as a fixed data table that you cannot change.

The following values determine the behavior of a MERVA ESA server:

sa_match
No

ca_match
No

encryption
Determined by the MFCL Client’s connect request (NONE or MFC)

sec_key_modifier
Not supported

sp_timeout
Not supported

DTS Profile Implementation on Windows NT
The MERVA Family Client DTS profile is implemented in the Windows NT

environment as a flat file with text parameters. The profile is created by using a
text editor.
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A MERVA Family Client DTS Sample Configuration

The following figure shows you a sample topology of an MERVA Family Client
configuration:

Node 2
(Windows NT)

SNA TCP/IP
» Server 21 |«

Node 3 (ESA)

Node 1 Server 31

(Windows NT) 4
: SNA SNA
LOCALI ) SNA >
> Glent a1 |

Senver 11 ][ 7o  Node 4

(Windows NT)

Node 5
(Windows NT) TCP/IP

LOCALI

[Sonersi]s

Figure 43. MERVA Family Client Sample Topology

For this sample configuration, the following DTS profile samples are valid

customizations:
DTS Profile of Node 1
#====================================================================
# MERVA Family Client DTS Profile (Node 1)
#====================================================================
B o o o o el
# Local Node Definitions for both, an MFCL Client and a Server Node
B o o o o el
LNODE: local Node 1
local_node_name = NODE1 Local client and server node
dts_trace_dir = c:\temp\trace\
sa_match = no server appl. need not match
ca_match = yes client appl. must match
APPL: local client application
application_name = CLIENTL1
APPL: local server application
application_name = SERVERI1
B o o o el
# Local Server Node Definition for a Client Node
e
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SNODE : local server node (Node 1)

server_node name = NODEl server node name

APPL: lTocal server application
application_name = SERVERLI1 server application formal name
informal_name = MUBLOCAL server application nickname
free_form_name = MERVA USE & Branch local server
connection_type = LOCAL preferred connection type
cp_timeout = 30 outbound timeout

e e

# Remote Server Node Definitions for a Client Node

B e

SNODE : remote server node (Node 2)
server_node name = NODE2 server node name
symb_destination = NODE2PC symbolic destination

APPL: remote server application
application_name = SERVER21 server application formal name
informal_name = MUBSERV  server application nickname
free_form_name = MERVA USE & Branch at Node 2
connection_type = SNA preferred connection type
encryption = MFC method for encryption
cp_timeout = 60 outbound timeout

SNODE : remote server node (Node 3)
server_node name = NODE3 server node name
symb_destination = NODE3PC symbolic destination

APPL: remote server application
application_name = SERVER31 server application formal name
informal_name = ESASERV  server application nickname
free_form_name = MERVA ESA server at Node 3
connection_type = SNA preferred connection type
encryption = MFC method for encryption

e e e

# Remote Client Node Definitions for a Server Node

e e e el

CNODE: remote client node (Node 4)
client_node_name = NODE4 client node name

APPL: remote client application
application_name = CLIENT41 <client application formal name
encryption = NONE method for encryption
sp_timeout = 120 next request timeout

#====================================================================

# MERVA Family Client DTS Profile End

f====================================================================

DTS Profile of Node 2

#==================================s=s=ssssssssssssssssssss=ss=sssssoo=s

# MERVA Family Client DTS Profile (Node 2)

#=====================================================================

e o e

# Local Node Definitions for a Server Node

e o e

LNODE: local Node 2 is a server node
Tocal_node_name = NODE2 Local server node name
sa_match = yes server application must match
ca_match = no client appl. need not match
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APPL: local server application

application_name = SERVER21

msg_proc_table = MERVASON.MRT
#=====================================================================
# MERVA Family Client DTS Profile End
#==================================================s=s=s=s====s=========

DTS DB of Node 3: No customization possible.

DTS DB of Node 4:

f#=====================================S==S====S=SSSSSSSSSSSSS==========
# MERVA Family Client DTS Profile (Node 4)
#====================================================================
e e
# Local Node Definitions for a Client Node
B e
LNODE: local Node 4 is a client node
local_node_name = NODE4 Local client node name
dts_trace_level = 0 Tevel = 0 : write no trace
ca_match = no client appl. need not match.
APPL: local client application
application_name = CLIENT41
e
# Remote Server Node Definitions for a Client Node
B e
SNODE : remote server node (Node 2)
server_node name = NODE2 server node name
partner_host = node2 partner host name
port_number = 7117 TCP/IP port
tcp_nodelay = on TCP_NODELAY opt. for outbound
APPL: remote server application
application_name = SERVER21 server application formal name
informal_name = MUBSERV  server application nickname
free_form_name = MERVA USE & Branch at Node 2
connection_type = TCP/IP preferred connection type
encryption = MFC method for encryption
cp_timeout = 60 outbound timeout
SNODE : remote server node (Node 3)
server_node name = NODE3 server node name
symb_destination = NODE3PC symbolic destination name
APPL: remote server application
application_name = SERVER31 server application formal name
informal_name = ESASERV  server application nickname
free_form_name = MERVA ESA server at Node 3
connection_type = SNA preferred connection type
encryption = MFC method for encryption
cp_timeout = 60 outbound timeout
SNODE : remote server node (Node 1)
server_node_name = NODE1 server node name
partner_host = nodel partner host name
port_number = 7117 TCP/IP port
tcp_nodelay = on TCP_NODELAY opt. for outbound
APPL: remote server application
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application_name = SERVERLI1 server application formal name

informal_name = NTSERV server application nickname
free_form_name = MERVA USE & Branch at Node 1
connection_type = TCP/IP preferred connection type
encryption = NONE method for encryption
cp_timeout = 60 outbound timeout

SNODE : remote server node (Node 5)
server_node_name = NODE5 server node name

APPL: remote server application
application_name = SERVER51 server application formal name
informal_name = MERVANT server application nickname
free_form_name = MERVA Workstation server at Node 5
connection_type = TCP/IP  preferred connection type
encryption = MFC

#====================================================================

# MERVA Family Client DTS Profile End

#====================================================================

LNODE: local Node 5
Tocal_node_name = NODE5 Tocal client and server node
dts_trace_dir = c:\temp\trace\
sa_match = no server appl. need not match
ca_match = no client appl. need not match

APPL: local client application
application_name = CLIENT51

APPL: lTocal server application
application_name = SERVER51

e e e

# Local Server Node Definition for a Client Node

o e e

SNODE: local server node (Node 5)
server_node_name = NODE5 server node name

APPL: local server application
application_name = SERVER51 server application formal name
informal_name = MERVANT server application nickname
free_form_name = MERVA Workstation Tlocal server
connection_type = LOCAL preferred connection type

e

# Remote Server Node Definition for a Client Node

B e

SNODE : remote server node (Node 3)
server_node_name = NODE3 server node name
symb_destination = NODE3PC symbolic destination name

APPL: remote server application

application_name SERVER31 server application formal name
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informal_name = ESASERV server application nickname

free_form_name = MERVA ESA server at Node 3
connection_type = SNA preferred connection type
encryption = MFC
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Appendix B. Diagnosing Problems

This section describes how to get diagnosis information for the MERVA Message
Processing Client. Diagnosis information within the MERVA Message Processing

Client is provided in the form of log files stored on the workstation where the

reporting component of the MERVA Message Processing Client is installed. For the

location of these files refer to the corresponding MERVA Installation and
Customization Guides. The purpose of diagnosis information is to help you locate
the reason for any problem that might occur.

The MERVA Message Processing Client Log Files

The MERVA Message Processing Client, hereafter called Client, comprises several

cooperating components, each with its own log file, as shown in the following

figure:

| Client Serving Process L—

!

| Server Communication |—

M. F. C. Serve

| Client Communicationsl—

Client Process

IL

M. F. C. Client

Figure 44. The Log Files of the Components of the MERVA Message Processing Client

The real names of the log files as shown in this figure depend on the respective

MERVA Message Processing Client configuration. The names are determined in the
following table:
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Table 4. MERVA Message Processing Client Log File Names

Configuration

CP_LOG

CSP_LOG

CC_LOG

SC_LOG

Remote Client
with MERVA
ESA server

As specified in
the user settings
or with the
parameter
[tracefile=

The CSP_LOG is
identical with
the MERVA ESA
journal

As specified
with the
parameter
informal_name
in the
ENCTDTS.PRF
profile of the
workstation
extended by "’
and three digits
(instance
counter)

The SC_LOG is
identical with
the MERVA ESA
journal

Remote Client
with MERVA
Workstation
server

As specified in
the user settings
or with the
parameter
[tracefile=

File name
derived from the
client’s LU6.2
name (SNA) or
the client’s
symbolic host
name (TCP/IP)
on server
workstation
(*.LOG)

As specified
with the
parameter
informal_name
in the
ENCTDTS.PRF
profile of the
workstation,
extended by "
and three digits
(instance
counter)

Derived from
the host name of
the client
(TCP/IP),
extended by "’
and three digits
(instance
counter)

Local Client

As specified in
the user settings

As specified in
the user settings

As specified
with the
parameter
informal_name
in the
ENCTDTS.PRF
profile of the
workstation
extended by "’
and three digits
(instance
counter)

As specified
with the
parameter
informal_name
in the
ENCTDTS.PRF
profile of the
workstation
extended by "’
and three digits
(instance
counter)

The Client Diagnosis Log

The client diagnosis logs CP_LOG and CSP_LOG contain three classes of

information:

* Log file entries that are characterized by the “-X->" signal report on exceptional
situations. In case of problem tracking, these entries should be analyzed by you
and your IBM representative.

* Log file entries that are characterized by the “-T->" signal report internal trace
data. In case of severe problems, these entries should be analyzed by your IBM

representative.

 All other log file entries report problems in your setup that should be solved
without IBM support.

The following table shows you a classification of all customer-oriented entries in

the log file:
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Table 5. MERVA Message Processing Client Customer-Oriented Logging Classes

Signal Logging Class
-E-> Trace and error reports of the client’s End User Interface Component
-M-> Trace and error reports of the client’s Message-Processing Component

You can display and edit the log file by using any standard ASCII text editor.

Note: Do not edit the file if any component of the MERVA Message Processing

Client on your workstation is active.

The following shows you an example of a client diagnosis log file that is displayed

by an ASCII text editor:

-T-> 05/07/1997 08:44:36 111 IThread(1)
(+) EncAPIUser_1

-T-> 05/07/1997 08:44:36 111  IThread(1)
> Sign on to server [EncAPIUser_ 1]
UserID="hho"
User0TdPW="sxx%xxxx"
UserNewPW="x#**x%xx+"

-T-> 05/07/1997 08:44:37 111 IThread(3)
> Send request to server [EncAPIClientComm 1]
ServerRequest (1)="SIGNON hho #xxwskw* ()"

-T-> 05/07/1997 08:44:42 111 IThread(3)

* Request execution at server [EncAPIServerComm 1]
ClientID="CAl at HHONODE" ExecutelIndication="EXECUTED"
ServerRequest="SIGNON hho **xxxxsx* ()"
ServerReply="0 IBMMERVA2 "" US ((SWIFTFIN ((SWIFTC1 (160))))"

-T-> 05/07/1997 08:44:43 111 IThread(1)
(+) EncCMessageBox_4

-T-> 05/07/1997 08:44:43 111 IThread(1)
(+) EncCFunctionList 1

-T-> 05/07/1997 08:44:43 111  IThread(1)
(+) EncAPIUserExit_1

-T-> 05/07/1997 08:44:43 111 IThread(1)

> Execute user exit [EncAPIUserExit_1]
UserExitID="AccessCurrencyCodes"
InputData=":REQTYP:LIST"

-T-> 05/07/1997 08:44:43 111 IThread(3)
> Send request to server [EncAPIClientComm 1]
ServerRequest (2)="EXECUTEUSEREXIT AccessCurrencyCodes enm2lux :REQTYP:LIST"

-T-> 05/07/1997 08:44:43 111 IThread(3)

* Request execution at server [EncAPIServerComm 1]
ClientID="CAl at HHONODE" ExecutelIndication="EXECUTED"
ServerRequest="EXECUTEUSEREXIT AccessCurrencyCodes enm2Tux :REQTYP:LIST"
ServerReply="9999 """

-T-> 05/07/1997 08:44:44 111 IThread(3)
(') EncAPIUserExit_1 EncAPIUserExit::outputData
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-X-> 05/07/1997 08:44:44 111 IThread(1)
EncAPIUserExitError exception thrown.
function: EncAPIUserExit::getExecuteReply()
file: encaexit.cpv
line: 72
Error Id is 181
Error Code group is ENCApiUserExitServices
Exception text is:
ENCO181: Execute of user exit not accepted: Server's RC=9999 [].
9999

-T-> 05/07/1997 08:44:44 111 IThread(1)
(+) EncCMessageBox_5

-T-> 05/07/1997 08:44:44 111  IThread(1)
(-) EncCMessageBox_5

-T-> 05/07/1997 08:44:44 111  IThread(1)
(-) EncAPIUserExit_1

-T-> 05/07/1997 08:44:49 111 IThread(1)
> Get server MP tables' signature [EncAPIServer 1]
ServerID="MFCL at HHONODE"

-T-> 05/07/1997 08:44:49 111 IThread(3)
> Send request to server [EncAPIClientComm 1]
ServerRequest (3)="GETTABLESSIGNATURE"

There are two types of log file entries. For details see I’Exception Messages”l and

Exception Messages

Exception messages are log file entries that report exceptional situations such as
not valid data or unexpected system behavior. In case of problems with the
MERVA Message Processing Client, this data helps you find out the effect of the
problem.

Each exception entry in the log file has the structure shown in the following figure:
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MM/DD/YYYY hh:mm:ss  PID TID
exception signal

[
[-X->] |01/08/1997 13:58:35| [172] IThread (|2])

ExceptionClassName

|EncAPIMessageError| exception thrown.
MemberF ti
function: | EncAPIMessageQueueing::getReleaseReply() Iw

' SourceFile
file: | encamsggq.cpv

line: | 596 LineNumber

Error Id is| 149 Errorld

/ ErrorCodeGroup

Error Code group is| ENCApiMessageServiWaI

Exception text is;

ENC 0149KRe;ease not accepted: Server's RC=9999 [General system error] |

ErrorText

Figure 45. The Structure of Exception Messages

The following list explains the terms used in the figure:

MM/DD/YYYY hh:mm:ss
Time stamp that indicates date and time when the log entry is created.

PID  Identification of the process that creates the log entry.
TID  Identification of the thread that creates the log entry.

ExceptionClassName
Name of the exception class to which the error belongs.

MemberFunction
Class member function that throws the exception.

SourceFile
Name of the source file from which the throwing function is called.

LineNumber
Line number that is related to the source file in which the call of the
throwing function is placed.

ErrorID
Error identification that restricts the error within the exception class. It
might be used to identify the error message in Messages and Codes to help
you solve the problem.

ErrorCodeGroup
Assigns the error to a specific group of errors. Usually, this group is
identical with the exception class.

ErrorText
Explains why the message is displayed. The text contains variable text that
describes the surrounding conditions of the error.

Trace Messages

Trace messages are log file entries that describe processed data and regular system
behavior. In case of problems with the MERVA Message Processing Client, this
data helps you find the reason for the problem.
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Each trace entry in the log file has the structure of one of the types shown in the
following figure:

MM/DD/YYYY hh:mm:ss PID TID [Z'
trace signal

ObjectInstance

e
[-T->] |01/08/1997 13:58:35| [172] IThread (|2])

[
|Connect to server| [|EncAPIUser_1| 1

Action

ActionType

ServerlD="M2SERV1 at XHRPC1" T Inf
ServerType="2" race.nto
MM/DD/YYYY hh:mm:ss PID 71D

trace signal

Notificationld
[1>] [01/08/1997 13:58:35] [172] IThread ([2]) SEALRELLALL
|EncAPIServer_1| |EncAPIServer::attached Objectinstance
[

ActionType

MM/DD/YYYY hh:mm:ss PID TID
trace signal

e
[-T->] |01/08/1997 13:58:35| [172] IThread (|2])

EncAPIServer_1 Objectlnstance

ActionType

MM/DD/YYYY hh:mm:ss PID TID [E'
trace signal

face sTonel
|-T>| |01/08/1997 13:58:35] [172| IThread (|2])

Any text string

|XXXXXXXXXXXXXXXXXXI

Figure 46. The Structure Types of Trace Messages

The following list explains the terms and their definition used in the figure:

MM/DD/YYYY hh:mm:ss
Time stamp that indicates date and time when the log entry is created.

PID  Identification of the process that creates the log entry.
TID  Identification of the thread that creates the log entry.

Action Type
Symbols indicating the state of the action. The following symbols are valid:
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>< Run of a client function (Type A)

> Entry to a client function (Type A)

< Return from a client function (Type A)
Run of a server function (Type A)

(+) Construction of an object (Type C)

(-) Destruction of an object (Type C)

(!) Notification on execute completion (Type B)
Free text trace (Type D)

Action
Describes the action.

ObjectInstance
Instance name and number of the related object.

NotificationID
Shows the identification of the notification.

Tracelnfo
Shows trace data that corresponds to the action. The number of trace
information entries depends on the action traced.

Communication Diagnosis Log

The DTS diagnosis logs CC_LOG and SC_LOG contain information on the data
transfers between clients and servers.

Experienced system specialists should evaluate the related log files because special
knowledge about the applied data transfer protocols and the data transfer
customization is required. However, looking into the communications log files can
help you detect customization errors with respect to the MERVA Message
Processing Client data transfer components and the SNA or TCP/IP standard
software tools used.

Especially while putting a client-server connection into operation, the CC_LOG
and SC_LOG contain useful information on the establishment of the connection
between client/server and the transfer of application data.

The DTS diagnosis log files contain information on the activities of the MERVA
Message Processing Client communications components and the transferred data.
In case of errors, you can find related information, such as error and sense codes of
the applied communications tools. You can then use this information for trouble
shooting.

You can display and edit the log files with any standard text editor. Note that you
should not edit the file when any component of the MERVA Message Processing
Client is active on the workstation.

Example of a Log File without Errors

The following section shows you a sample of records in a communications
diagnosis log file displayed by a text editor.

The sample log file shows a sequence of log entries that represent a typical
client/server communication activity divided into an initial connection to the
server, several data transfers, and a final disconnection.

ENCTSO MERVA Family Client process start on Mon Nov 03 11:44:31 1997

ENCTSO Env var PATH is C:\WINNT40\system32;C:\WINNT40;E:\CLIENT\CLI\BIN;
ENCTSO Env var DPATH is E:\CLIENT\CLI\BIN
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ENCTSO Env var ENC_DIR is E:\CLIENT\CLI
ENCTSO_crqg Connect request parameters printed by ENCTSO pcr:

ENCTSO_pcr Local client address is MCLIENT at XHRPCNT
ENCTSO_pcr Local system type is WNT
ENCTSO_pcr Processing trace 1vl is 3

ENCTSO_pcr Server appl nickname is XHRPC_CL

ENCTSO_pcr Server address is MSERVER1 at XHRPC

ENCTSO_pcr Msg processing table is MERVASON.MRT

ENCTSO_pcr Server system type is 0S/2

ENCTSO_pcr Appl data security is Encryption 0 Authentication 1

ENCTSO_pcr Preferred conn type is TCP/IP, CP timeout is 3000 seconds

ENCTSO_pcr SNA APPC info is TP '' at 'XHRPC1'

ENCTSO_pcr TCP/IP  info is Port '7117' at 'xhrpc'

ENCTSO_gcr PDU segment data begin --------mmmmmmmmm e *
ENCTSO_gcr 000000 74000001 1A000110 OBOOOLIAL 58485250 * t.......... TXHRP *
ENCTSO_gcr 000070 2E681E6F * .h.o *
ENCTSO_gcr PDU segment data end ---=---=mmmmmmm oo e e e e *

ENCTSO_Tsp Loading DLL enctco.dl1l
ENCTSO_Tsp DLL enctco was successfully loaded

ENCTCO_soc Service Primitive is CONNECT.Request
ENCTCO_soc Partner host name is xhrpc

ENCTCO_soc Connection to xhrpc has been established

ENCTCO_soc TCP_NODELAY flag has been set

ENCTSC_htn Converting outbound PDU segment 0100 to network format
ENCTSC_htn Converting outbound PDU segment 81FF to network format
ENCTCO_scr Connect Request PDU successfully sent

ENCTCO_rcc Receive CC-PDU with a timeout of 3000 seconds

ENCTCO_rds Inbound PDU segment begin is 002A0101 00089200 00000258 000C9201
ENCTSC_nth Converting inbound PDU segment 0101 to host format

ENCTCO_cpt Inbound PDU trailer is 000581FF F7

ENCTSC_nth Converting inbound PDU segment FF81 to host format

ENCTCO_cpt Change direction trailer received

ENCTCO_rcc Connect Confirmation PDU received

ENCTSO_dcc PDU segment data begin --------------ommmmmmmmm e *
ENCTSO_dcc 000000 2A000101 08000092 58020000 0C000192 =* *...... EX.oooon. E *
ENCTSO_dcc 000020 B0310800 04921A0E 5E34 * °1l...E..74 *
ENCTSO_dcc PDU segment data end -----------mmmmmmmm oo *

ENCTSO_trm Service primitive completed at Mon Nov 03 11:44:33 1997

--CLIENT--> call outbound function for request "SIGNON"
to server "MSERVER1 at XHRPC"

ENCTSO_srqg Send request received at Mon Nov 03 11:44:33 1997
ENCTSO_pod Application data begin =======-mmmmmm o *
ENCTSO_pod 000000 5349474E A4F4E202A 2A2A2A2A  2A2A2A2A  * SIGNON *%xxsssksk *

ENCTSO_pod 000030 2A2A * ko *

ENCTSO_pod Application data end ---------------mmmmmmm e *
ENCTSO_gad PDU segment data begin ----------mmmmmmm e *
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ENCTSO_gad 000000 40000201 08000092 32000000 0C000192 =* @...... k2...... K

ENCTSO_gad 000030 DD8E4FAC 4E79AC9B 3BDSE9OB E4A3BCE2 * |AONyg;i0.0040 *
ENCTSO_gad PDU segment data end -----------mmmmmmmm oo *
ENCTSC_htn Converting outbound PDU segment 0102 to network format

ENCTSC_htn Converting outbound PDU segment 81FF to network format

ENCTCO_sap Application Data PDU successfully sent

ENCTCO_rap Receive AD-PDU with a timeout of 3000 seconds

ENCTCO_rds Inbound PDU segment begin is 00400102 00089200 00000503 000C9201
ENCTSC_nth Converting inbound PDU segment 0201 to host format

ENCTCO_rad New application data buffer of 4096 bytes allocated

ENCTCO_rad Application data begin is 30204942 4D4DA4552 56413220 22546573
ENCTCO_cpt Inbound PDU trailer is 000581FF F7

ENCTSC_nth Converting inbound PDU segment FF81 to host format

ENCTCO_cpt Change direction trailer received

ENCTCO_rap Application Data PDU received

ENCTSO_dad PDU segment data begin --------------cmmmmmmmm *
ENCTSO_dad 000000 40000201 08000092 03050000 0C000192 =* @...... Eooo.... E *
ENCTSO_dad 000030 5E1601F2 E10BO2B7 E756766F ACDE9AE3 * i.._B..ApVvoll0 *
ENCTSO_dad PDU segment data end -----==------mmmmmmm e *
ENCTSO_pid Application data begin --------------commmmmmm o *
ENCTSO_pid 000000 30204942 4D4D4552 56413220 22546573 = © IBMMERVA2 "Tes *

ENCTSO_pid 0003F0 20393930 20393931 20393932 20393935 =* 990 991 992 995 *
ENCTSO_pid Application data end ---------------mmmmmm e *
ENCTSO_pid Application data successfully authenticated

ENCTSO_trm Service primitive completed at Mon Nov 03 11:44:41 1997

--CLIENT--> call outbound function for request "GETFUNCTIONLIST"
to server "MSERVER1 at XHRPC"

ENCTSO_srq Send request received at Mon Nov 03 11:44:44 1997

ENCTSO_pod Application data begin --------------cmmmmmmm e *
ENCTSO_pod 000000 47455446 554E4354 494FAEAC 495354 * GETFUNCTIONLIST =
ENCTSO_pod Application data end ---------------mmmmmmm e *
ENCTSO_gad PDU segment data begin ----------cmmmmmmmmmm e *

ENCTSO_gad 000000 40000201 08000092 OFO00000 0C000192 =* @...... Eo...... E

ENCTSO gad 000030 297D3F83 OCCO62E5 4142084E D37FF3F2 * )}?a.LlbOAB.NEA_ =
ENCTSO_gad PDU segment data end ------------=---mmmmmm e *
ENCTSC_htn Converting outbound PDU segment 0102 to network format

ENCTSC_htn Converting outbound PDU segment 81FF to network format

ENCTCO_sap Application Data PDU successfully sent

ENCTCO_rap Receive AD-PDU with a timeout of 3000 seconds

ENCTCO_rds Inbound PDU segment begin is 00400102 00089200 00001CB9 000C9201
ENCTSC_nth Converting inbound PDU segment 0201 to host format

ENCTCO_rad New application data buffer of 8192 bytes allocated

ENCTCO_rad Application data begin is 30202828 4D424352 43455252 20302022
ENCTCO_cpt Inbound PDU trailer is O00581FF F7

ENCTSC_nth Converting inbound PDU segment FF81 to host format

ENCTCO_cpt Change direction trailer received

ENCTCO_rap Application Data PDU received

ENCTSO_dad PDU segment data begin ----------mmmmmmm e *
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ENCTSO_dad 000000 40000201 08000092 B91C0000 0CO00192

ENCTSO_dad 000030 D534AC6C 1614C8E9 8BB99835 OBDC44A3 + 141..L071y5KgDi *
ENCTSO_dad PDU segment data end -----=----mmmmmmmmm oo *

ENCTSO_pid Application data begin --------------cmmmmmmmm o *
ENCTSO_pid 000000 30202828 4D424352 43455252 20302022 * O ((MBCRCERR 0 " =

ENCTSO_pid 0003FO 3E203E3D 203C3D20 3E203C20 3D292920 * > >= <= > < =)) *
ENCTSO_pid Application data end -----=-----ommmmmm o *
ENCTSO_pid Application data successfully authenticated

ENCTSO_trm Service primitive completed at Mon Nov 03 11:44:46 1997

: (... further request data transfers between client and server ...)

--CLIENT--> call outbound function for request "DISCONNECT"
to server "MSERVERL at XHRPC"

ENCTSO_drg Disconnect request received at Mon Nov 11 17:27:13 1997
ENCTSC_htn Converting outbound PDU segment 81FF to network format
ENCTCO_drq Deallocate request successfully sent

ENCTCO_trm TCP/IP socket has been closed

ENCTSO_trm Service primitive completed at Mon Nov 11 17:27:13 1997
ENCTSO_trm Client process is about to terminate

ENCTSO Process end Mon Nov 11 17:27:13 1997
ENCTSO Elapsed time is ... seconds

Example of a Log File with Errors

The following section shows you a sample of records in a communications
diagnosis log file displayed by a text editor.

The sample log file shows an error that occurs during the attempt at connection.
The error is caused by the APPC communications tool. The local client
communication component reports the error.

ENCTSO MERVA Family Client process start on Tue Apr 22 08:54:19 1997
ENCTSO_crg Connect request parameters printed by ENCTSO_pcr:

ENCTSO_pcr Local client address is MCLIENT at XHRPC1
ENCTSO_pcr Local system type is WNT
ENCTSO_pcr Processing trace 1vl is 3

ENCTSO_pcr Server appl nickname is MESACICS

ENCTSO_pcr Server address is ESASERV at XTRNODE

ENCTSO_pcr Msg processing table is TEST.AND.TRAINING

ENCTSO_pcr Server system type is MVS/CICS

ENCTSO_pcr Appl data security is Encryption 0 Authentication 0

ENCTSO_pcr Preferred conn type is SNA, CP timeout is 10 seconds

ENCTSO_pcr SNA APPC info is TP 'DSLF' at 'XTRESA'

ENCTSO_gcr PDU segment data begin -------------commmmmmmmm e *
ENCTSO_gcr 000000 6C000001 19000110 OAOOO1Al 58485250 * T.......... TXHRP *
ENCTSO_gcr 000060 BD25BB21 08000AAl 2D66D3FB * Yo, .. 1-fE2 *
ENCTSO_gcr PDU segment data end ---------mmmmmmmmm oo *
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ENCTSO_Tsp
ENCTSO_Tsp

ENCTPO_alc
ENCTPO_alc
ENCTPO_alc
ENCTPO_alc

ENCTPO_alc
ENCTSO_trm
ENCTSO_trm

ENCTSO_trm
ENCTSO_trm
ENCTSO_trm
ENCTSO_trm

ENCTSO_drq
ENCTPO_drq
ENCTSO_trm
ENCTSO_trm

ENCTSO
ENCTSO

Loading DLL enctpo
DLL enctpo was successfully loaded

Service Primitive is CONNECT.Request
Symbolic destination is XTRESA

Partner TP name set to DSLF

Conv. security type 1is PROGRAM

Allocate conversation failed, CM_RC is decimal 2
DTS error detected, TSO Error codes: RC = 81, RS = 8, EC = 0
Application data security index is 0

I
(<]

Error information type is 4, RC = 12, RS = 2, EC =
> 004 Error reported by MFC DTS program ENCTPO:

> 012 Allocate APPC conversation failed

> 002 APPC allocate failure, retry recommended

Disconnect request received at Tue Apr 22 08:54:20 1997
Disconnect request ignored, conversation not allocated
Service primitive completed at Tue Apr 22 08:54:20 1997
Client process is about to terminate

Process end Tue Apr 22 08:54:20 1997
Elapsed time is one second

Logging Relationships

Several logging interdependencies are introduced to ensure that the causal
connection of actions initiated by different components of the MERVA Message
Processing Client and the related MERVA servers can be reproduced.

Logging within the Components of the MERVA Message
Processing Client

The following relationships are possible:

* If the client process requests data transfer services from the client
communication component, it inserts a corresponding log entry in the CC_LOG.

* If the client serving process requests data transfer services from the server
communication component, it inserts a corresponding log entry in the SC_LOG.

MERVA Server Logs

Log entries in the log files of the MERVA server depend on the log level of the
system. The following log entries are shown:

* The Client Serving Process requests services from the MERVA server.

* The requested services are executed by the MERVA server.

For details refer to the corresponding MERVA Diagnosis Guide of the MERVA server.

Setting the Amount of Logging Data

You should change the level of logging only at the request of your IBM
representative.

After the cause for a problem is found, reset the level of logging to its Erevious

value that is determined in the installation part. For details refer to

17

Appendix B. Diagnosing Problems 153



Problem Determination

154

This section tells you how to determine the cause of a problem. It describes the
documentation that is required if you contact your IBM representative for further
problem analysis.

If you have to submit an authorized program analysis report (APAR), follow the
instructions of your IBM representative. An APAR contains a detailed description
of the problem and problem-related data. Your IBM representative processes the

APAR through IBM’s Known Problems database.

Initial Evaluation of a MERVA Message Processing Client
Problem

If the MERVA Message Processing Client fails to function correctly, a diagnostic
message is displayed. This message starts with ENC. For an explanation of each
message and the action to take, refer to Messages and Codes. To access Messages and
Codes, double-click the Messages and Codes icon in the MERVA Message
Processing Client folder, or select it and press Enter.

If the same or a related problem occurs after you take the recommended action,
repeat the initial evaluation of the problem. This helps you find out whether the
problem is caused by an error in the code supplied by IBM, or by errors in the
operating system or system services. Even if the problem occurs while the MERVA
Message Processing Client is active, the problem might be caused by errors in the
operating system or system services.

For the initial evaluation, take these steps:

1. Check whether the problem is software related or hardware related. For details
see [Is the Problem Software Related or Hardware Related?’]

2. If the problem is software related, classify type and component of the problem.

For details see I!Classifying a Software-Related Problem” an page 153,

Is the Problem Software Related or Hardware Related?

The first step to resolve a problem is to find out whether it is software related or
hardware related. If you assume that the problem is hardware related, the
following procedure helps you with the first step:
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hardware to your system?

lno

Perform a hardware check. YeS _ Resume
Did the check resolve the problem? operations!

lno

[Run hardware diagnostics.

yes Have you added new J

yes Refer to
"Classifying a

Is the hardware OK? software problem"!

lno

— | Repair the hardware!

Figure 47. Problem Determination

Classifying a Software-Related Problem

You classify a software-related problem by type and component. The type refers to
the category of symptoms to which the problem belongs. The component refers to
the operating system, the LAN software, the communication software, and the
MERVA Message Processing Client software that causes or reports the problem.

By classifying a problem by type and component and reporting this information to
IBM, you can:

* Decrease the range of probable causes
e Accelerate the search within IBM’s Known Problems database

* Accelerate the process of problem solving

Identifying the Application or Scenario to Reproduce the
Problem

By reproducing the problem, you get diagnostic information that helps you
identify the source of the problem.

The following questions help you isolate the source of the problem, or identify the
application or scenario to reproduce the problem:

1. How do you describe the problem?
* Which are the tasks that you cannot perform?
* Is the keyboard locked?

2. What happened when the problem occurred?

¢ Were you working in a window of the operating system, in a session of the
MERVA Message Processing Client, or were you running a program from the
MERVA Message Processing Client folder?

* Did the system stop when the problem occurred?
* Which is the sequence of events and user actions that led to the problem?

¢ Were the user actions carried out successfully before? If yes, were the
circumstances different when the problem occurred?

* Was the size of the failing application or scenario reduced to a minimum to
eliminate extraneous symptoms?
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Were there messages or indications that a problem might occur? If yes, report
message number and error codes. If there is no message number, report the
message text.

Which is the last successfully run operation?

Which is the last displayed screen?

Were there other active programs on your workstation?
Is the problem a recurring problem?

Can you re-create the problem at will?

3. Are there unusual or specific operating circumstances?

Is the application new?
Are the procedures new?
Might recent changes have affected the system?

Was the operating system or a service changed since the last time the
application ran successfully?

Is there a recent installation of a ServicePak or a MERVA Message Processing
Client PTF?

Determining the Type of Software Problem
IBM ServiceLink and IBM Support Center databases have a structure for problem

categories. This structure is shown in the following table:

Table 6. Problem Categories

Problem Keyword Problem Description

Installation (INSTALL) Problems caused by program changes, or experienced during

or resulting from the installation of the MERVA Family Client
program, applications, or new hardware.

Abnormal termination Abnormal termination refers to a recurring or unrecoverable
(ABEND) problem caused by a program defect that unexpectedly ends

processing by a component, application, or function.

An abnormal termination can result from a software
compatibility problem or from problems associated with a
workstation’s hardware configuration.

Wait or Loop If your keyboard is locked, or if the program is not responding
(WAIT/LOQOP) as it should, an unexpected program suspension, referred to as

a wait, might have occurred.

If a program encounters a problem or contains a coding error
that causes it to execute a certain sequence of instructions
repeatedly while the error conditions persists, an
uncontrollable program loop might have occurred.

Based on external symptoms, you might not be able to
distinguish between a wait and a loop. For this reason, these
two types are grouped together.
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Table 6. Problem Categories (continued)

Problem Keyword Problem Description
Performance problems This refers to unusually slow or delayed system run or
(PERFM) response time that causes programs to take longer than usual

to complete a task. Performance problems can be caused, for
example, by a shortage of disk space, improper allocation of
buffers, and program resources of the operating system.

Many performance problems can be solved by means of
system tuning. Check the configuration settings to ensure that
they are appropriate for the number of applications and files
that currently run on your system.

A performance problem can also result from a software
compatibility problem or from problems associated with the
hardware configuration of a workstation.

Deficient documentation |If the product documentation is deficient, for example, if helps
(DOC) or procedures are incomplete or incorrect, report the problem
in detail to IBM.

Include title, form number, and the page number of the page
on which the error occurs. If you report an error in the online
documentation, include title or name of the online help panel.

Incorrect output This refers to the following situations:

(INCORROUT) * Output is missing.

* Output is incorrect.

 Data returned by the program is missing or incorrect.

Note: External symptoms might belong to more than one problem type. In this
case, review each description to determine the best match.

Determining the Component Associated with the Problem
Use the following descriptions to determine the component that has or causes the
problem:

Operating system
Operating system problems include problems that occur when you respond
to operating system prompts or when you use a text editor, the file system,
or the print spooler.

Communication Services
Because the MERVA Message Processing Client is installed in a remote
configuration by means of communication services, such as Personal
Communications, you might get communication problems.

For more information refer to the supported communication software
documentation.

The MERVA Message Processing Client
Problems regarding the MERVA Message Processing Client include
problems that occur when you use the client executable or the installation
and customization programs.

Operating System Problems
Read this section if you assume that an operating system problem exists. Operating
problems are, for example:

* Installation Problems (INSTALL)
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If you assume that an installation problem is connected to the operating system,
take these steps:

1. Try to reproduce the problem.

2. Review the information in the installation log.

3. Reinstall the program with the original distribution media. Do not change

any file or add other software. If the operation runs successfully, the problem
is solved. If the operation does not run successfully, take the next step.

4. Remove any non-IBM or non-supported IBM hardware and retry the failing
operation. If the software problem is solved, the installation problem is
connected to the interaction between hardware and software. Refer to the
information that is supplied with the hardware to solve the hardware
problem.

* Abnormal termination (ABEND)
Indications of an abnormal termination are, for example:

— An unexpected return to the desktop of the operating system or to the
command prompt

— A message that the system is stopped unexpectedly
— A postmortem error message that indicates a general protection fault

Postmortem dumps are generated when the base operating system or the

hardware ends an application because the application violates one of the rules

maintained by the base operating system or the hardware. Possible reasons

are:

- An application tries to access storage that the application is not allowed to
access.

- The processor tries to run a privileged or inexecutable instruction.
Record the data of the error to compare it with the system error message.
Examine it then for additional information or instructions.

* Wait or loop (WAIT/LOOP)

An application can be blocked, in an apparently irrecoverable wait state, or in a
loop. If a blocking or wait state occurs, a wait condition might exist. In this case,
take these steps:

1. Try to isolate the problem to a single application. If you can isolate the
problem to a specific application, solve the problem by using the information
supplied with the respective application.

2. Try to isolate the problem to the set of concurrent applications or to the
circumstances that cause the wait condition.

3. Write down the steps that lead to the failure.
If you assume that a loop involving the base operating system occurs, try to
isolate the application involved. If you can isolate the problem to a specific

application, solve the problem by using the information supplied with the
respective application.

* Performance problems (PERFM)
These are, for example:
— Software incompatibility
— Program components of an operating system or an application that can affect
other program components of an operating system or an application.
In case of performance problems, the following problems can occur:

— Slow system processing or response time causes the programs to take longer
than usual to complete a task.
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— Program suspension when you switch from one session to another.

— Incorrect or incomplete program processing that might result in incorrect
output.

— Program or system failure that might result in abnormal termination.
Try to reproduce the problem on a system with the same configuration and

memory size. If you cannot reproduce the problem on this system, the problem
might be a hardware problem.

MERVA Message Processing Client Problems
For all types of MERVA Message Processing Client problems, the following
information is required:

* Workstation model, main memory size, hard disk size

* Version, release, and service level (CSD) of the operating system

* Version, release, and service level (CSD) of the communication tool

* Version, release, and PTF level of the MERVA Message Processing Client

* Component identification of the MERVA Message Processing Client

The following information about MERVA Client trace and configuration is also
necessary for problem tracking:

¢ Installation and configuration report

To generate this report, run the enccfg.exe. It is contained in the installation
directory of the MERVA Client. By default, the output is sent to the screen. To
sent the output to a file, use the redirect operator >.

* Client diagnosis logs on client (CP_LOG) and server (CP_LOG)

For details on how to change trace settings, refer to [Changing Settings” onl

. For information about naming conventions and locations of the logs,

refer to [Mable 4 an page 144

* Communication diagnosis logs on client (CC_LOG) and server (SC_LOG)

For details on trace customization, refer to [!Customizing Communication
Bystems for the MERVA Message Pracessing Client” an page 112 and I'DTY
IEto.ﬁlP_Con.ten.ts_@A.ECL_Chem.)_on_p.a.gﬂBJ] For information about naming
conventions and locations of the logs, refer to [[able 4 on page 144.
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Appendix C. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Deutschland
Informationssysteme GmbH
Department 3982
Pascalstrasse 100
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70569 Stuttgart
Germany

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement
or any equivalent agreement between us.

The following paragraph does apply to the US only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.

Trademarks

The following terms are trademarks of the IBM Corporation in the United States or
other countries, or both:
CICS
CICS/ESA
CICS/VSE
eNetwork
IBM
IMS
IMS/ESA
MVS
MVS/CICS
MVS/ESA
VSE/ESA

AccordWorkstation (AWS) and Directory Services Application (DSA) are
trademarks of S.W.LET., La Hulpe in Belgium.

Pentium is a trademark of Intel Corporation.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks
of others.

Appendix C. Notices 163



164 MERVA Message Processing Client User’s Guide



Glossary
A

address. See S.W.LET. address.

address expansion. The process by which the full
name of a financial institution is obtained using the
S.W.LET. address, telex correspondent’s address, or a
nickname.

answerback. In telex, the response from the dialed
correspondent to the “WHO R U” signal.

answerback code. A group of up to 6 letters following
or contained in the answerback to check the
answerback.

APC. Application Control.
application. See message application.
API.  Application Programming Interface.

APPC. Advanced Program-to-Program
Communication.

Application Programming Interface (API).
Application Programming Interface.

Application Support (AS). Application Support.

ASCII. American Standard Code for Information
Interchange.

authentication. The SSW.LET. security check to ensure
that a message is not changed during transmission and
that a message is sent by an authorized sender.

authorization. The process of granting you complete
or restricted access to the functions of the MERVA
Message Processing Client.

Bank Identifier Code (BIC). The S.W.LET. address of
a bank as assigned by SW.LET. See also S.W.LET.
address.

BIC. Bank Identifier Code. See also S.W.I.LE.T. address.

body. See message body.

C

category. See message category.

CBT. S.W.IET. Computer-Based Terminal.

© Copyright IBM Corp. 1997, 1999

CC_Log. The communication diagnosis log file that
contains information about the client communication.

component. A functionally distinct part of MERVA,
such as MERVA Link.

correspondent. An institution to which your
institution sends messages and from which messages
are received.

correspondent identifier. The 11-character identifier of
the receiver of a telex message. Used as a key to
retrieve information from the Telex Correspondents
File.

CP_Log. The communication diagnosis log file that
contains information about the client process.

cross-field checking. When you move to a new field
in a message, MERVA checks that the data that is
entered in the previous field is correct. Some fields
depend on entries that are made in other fields.

CSP_Log. The communication diagnosis log file that
contains information about the client serving process.

Currency Code File. The file that contains the
currency codes together with the name, fractional part
country code, and country names.

D

data area. An area in a message-processing window of
a predefined length and format, where you can enter or
display data. A field can consist of one or more data
areas.

F

field. An area used to enter or display a particular
type of data in a predefined format. A subdivision of a
message. A field is located by its position in a message
and by its tag. A field is made up of one or more data
areas. See also data area.

FIN. Financial Application.

four-eyes principle. A banking security concept
whereby changes and approval of changes must always
be carried out by two different people.

icon. A pictorial representation of an object or a
selection choice. An icon also represents an application
when it is minimized.
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input message. A message that is sent to the SW.IET.
network.

ISO. International Organization for Standardization.

L

LT or LTERM. Logical terminal. A destination with a
name related to one or more physical terminals.

M

MERVA ESA. Message Entry and Routing with
Interfaces to Various Applications for ESA.

MERVA Link. The MERVA component that can
interconnect MERVA systems.

MERVA-related data. A representation of data that
MERVA uses while processing the message. This data is
not included in the message body and is only used by
MERVA.

MERVA USE & Branch for Windows NT. Message
Entry and Routing with Interfaces to Various
Applications USE & Branch for Windows NT.

MERVA USE & Branch for Windows NT with SWIFT
Link. Message Entry and Routing with Interfaces to
Various Applications USE & Branch for Windows NT
with SWIFT Link.

message. A string of fields in a predefined form to
send or receive information.

message application. A specification for an
application area to which message categories and
messages belong.

message body. The part of the message that contains
the message text. This text contains the data that is sent
to other MERVA systems, non-MERVA applications,
and networks.

message category. A group of messages that are
logically related within an application.

message database. An area to store messages that are
created by using the MERVA Message Processing Client
or messages that are received from other systems.

message header. The leading part of a message that
contains the sender and receiver of the message, the
message priority, and the type of message.

message-processing function. The various parts of the
MERVA Message Processing Client to create, verify,
authorize, edit, display, print, and delete messages.

message queue. A logical subdivision of the message
database to store messages, on a first-in, first-out basis
while the messages wait to be processed by a
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message-processing function. The queue has the same
name as the message-processing function with which it
is associated.

message reference number (MRN). A unique 16-digit
number assigned to each message for identification
purposes. The message reference number consists of an
8-digit domain identifier followed by an 8-digit
sequence number.

message sequence number (MSN). A sequence
number for messages that are transferred by MERVA
Link.

message template. An outline to create similar
messages of this type. See also S.W.LF.T. message.

message type (MT). A number up to 8 characters long
that identifies a message. S.W.LET. messages are
identified by a 3-digit number, for example, SW.LET.
message type MT 100.

MRN. Message Reference Number.
MSN. Message Sequence Number.
MTP. Message Transfer Process or Program.

MT. Message Type.

N

nested message. A message that is composed of one
or more message types.

network. A link between two or more computer
locations.

nickname. An abbreviation or synonym of the Bank
Identifier Code (BIC) of a financial institution with
which you correspond frequently.

O

occurrence. See repeatable sequence.

P

PTE. Program Temporary Fix.

PTN. Public Telex Network.

Q

queue. See message queue.

R

ready-to-send queue. A queue to collect messages that
are ready to be sent to SW.LET. or telex network.



repeatable sequence. A field or group of fields that
can be successively entered or displayed more than
once in a message.

retype verification. See verification.

routing. The passing of messages from one processing
stage in a predefined processing path to the next
processing stage.

S

SC_Log. The communication diagnosis log file that
contains information about the server communication.

sign off. To end a session with the MERVA Message
Processing Client.

sign on. To start a session with the MERVA Message
Processing Client.

SNA. Systems Network Architecture.

subfield. A subdivision of a field with a specific
meaning. For example, field 52A consists of Account
Number and Logical Terminal subfields.

S.W.LET. Society for Worldwide Interbank Financial
Telecommunication, s.c.

S.W.LET. Refers to the SW.LET. network of the
Society for Worldwide Interbank Financial
Telecommunication, s.c. (SSW.IET.).

S.W.LET. address. A bank identifier code (BIC) that

consists of 12 characters to identify a bank within the

S.W.LET. network. The code is assigned by SW.LET.

and has the following subcodes:

* Bank code (4 characters)

* ISO country code (2 characters)

* Location code (2 characters)

* LT code (1 character)

* Branch code (3 characters) for a S.W.LLE.T. user
institution

S.W.LET. Correspondents File. The file that contains
the SW.IET. address or BIC, together with the name,
postal address, and zip code of each financial
institution in the BIC directory.

S.W.LET. financial message. A message in one of the
S.W.LET. categories 1 to 9 that you can send or receive
via the SSW.LET. network.

S.W.LET. message. A message in one of the SW.IET.
categories as defined in the S.W.ILE.T. User Handbook
that you can send or receive via the SSW.LLET. network.

S.W.LET. system message. A SW.LET. general
purpose application (GPA) message or a financial
application (FIN) message in S.SW.LET. category 0.

Systems Network Architecture (SNA). The
description of the logical structure, formats, protocols,
and operating sequences for transmitting information
units through, and controlling the configuration and
operation of, networks.

T

TCP/IP. Transmission Control Protocol/Internet
Protocol.

Telex Link. The MERVA system component to link the
public telex network.

telex header. The first part of a telex message with
control information for the telex network.

template. See message template.

testkey. Normal banking practice requires the addition
of a testkey to a telex message to ensure message
integrity and authorized delivery. The testkey is an
integer value of up to 16 digits, calculated using the
significant information in the message, for example,
amounts, currency codes, and message date. The
testkey is calculated manually or by a
testkey-processing program.

Transmission Control Protocol/Internet Protocol
(TCP/IP). A set of communication protocols that
support peer-to-peer connectivity functions for local
and wide area networks.

TRN. Transaction Reference Number.

U

UPM. User Profile Management.

user profile. A description of a user that includes such
information as user ID, user name, user password,
access authority, and other attributes obtained at logon.
It contains also specifications of the functions that a
user is allowed to perform and the associated queues.
The user profile can only be maintained by authorized
users.

User Profile Management. A component that provides
user ID validation, and user and group management
facilities. Each installation of User Profile Management
is local to the particular workstation where it is
installed and validates user accessing controlled data or
using programs that reside on that particular
workstation. It also provides the mechanism for users
to log on to the system and log off from the system,
and to identify and authenticate system users.
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verification. A check by reading through the message
or retyping marked fields to ensure that the contents of
a message are correct.

w

Who Are You (WRU). Answerback that identifies the
remote subscriber.
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